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Abstract 

 

ORA is a network analysis tool that detects risks or vulnerabilities of an organization’s design 

structure. The design structure of an organization is the relationship among its personnel, 

knowledge, resources, and tasks entities. These entities and relationships are represented by the 

Meta-Matrix. Measures that take as input a Meta-Matrix are used to analyze the structural 

properties of an organization for potential risk. ORA contains over 100 measures which are 

categorized by which type of risk they detect. Measures are also organized by input requirements 

and by output. ORA generates formatted reports viewable on screen or in log files, and reads and 

writes networks in multiple data formats to be interoperable with existing network analysis 

packages. In addition, it has tools for graphically visualizing Meta-Matrix data and for 

optimizing a network’s design structure. ORA uses a Java interface for ease of use, and a C++ 

computational backend. The current version ORA1.2 software is available on the CASOS 

website: http://www.casos.ece.cmu.edu/projects/ORA/index.html. 
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2 Questions, Bugs, and Comments 

Please contact us: 

Dr. Kathleen M. Carley (kathleen.carley@cmu.edu) 

3 Dynamic Network Analysis 

Dynamic Network Analysis (DNA)* is an emergent scientific field that brings 

together traditional social network analysis (SNA), link analysis (LA) and multi-agent 

systems (MAS)*. There are two aspects of this field. The first is the statistical analysis of 

DNA data. The second is the utilization of simulation to address issues of network 

dynamics. DNA networks vary from traditional social networks in that are larger 

dynamic multi-mode, multi-plex networks, and may contain varying levels of 

uncertainty. 

DNA statistical tools are generally optimized for large-scale networks and admit the 

analysis of multiple networks simultaneously in which, there are multiple types of nodes 

(multi-nodes)* and multiple types of links (multi-plex)*. In contrast, SNA statistical tools 

focus on single or at most two mode data and facilitate the analysis of only one type of 

link at a time. 

DNA statistical tools tend to provide more measures to the user, because they have 

measures that use data drawn from multiple networks simultaneously. From a computer 

simulation perspective, nodes in DNA are like atoms in quantum theory, nodes can be, 

though need not be, treated as probabilistic.  

mailto:kathleen.carley@cmu.edu
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Whereas nodes in a traditional SNA model are static, nodes in a DNA model have 

the ability to learn. Properties change over time; entities can adapt: A company's 

employees can learn new skills and increase their value to the network; Or, kill one 

terrorist and three more are forced to improvise. Change propagates from one entity to 

the next and so on. DNA adds the critical element of a network's evolution and considers 

the circumstances under which change is likely to occur.  

3.1 Where to learn to more: 

 Kathleen M. Carley, 2003, Dynamic Network Analysis‖ in Dynamic Social 

Network Modeling and Analysis: Workshop Summary and Papers, Ronald 

Breiger, Kathleen Carley, and Philippa Pattison, (Eds.) Committee on Human 

Factors, National Research Council, National Research Council. Pp. 133-145, 

Washington, DC. 

 Kathleen M. Carley, 2002, Smart Agents and Organizations of the Future‖ The 

Handbook of New Media. Edited by Leah Lievrouw and Sonia Livingstone, Ch. 

12, pp. 206-220, Thousand Oaks, CA, Sage. 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-

forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, DSS Special 

Issue on Cyberinfrastructure for Homeland Security: Advances in Information Sharing, 

Data Mining, and Collaboration Systems. 

4 File Formats 

ORA can read in a multitute of file formats.  

Below is a list, with examples of the code, of those formats.  

DyNetML – .dl – UCINET – comma delimited (.csv) – text files (.txt) – Pajek (.net) – 

GraphML – GMU model (.stl) – Pathfinder (.lo). 

Dynetml (the native ORA xml format): DynetML is an xml based interchange language 

for relational data including nodes, ties, and the attributes of nodes and ties. DyNetML is 

a universal data interchange format to enable exchange of rich social network data and 

improve compatibility of analysis and visualization tools. 

<node id="col_jack_o'neill"> 

  <properties> 

    <property name="ally" type="string" value="yes"/> 

    <property name="gender" type="string" value="male"/> 

  </properties> 

</node> 

<graph sourceType="Agent" source="Agent" targetType="Agent" target="Agent" 

id="agent x agent" isDirected="true"> 

  <edge source="A01" target="A11" type="double" value="1"/> 

  <edge source="A02" target="A01" type="double" value="1"/> 

</graph> 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm%23dynetml
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.dl: DL (for "data language") is a very powerful and (fairly) simple language that allows 

the creation of quite complex and large UCINET data sets with minimal data entry. DL 

language files are plain ASCII text files that can be created with any editor (be sure to 

store the results as plain text). 

dl n=9, format=edgelist1 

labels: 

    A,B,C,D,E,F,G,H,I 

data: 

    1    1    1 

    1    2    1 

    1    6    1 

          . 

          . 

          . 

    8    7    1 

    9    9    1 

 
.##h and ##d (UCINet): UCINET datasets are stored in a special (Pascal) format, but can 

be created and manipulated using both UCINET's and other software tools (text editors 

and spreadsheets). Each UCINET dataset consists of two separate files that contain 

header information (e.g. myfile.##h) and the data lines (e.g. myfile.##d). Because of this 

somewhat unusual way of storing data, it is best to create data sets with the internal 

spreadsheet editor or DL language tools, or to import text or spreadsheet files and save 

the results as UCINET files. 

 
.CSV (comma separated values): The CSV ("Comma Separated Value") file format is 

often used to exchange data between disparate applications. The file format, as it is used 

in Microsoft Excel, has become a pseudo standard throughout the industry, even among 

non-Microsoft platforms. File most commonly created from an Excel spreadsheet using 

the Save As… option 

 Each record is one line… but — A record separator may consist of a line feed 

(ASCII/LF=0x0A), or a carriage return and line feed pair (ASCII/CRLF=0x0D 

0x0A)… but — fields may contain embedded line-breaks (see below) so a record 

may span more than one line. 

 Fields are separated with commas. 

 Leading and trailing space-characters adjacent to comma field separators are 

ignored. 

 Fields with embedded commas must be delimited with double-quote characters. 
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 Fields that contain double quote characters must be surounded by double-quotes, 

and the embedded double-quotes must each be represented by a pair of 

consecutive double quotes. 

 A field that contains embedded line-breaks must be surounded by double-quotes 

 Fields with leading or trailing spaces must be delimited with double-quote 

characters. 

 Fields may always be delimited with double quotes. 

 The first record in a CSV file may be a header record containing column (field) 

names 

,A01,A02,A03,A04 

A01,0,0,0,0 

A02,1,0,0,0 

A03,1,0,0,0 

A04,1,0,0,0 

 
.txt (text files): Otherwise refered to ASCII files which contain no extemporaneous 

formating. 

 
.raw: net (Pajek): The file format accepted by Pajek provides information on the vertices, 

arcs (directed edges), and undirected edges. A short example showing the file format is 

given below: 

*Vertices 3 

1 "Doc1" 0.0 0.0 0.0 ic Green bc Brown 

2 "Doc2" 0.0 0.0 0.0 ic Green bc Brown 

3 "Doc3" 0.0 0.0 0.0 ic Green bc Brown  

*Arcs 

1 2 3 c Green 

2 3 5 c Black 

*Edges 

1 3 4 c Green 

 
.graphml: GraphML is a comprehensive and easy-to-use file format for graphs. It consists 

of a language core to describe the structural properties of a graph and a flexible extension 

mechanism to add application-specific data. Unlike many other file formats for graphs, 

GraphML does not use a custom syntax. Instead, it is based on XML and hence ideally 

suited as a common denominator for all kinds of services generating, archiving, or 

processing graphs. 

<xs:annotation> 

  <xs:documentation 

    source="http://graphml.graphdrawing.org/" 

    xml:lang="en"> 

    Simple type definitions for the new graph attributes. 
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  </xs:documentation> 

</xs:annotation> 

 

.stl (GMU model): This file format is native to the stereolithography CAD software 

created by 3D Systems. STL files describe only the surface geometry of a three 

dimensional object without any representation of color, texture or other common CAD 

model attributes and can us both ASCII and binary representations 

An ASCII STL file begins with the line: 

solid {name} 

where name is an optional string. The file continues with any number of triangles, each 

represented as follows: 

facet normal n1 n2 n3 

  outer loop 

    vertex v11 v12 v13 

    vertex v21 v22 v23 

    vertex v31 v32 v33 

  endloop 

endfacet 

where n1-n3 and v11-v33 are floating point numbers in sign-mantissa'e'-sign-exponent 

format and concludes with: 

endsolid {name} 

 
.lo (pathfinder):  
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5 Getting Started 

Welcome to ORA's Help File system! 

The ORA help set is organized into the following top-level folders: 

To begin with, if you're not familiar with Social Network Analysis, then you should read 

through this manual. It's broken up into six parts. 

1. Getting Started: provides an overview of Social Networks and how they pertain to 

ORA. 

2. The Main Interface: The Main Interface is the area for working with the data 

within the Networks. This includes loading, saving & merging, performing 

various math functions on the Networks, generating a variety of networks, and 

running reports. 

3. The Visualizer: This is the graphical tool for visualizing the Networks. It contains 

tools for displaying (or hiding) nodes and links, creating different groupings, and 

displaying information about the Network. 

4. ORA Measures: This section contains explanations of the various measures used 

in ORA. They contain a short explanation and (for the most part) the math used in 

the measure. It also describes the type, input, and output. 

5. Lessons: Lessons designed to teach specific materials. 

6 Network Drives 

If you are running on a network drive then the help system needs a drive letter in order to 

work correctly. There are 2 possible solutions to this: 

1. Copy the ORA folder to each local machine. 

2. If at all possible Map a Network Drive. Right click on the shared folder and select 

Map Network drive. 

6.1 Mapping a Network Drive 

In an Explorer window select My Network Places. Find the name of the network which 

contains ORA. 

 

Go back to My Document. 
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From the menu select Tools => Map Network Drive. This brings up the dialog box 

below. 

 

Select the [Browse] button in order to select the network drive. 

 

Select the correct network drive and press [OK]. 
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Select [Finish]. 

 

Your computer now has the Network drive with ORA mapped on the desktop. 



 

9 

 

7 ORA and DNA 

In general, you may want to use ORA in conjunction with other computational tools 

to advance DNA theory. The CMU CASOS tools that work with ORA to form tool 

chains are AutoMap (extracts networks from texts) and various DNA simulators 

including both Construct and DyNet. These tools are often used in a number of real world 

applications, including the following areas: 

 Designing adaptive teams for Command and Control Networks 

 Estimating the impact of organizational downsizing 

 Estimating the effectiveness of new structures 

 Evaluating risk in organizational designs 

 Examine impact of IT effectiveness 

 Impact analysis of actions in asymmetric warfare simulation 

 Impact analysis of weaponized biological attacks on cities 

ORA is interoperable with a number of other SNA and link-analysis tools: UCINET, 

KeyPlayer, and Analyst Notebook. Additional information is listed under data import and 

export. 

7.1 Where to learn more about CASOS tools and this tool chain: 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2004, An 

Integrated Approach to the Collection and Analysis of Network Data, In Proceedings of 

the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M.Carley, 2004, Estimating Vulnerabilities in Large Covert Networks Using 

Multi-Level Data, In Proceedings of the NAACSOS 2004 Conference, Pittsburgh, PA 

Kathleen M. Carley, 2003, Dynamic Network Analysis in Dynamic Social Network 

Modeling and Analysis: Workshop Summary and Papers, Ronald Breiger, Kathleen 

Carley, and Philippa Pattison, (Eds.) Committee on Human Factors, National Research 

Council, National Research Council. Pp. 133-145, Washington, DC. 

Kathleen M. Carley, Jana Diesner, Jeffrey Reminga, Maksim Tsvetovat, 2005-

forthcoming, Toward an Interoperable Dynamic Network Analysis Toolkit, DSS Special 

Issue on Cyberinfrastructure for Homeland Security: Advances in Information Sharing, 

Data Mining, and Collaboration Systems. 

CASOS: Center for Computational Analysis of Social and Organizational Systems 

(http://www.casos.cs.cmu.edu/index.html) 

8 Questions, Bugs, and Comments 

Please contact us: 

Dr. Kathleen M. Carley (kathleen.carley@cmu.edu) 



 

10 

 

9 Overview: The Organizational Risk Analyzer 

ORA is an analysis tool designed to help the user evaluate one or more networks. It 

can be used to assess the nature of, features of, change in, and determinants of complex 

networks. A large variety of networks can be assessed including, but not limited to, social 

networks, activity networks, task networks, knowledge networks, supply chains, and 

communication networks. Using ORA questions such as the following can be addressed: 

what is critical, are there groups of interest, are there patterns of interest, how might 

interventions impact the network, who is critical, are there emerging groups, how is the 

network changing. 

What is a network? In any data there are relations among things such as two people 

are cousins, or a set of people are all members of the same club. These networks might be 

psychological or cultural as when two people share the same belief. They might be 

physical as in two resources being in the same location or two computers being connected 

by a line, or they might be social as in people being related. There are many reasons why 

networks exist. Networks are ubiquitous. Everyone and everything is constrained and 

enabled by the networks in which they are embedded. Everyone and everything is 

embedded in multiple networks; e.g. you are connected to some people due to work, 

others due to school, others due to your kids, and so on. ORA lets you visualize, assess, 

and reason about these networks. 

9.1 What kinds of networks? 

ORA can assess any type of network. Anything that can be represented as a set of 

nodes and relations can be assessed. Typical networks are: social networks (who interacts 

with whom), financial networks (who lends money to whom); gant charts (what task 

needs to be done before what), supply chains (what resources are needed to build what 

other resources)., semantic networks (what ideas are linked to what ideas), proximity 

networks (what states border on what states), and so on. ORA can assess any data that 

can be represented as nodes and relations regardless of what the nodes are or what the 

relations are. 

9.2 What if there are many networks? 

ORA can be used to assess the interlocks among networks. For examples, imagine 

that the following networks exist: who works with whom; who has what skills, what 

skills are needed for what tasks, who is doing what tasks then ORA can assess whether in 

fact the right people have been assigned to those tasks or where there are problems 

because there is insufficient skills available for the task. ORA can assess "multi-mode 

multi-link" data. 
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9.3 What if the networks change? 

ORA can be used to assess change in networks over time. Over time, the shape or 

topology of a network might change; e.g., start up companies move from a collaborative 

to a hierarchical structure, terrorists change what weapons they use to attack sites, 

scholars cite different papers, and so on. Consequently, over time, who or what is critical 

in a network might change. ORA can assess change in networks, and forecast possible 

ways in which the network might change in the future. 

9.4 What if information is incomplete? 

ORA can assess networks even when information is incomplete. ORA has been 

built to gracefully degrade so that it calculates all and only those metrics for which there 

is information. 

9.5 Illustrative applications 

ORA has been applied in numerous settings. Examples include the following. 

Assessment of team-x leadership structure at NASA. Comparison of terror networks. 

Identification of vulnerabilities in insurgency and terror networks. Assessing change in 

political elite structures in Korea and early identification of emergent leaders. Designing 

teams for wargames. Assessing the impact of turnover and retirement on public health 

organizations in Duchess County, NY. Identifying waports with AIS data. Organizations 

where ORA has been used include: AFIT, SOCOM, USMA, CIA, many universities. 

9.6 Tool Evolution 

There are still many challenges in the area of dynamic network analysis. Key 

challenges include handling streaming data, locating confidence intervals for metrics, 

uncertainty assessment, and so on. As these challenges are met, new algorithms are 

implemented, tested and added to ORA thus further meeting the user's needs. 
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Social Network Analysis (SNA) 

Social Network Analysis* is a scientific area focused on the study of relations, 

often defined as social networks.  

In its basic form, a social network is a network where the people entities and the relations 

links are a form of connection such as friendship. Social Network Analysis takes graph 

theoretic ideas and applies them to the social world.  

The term social network was first coined in 1954 by J. A. Barnes (see: Class and 

Committees in a Norwegian Island Parish). Social network analysis is also called network 

analysis, structural analysis, and the study of human relations. SNA is often referred to as 

the science of connecting the dots. 

Today, the term Social Network Analysis (or SNA) is used to refer to the analysis 

of any network such that all the entities are of one type (e.g., all people, or all roles, or all 

organizations), or at most two types (e.g., people and the groups they belong to). The 

metrics and tools in this area, since they are based on the mathematics of graph theory, 

are applicable regardless of the type of nodes in the network or the reason for the 

connections. 

For most researchers, the entities are actors. As such, a network can be a cell of 

terrorists, employees of global company or simply a group of friends. However, entities 

are not limited to actors. A series of computers that interact with each other or a group of 

interconnected libraries can comprise a network also. 

9.7 Where to find out more on SNA 

 Scott, John, 2000, Social Networks, Sage (2nd edition) 

 Wasserman, S. & K. Faust, 1994, Social Network Analysis: Methods and 

Applications 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23s
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10 Stargate - Summit - Synopsis 

 

10.1 Story Background 

The data for this scenario is based on the Sci-Fi tv show, Stargate SG-1 and 

specifically the episodes Summit / Last Stand. Following is a synopsis of the episodes if 

you have an questions regarding the dataset. 

10.2 The DataSets 

The Agents – Colonel Jack O'Neill, Major Samantha Carter, Doctor Daniel Jackson, 

Teal'c, Jacob Carter/Selmak, Lt Elliot, Ren'al, Aldwin, Janet Frazier, Major 

Mansfield, General Hammond, Lantash, Narim, Travell, Osiris, Yu 

10.3 The Short of it 

The Tok'ra are planning an attack which would kill all of the head Gou'ald in one 

fell swoop by inflitrating a summit and poisoning them all simultanously. With the help 

of Stargate Command and the U.S. Military they are able to infiltrate the summit. The 

plan is going fine until new information is disclosed which changes everything. 

10.4 The Story 

The Tok'ra have information regarding a secret Gou'ald summit of all the System 

Lords. They devise a plan to destroy the organization once and for all by poisoning theie 

symbiotes, but they have need of one thing. A human (tauri) who speaks fluent Gou'ald. 

Ren'al (the head of the Tok'ra council) travels to Earth to meet with Stargate Command in 

order to recruit Dr. Daniel Jackson. Dr. Jackson is a human who is fluent in Gou'ald. The 

System Lords have declared a truce for the summit and each System Lord can bring one 

human servant. 

SG-1 journeys to the Tok'ra homeworld, Revanna. Jacob Carter, previously of the 

U.S. military but now a Tok'ra, presents the plan to Colonel O'Neill and SG-1. He's 

established himself as a minor Goa'uld in the service of Yu. He can help get Daniel inside 

Yu's home base by using the Reole memory-altering chemical to convince Yu that he is 

his closest human slave, Jarren. 

Elsewhere, the Goa'uld Zipacna, a servant of the new and very powerful Goa'uld, 

welcomes a guest, Osiris. Zipacna offers her a position in service of the Goa'uld, Anubis. 
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Osiris prepares to depart Zipacna's ship for the summit, as Anubis' official representative. 

Zipacna, meanwhile, has learned the location of the new Tok'ra homeworld, Revenna, 

from a captured spy and plans to launch a full-scale invasion. 

Jacob and Daniel successfully dispose of Jerran, and, using the reole drug, trick Yu into 

believing Daniel is his faithful servant. Yu and Daniel depart to the summit. 

Six of the galaxy's most powerful System Lords are waiting: Ba'al, Olokun, Morrigan, 

Bastet, Kali the Destroyer, and Svarog. They are waiting, though, for another guest, the 

powerful Goa'uld who has been dealing them all heavy defeats in battle, but who refuses 

to make his identity known. 

As the attack begins on Revanna SG-1 and SG-17 try to help the Tok'ra, but little 

can be done. The Goa'uld have dialed into Revanna's Stargate, thusly preventing their 

escape. Zipacna continues bombing the surface of Revanna, in an attempt to flush out the 

resistance. As the tunnels collapse many Tok'ra are killed along with Major Mansfield. 

Ren'al encrypts the symbiote poison formula onto a data crystal but is killed by falling 

debris shortly after. Major Samantha Carter takes the data crystal for safe keeping. A 

large holding tank, where the symbiote Lantash is being kept alive, is destroyed and 

Lantash takes refuge in the dying Lieutenant Elliot as a host. 

Colonel O'Neill, Teal'c and the Aldwin do a scouting run on the surface of the 

planet only to find Zipacna has amassed an army of Jaffa troops on the surface. Aldwin is 

killed on their way back to the tunnels. SG-1 regroups but more tunnel collapses prevent 

their escape to the ring room. Their path to the surface is blocked. 

Back at the summit Osiris, the final guest, arrives. Daniel is caught by surprise. Osiris 

had taken possession of his friend Sarah Gardner a year ago. Osiris recognizes Daniel, 

but does not reveal this to the System Lords. 

In private Daniel communicates her arrival to Jacob. Her arrival presents a large problem. 

Osiris confronts Daniel Jackson and demands to know what he's is planning. Daniel 

manages to prick her with his ring containing the reole memory drug and convinces her 

that he is but Yu's human servant. The drug takes affect and she leaves, somewhat 

confused. Col. O'Neill and Teal'c find a set of Tok'ra tunneling crystals which they use to 

grow new tunnels. Major Carter tries to help Lt. Elliot stay alive. 

Oiris tells the System Lords she represents the Anubis, who had been believed to 

be dead for 1,000 years. Anubis has dealt blows to each and every System Lord. Anubis 

wants entrance back into the System Lords. The Goa'uld vote to allow Anubis to rejoin 

them, and for Osiris to represent him. 

Daniel reports this to Jacob Carter. They both agree that the plan to poison the System 

Lords must be aborted. If they wipe out the seven most powerful System Lords now, 

Anubis will be free to conquer the galaxy. 

SG-1 and Lt. Elliot make it to the surface but must still must avoid the Jaffa army. They 

begin the 25-mile walk to the Tok'ra beacon to send a signal to Daniel and Jacob. At the 

beacon Maj. Carter sends a signal to Jacob and Daniel. 
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Jacob tells Daniel to get off the space station. But Daniel decides to attempt to kidnap 

Osiris (still hoping to free her from the Gou'ald). When she arrives, he locks her in the 

hold and readies to steal the ship. But Yu intervenes saying that his servant Jarren has 

betrayed him. He releases Osiris. But believing that Yu plotted to kidnap her she stabs 

Yu. As she prepares to kill Daniel he reveals who he really is. This cause her to hesitate. 

That, and the attack by Yu gives him the opportunity to escape. 

On their return to Revenna Jacob and Daniel are shot down by the Jaffa army and crash. 

SG-1 finds them shaken but unhurt. Lt Elliot/Lantash, knowing he's dieing anyway, 

volunteers to sacrifice himself by taking the symbiote posion and wait to be captured. 

He'll then release the poison clearing the way for SG-1 to escape through the Stargate. 

Colonel O'Neill hates to leave his man behind, but sees that there is no other choice. The 

team goes into hiding. Elliot places the poison in his pocket, and listens as the footfalls of 

the approaching Jaffa army loom ever closer. 
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11 System Requirements 

ORA performs best on machines that meet or exceed the following specifications: 

Spec Windows Mac (running XP) 

System XP OSX 10.4.x 

RAM 256 MB 1GB 

Processor Pentium 4 Intel Core 2 Duo 

Speed 1.0 GHz 2.0 GHz 

Java 6.0 6.0 

Extra  Parallels for Dual Booting 

NOTE : When working with extremely large data sets, increasing processing speed and 

RAM is highly recommended. 

12 RELEASE NOTES: ORA 1.9.0 

TERMINOLOGY CLARIFICATION 

So that the help file mirrors the actual tool in use, some terms have been 

deliberately left in the help documentation that have since been refined in use as they 

specifically apply to the ORA interface. To avoid confusion, the ORA Help will refer to 

terms as they are still used in the ORA interface, though the term may need to be 

updated. However, what follows is a clarification of all key terms one will encounter in 

the both the interface and the help. For other terms, please see Basic Terms in the ORA 

help documentation. 

ENTITY 

Can be who, what, where, how, why, a thing that is being studied. For example, 

entities can be people, agents, organizations, beliefs, expertise areas, resources, tasks, 

events, locations. 

NODE 

The representation of a single entity (a who, what, where, how why item). This 

pertains to actually looking at a network model. In the visual model, entities are called 

nodes. 

META-NODE 

The representation of a group of nodes as one node. For example, if Bob, Carol, 

Ted, and Alice are all accountants, they could all belong to the Meta-Node Accountants 

which would contain all their individual nodes. 

LINK 

The representation of the tie, connection, relation, edge between two nodes. 

META-LINK 

The representation of a Group of links. 

NETWORK 
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The representation of a set of nodes, including meta-nodes, of one type and the links, 

including meta-links, of one type between them. 

META-NETWORK 

The representation of a Group of networks. 

LABEL 

Each entity, node, link or network has a type — what kind it is, is called a label. 

This can be the common name, an id — unique identifying number or some other kidn of 

label. 

ENTITY CLASS 

A set of entities of one type. 

NODE CLASS 

A set of nodes of one type. Note: a set of nodes of one type can be represented as 

a meta-node. 

LINK CLASS 

A set of links of one type. Note: a set of links of one type can be represented as a 

meta-link. 

NETWORK CLASS 

A set of networks of one type. Note: a set of networks of one type can be 

represented as a meta-network. 

GROUP 

A collection of things, such as entities, nodes, ties, and networks. A group might at 

times be represented as a meta-node. 

Nodes may be classified in groups based on a shared attribute, type, id-range, label, 

user selection, etc. For example: if you have a set of people and know their gender, 

then there might be two groups - men and women. 

In addition, the nodes representing those people could be displayed as a meta-node 

for men and a meta-node for women. 

Nodes may be classified into groups based on a grouping algorithm. For example, if 

you have a network showing connections among members of an organization and you 

run a grouping algorithm it will return clusters of nodes that fit together on some 

mathematical criteria. This cluster is a group and can be represented as a meta-node. 

TRAIL 

A set of nodes and links that form a single unbroken chain, such that no node or link is 

repeated. 

PATH 

A set of nodes and links that form a single unbroken chain, such that no nodes and links 

can be repeated.  



 

18 

 

13 What Is ORA? 
13.1 An Overview 

The Organizational Risk Analyzer (ORA) is a statistical analysis package for 

analyzing complex systems as Dynamic Social Networks.  

Many complex systems such as organizations, intra-state alliances, food webs, etc. can be 

represented as an ecology of interlinked networks. Within ORA any complex system is 

represented as a Network. What follows is a general description of ORA's primary 

capabilities. Specific instruction is provided under the correlating folders in this help 

system. 

See Basic Terms for additional definitions relating to Social Networks. 

13.2 The ORA Visualizer 

The ORA Visualizer renders conceptual images of social networks. Nodes such as 

Agents, Task, Knowledge and Organizations represent real-world Entities like the 

president of a company, driving to the airport, or how to wash your clothes. Nodes which 

share the same attributes can be further grouped together creating Meta-Node. Links 

connect nodes that share a direct relationship. Such relationships are derived from the 

Network. ORA's single unit of data input, and are referred to as graphs. The ORA 

visualizer is interactive. You can zoom, rotate, isolate, add and remove Meta-Nodes, and 

much more. 

13.3 Reports 

ORA can run many reports: Risk, Intelligence, and Sphere of Influence to name a 

few. Multiple organizations can be compared against each other, network structure can be 

optimized, subgroups within a network can be identified, and scenarios involving the 

removal of nodes or links can be examined. Reporting capabilities are constantly being 

refined and updated. 

13.4 Charts 

Four chart types are available: Bar Chart, Scatter Plot, Histogram, and Heat Map. 

Each one in turn presents a different statistical profile of a selected nodeset. Examples of 

these reports and how to access them can be found under Basic Usages. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\dna\dna.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html


 

19 

 

14 Where To Begin 

To begin you need data to run in ORA. And not data in just any format. ORA uses 

particular data formats: DyNetML*, .csv*, GraphML*, and a couple others. 

The examples in the ORA help file use a dataset based on the popular Sci-Fi TV show, 

Stargate. You can download a copy of this dataset to practice using ORA at the following 

URL: 

http://www.casos.cs.cmu.edu/computational_tools/datasets/internal/stargate/index2.html 

Another method is to create a MetaNetwork from an Excel spreadsheet and save it as a 

.csv* file.  

Let's now assume you've created a MetaNetwork after reading through the 

documentation. 

From the Main Menu select: File => Open MetaNetwork. Then navigate to the directory 

which contains the MetaNetwork you want. 

If this is the first MetaNetwork you're opening it will appear in panel 1. If there are 

already Matrices open you'll get the following dialog box. 

 

Choose Replace Selected Org to remove the previous MetaNetwork and replace it with 

the current one; 

Choose Append As Additional Org to add it to any MetaNetworks already loaded in the 

ORA session; 

Choose Replace all Orgs to remove any MetaNetworks loaded into ORA and start over 

with the current MetaNetwork only. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\start\basicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\start\basicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\start\basicTerms\basicTerms.html%23g
http://www.casos.cs.cmu.edu/computational_tools/datasets/internal/stargate/index2.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\tasks\createFromExcel\creatingMetaMatrixFromExcel.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\start\basciTerms\basicTerms.html%23c
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15 The Main Interface 

Analysis 

 

Generate Reports – Brings up a dialog box that enables you to run any report on any 

currently active Meta-Network then select the format you want the results. 

Report Selection Wizard – Assists you in selecting the best reports for the selected Meta-

Network. 

Measures Manager – The option allows you to choose which measures are to be used in 

generating reports for the selected Meta-Networks. The dropdown menu allows you to 

chose measures lists which divide them up into categories such as: Slow Measures, 

Critical Risk Employees, and Resource Allocation Risk. 

Attribute Partition Tool – Creates new Meta-Networks using an existing Meta-Networks 

and uses attribute values to affect the result. 

Near-Term Analysis – Tool used to detect the results when a Meta-Node is removed from 

an existing circumstance. See Near-Term Impact lesson. 

Latent Semantic Analysis – Latent semantic analysis (LSA) is a technique in natural 

language processing, in particular in vectorial semantics, of analyzing relationships 

between a set of documents and the terms they contain by producing a set of concepts 

related to the documents and terms. 

Geary-C & Moran-I Analysis – This function performs Moran's I test using phylogenetic 

and spatial link matrix (binary or general). It uses neighbouring weights so Moran's I and 

Geary's c randomization tests are equivalent. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L7-nearTermImpactAnalysis\nearTermImpactAnalysis.html
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16 Attribute Partition Tool 

To create new Meta-Networks which are a subset of nodes use the Attribute 

Partition. Select an Node-Class(es), select the Attribute set, then select the individual 

attribute(s) to form a new Meta-Network. 

 

There are four sections to the dialog box: 

Select a Meta-Network: The dropdown menu lists all the currently open Meta-Networks 

Here I selected "stargate_summit". 

Select Node Class(es): Place a checkmark in the box(es) of the NodeSets you want 

included. 

I selected all the NodeSets 

Select an attribute: This dropdown menu shows all the attribute(s) contained within the 

selected NodeSet(s). If you change the NodeSet(s) the choice of attribute(s) will be 

reflected in this dropdown. 

For an attribute set I selected ally. 
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Attribute Value: Place a checkmark in the box(es) of the attributes you want included in 

the new Meta-Networks. 

Finally I chose two values "yes" and "no". 

Next select the [Compute] button. The following dialog box will appear showing the 

number of new Meta-Networks created. 

 

Close the dialog box. In the main interface you'll see your new Meta-Networks listed in 

Panel 1. The two new Meta-Networks contain, in their names, the source such as ally=yes 

and ally=no. 

 

I returned to the original Meta-Network and opened the agent x location network. Then I 

selected the new Meta-Network for ally=yes and opened that agent x location network. 
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This is the visualization of the NEW stargate_summit — agent x location network with 

the attribute partition active. 

 

This is the visualization of the original stargate_summit — agent x location network with 

no attribute partition. Note: The nodes and links not in the attribute display have be 

lightened for this display only. 

 

With the partition attribute network only the nodes associated with ally=yes are shown in 

the new network.  
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17 Measures Manager 

Before you run any measures on a Meta-Network you can use the Measures Manager to 

set exactly which measures you wish to run. 

Form the main interface menu select Analysis => Measures Manager. 

 

The dialog box has multiple sections: 

17.1 Filter Commands : 

This section comprises two radio buttons (Match at least one filter | Match all filters) 

which allow for complex filterings, a [Reset Filters] button, and a Search textbox used for 

inputing your search. Whatever searches you input in this section are reflected in the 

Tabbed Window below. It will display only the nodes which match the search(es). 

17.2 item(s) Selected | Visible | Total 

When first called up the All Measures tab defaults to showing every measures available. 

When started there were 137 item(s) selected, 137 visible, 137 total. 

Selecting the Slow Measures tab this changes to 16 item(s) selected, 16 visible, 16 total. 
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Typing Cognitive into the seach textbox reduces this to 16 item(s) selected, 8 visible, 16 

total showing that only 8 out of the 16 Slow Measures contain the word Cognitive. 

Furthermore you can deselect measures by removing the checkmark next to the measure's 

name. With each measure deselected the number of selected items will reduce by one. 

With these tools you can select only the measures you want to run reports on. 

17.3 Buttons 

 Reorder 

 Select All : Selects (puts a checkmark in the box) all visible measures 

 Clear All : De-Selects (removes checkmarks) from all visible measures. 

17.4 Tabbed Window 

This section contains tabs which sort the measures into various categories. 

Each of the nine tabs sorts out the measures in different categories. This is very useful for 

large MetaNetworks when you'd prefer not run, say the Slow Measures* cause it would 

put too much a drain on your machine. By removing the checkboxes for the Slow 

Measures they are taken out of the mix and the reports will effectively ignore them. You 

can turn them back on when you're finished by placing a checkmark back in the box. 

In the Tabbed Window there are four columns: 

1. Last Name : Deals the general type of measure (Congruence, Exclusivity, 

Cognitive...). Most entries in this column will display one row as they are singular 

in what they need to show. Others will display two rows as it's nearly the same 

measure run on both knowledge and resources. Then a few (like Centrality) will 

display quite a few rows the types of measures written for that type of measures 

are somewhat varied. 

2. First Name : Deals with the category of the measure (Betweenness, Closeness, 

Centrality...). This is a secondary factoring. 

3. Graph Level : Graph Level* produces a single number as output. 

4. Entity Level : Entity Level* produces one number per entity. 

17.5 Drop-Down Menu 

Gives the user the ability to select which currently active Meta-Network to run the 

measures on, as well as, which individual networks. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23s
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23g
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23e
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18 Near Term Impact Menu 

 

Save the current simulation setting: Brings up a save box where you can navigate to a 

directory and save all the current simulation settings. 

Load a simulation settin from a file: Navigate to a directory to load a previousy saved 

simulation setting. 

NOTE : This will remove any settings that are currently active. 

Close: Closes the Near Teram Ananlysis window. 

 

 

Execute simulation cases: Begins running the simulation. Same function as the [Execute] 

button at the bottom of the window. 
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Show the add simulation wizard: Brings up the creation window. same as the [Add new 

simulation cases] button. 

Add ORA-Intel report based simulation cases: Same as [Add ORA-Intel report based 

simlation cases] button. 

Edit the highlighted case: Brings up the dialog box to edit parameters for selected event. 

Remove the selected cases: Removes selected event from simulations. 

Remove all of the cases: Same as the [Remove all the simulations] button. 

 

 

These menu items will display in the Near Term Results menu:  

Generate evolved Interaction Matrix:  

Generate evolved Agent-to-Agent Matrix: Displays how agents interact with one another. 

Generate evolved Agent-to-Knowledge Matrix: Displays how knowledge is diffused 

within the agent network 

Generate evolved Agent-to-Task Matrix: Display how tasks are used within a network. 
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19 Near Term Impact Analysis 

The Near Term Analysis (NTA) is a tool that allows for the removal of nodes from a 

given organizational structure to evaluate how the organization will likely perform as a 

result. The Near Term Analysis tool uses a multi-agent model as input, Dynet ML*. 

The goal is to provide an answer to the question on how an organization will behave and 

change after considering a sequence of strategic interventions or personnel loss by way of 

agent removal. In other words, we want to know what happens when we remove nodes 

from an organization, be they people, places, resources, knowledge sets or other common 

Node Classes*. 

This example will use the Stargate dataset (SG-1). This dataset is included with the 

version of ORA downloaded and can be found online at the following url: 

http://www.casos.cs.cmu.edu/projects/ora/sample.php. 

From the menu bar select File => Open Meta-Network then select SG1.xml. 

In this example, we will remove two agents: daniel_jackson and maj_samantha_carter  

1. Open the SG1 MetaNetwork into ORA. 

2. Highlight the SG1 Meta-Network before starting NTA in the ORA Meta-Network 

Manager panel. 

3. From the main menu select Analysis => Near-Term Analysis. 

NOTE : If your dataset contains an Organization nodeset ORA will display the NTA main 

window. If not, it will ask for you to chose a substitute Organization nodeset. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23n
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When a Meta-Network is first loaded into ORA's the Near Term Analysis, a pop-up may 

appear asking for a location node. Select Cancel and proceed with the Near Term 

Analysis. 

 
The NTA main window consisted of four sub panels: Input Data, Settings, Simulation 

time line and Cases to simulate. Below is a brief description of each panel:  

 

19.1 1. Input Data 

In this section is the file name of the Meta-Network loaded. 

19.2 2. Settings (Global Parameters) 

In the Setting area are two text boxes. The first, The Number of replications informs 

ORA how many times to run the simulation. The second, The number of simulated time-

points defines the range in the section Simulation time line.  

In the settings area, there are two critical factors: 1) the number of replications and 2) the 

number of simulated time points. 

Why is this important? 
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The number of replications if set at a higher versus lower value, will result in more 

experiments being conducted on the scenario the tool is presented. Therefore, the more 

replications the more likely the results will mirror those in a real world example. 

The number of time points determines the length of the Near Term Analysis iterations. If 

this number is also set to a relatively high value, the simulation will take longer.  

 

NOTE : Be mindful of any memory considerations when running high value replications 

or time points. 

19.3 3. Simulation time line 

This are of the Near Term Analysis tool shows a visual representation of the time points 

selected in Settings area above. 

19.4 4. Cases to simulate 

After the settings (global parameters) are set, the virtual experiment cells need set. 

Initially, there is a pre-defined simulation cell, the Baseline. The Baseline is the cell 

without any entities removed as is the control situation when the organization does not 

experience any interventions. Besides Baseline, any other cells need set up. Start by 

selected Add new simulation instances, the leftmost of the four buttons. 

19.5 Add new simulation cases 

To run a Near Term Analysis, we will begin by selected the Add new simulations cases 

button from the main Near Term Analysis Tool (see area highlighted in red ellipse 

below).  
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After selecting Add new simulation instances button, a dialog box titled Near Term 

Analysis– Simulation scenario create wizard will appear. This wizard supports the 

creation of virtual experiment cells in three different ways. The First allows for the most 

freedom of choice. The second and the third options will ask for a set of criteria for 

selecting important agents in the network and make experiment cells according to the 

selection. Therefore, the first option gives full flexibility to users, and the second and the 

third option provides a systematic analysis setup method. To proceed this demonstration, 

select the first option and select [Next]. 
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19.6 There are four options: 

The next section explores all four of the Near Term Analysis Options: 

Run the Step-by-Step Wizard – This process will help walk through setting up a near 

term analysis experiment on the Meta-Network loaded into the Near Term Analysis tool. 

 

Create one simulation case – In this simulation experiment, events and user-specified 

time can be applied to agents. 

 

Create a set of cases by isolating agents – This scenario isolates one agent and performs 

an experiment. Then the experiment can be performed again with the agent removed. 

Create a set of cases by isolating a set of agents relating to a specific measure. – Based on 

measures contained in the ORA intel report, a set of agents can be isolated and a 

simulation case can be created. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\analysisMenu\nta\nta-option1.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\analysisMenu\nta\nta-option2.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\analysisMenu\nta\nta-option3.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\analysisMenu\nta\nta-option4.html
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20 Near Term Impact Option 1 
20.1 Step-by-Step wizard 

Selecting the first option brings up the step-by-step creation dialog box. 

 

Under Options select whether to isolate an agent, knowledge, or resource. We'll leave it 

at agent. Then select the [Next] button. 

 

Under Options select the agent to isolate. Here we select daniel_jackson. The select the 

[Next] button. 
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Under Options select the time-step to isolate the agent. For this simulation we select 5. 

The select the [Next] button. 

 

At this point you are asked if you want to add more events to the simulation or not.  

You can add as many eventsas you wish. But for this example we'll only use only one 

event. Select [No] to continue. 
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Now repeat the steps above and add a second simulation. But this time let's remove 

daniel_jackson at time-step 25. 

 

Now proceed to Analysis Results. 

21 Near Term Impact Option 2 
21.1 Apply events to specified agents 

The second option for creating simulation files is to create one simulation case and apply 

events to specified agents, knowledge, or resource nodes. 

Select the [Add new simulation cases] button to bring up the wizard. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\analysisMenu\nta\nta-results.html
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1. Type in search criteria to highlight only the agents to work with (i.e. typing in dan 

brought up only daniel_jackson. 

2. Place a checkmark on the line. Notice that when you placed a checkmark in the 

box the Event automatically changed to Isolation. 

3. Double-click in the Timing cell to select it and type in a number from 0 to the 

highest number you selected for your simulation. In this case we'll repeat with the 

timing of "5". 

4. Select the [Add events] button. This places the event in the Simulation event edit 

list section. 

5. If there were more events to add you could continue with the same procedure. 

When you are done, select the [Add a simulaton] button at the bottom. 

The two buttons beneath the Simulation event edit list section to remove events from the 

list. The [Remove all the events] button obviously removes everything in the Simulation 

event edit list but the Remove the selected events from the event list only removes the 

events with a checkmark beside them.  

The [Reset selection] button removes all checkmarks placed in the bottom table and sets 

the Event to No Event. 

The [Previous] button returns to the main Wizard screen. 

When you have finished you will have created the same two simulations as in Option 1. 

 

Now proceed to Analysis Results. 
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22 Near Term Impact Option 3 
22.1 Create set of cases using Measures 

Option 3 allows for selecting agents/knowledge/resources based on their ranking when 

certain measures are run on them. 

 

Here are three examples run with the same Isolation Time and Cut-offs. Only the 

measures were changed. 

22.2 Centrality, Total Degree 

 

22.3 Cognitive Demand 

 

22.4 Clique Count 
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When you have run the measures proceed to Analysis Results. 

23 Near Term Impact Option 4 
23.1 A set of agents by a set of cases by measure(s). 

 

Option 4 allows the addition of adding Time gaps between the isolations and whther to 

isolate them in decending, Ascending, or Random order. 

Now proceed to Analysis Results. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\analysisMenu\nta\nta-results.html
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24 Near Term Impact Results 

Now we're ready to Execute the simulations. But before that you must select the type of 

Output Options you want. From the Near Term Analysis menu select Output Options => 

{any or all of the four options}.  

 

Now select the [Execute] button in the bottom-right corner. This will bring up two dialog 

boxes asking you to confirm you're selected output options and then an alert telling you 

that, this may take a while with a large Meta-Network and a lot of simulation runs. 

 

An alert box will display advising you that the near term calcuation may take a long time 

depenidng on settings of your experiment.  

 

After selected [Execute] the Processing Near Term analysis dialog will show you the 

progress. 
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Next will be displayed the Near Term Analysis results window. 

 

The results of the experiment will compare against the baseline data established prior to 

the removal of any isolated agents. In the example above, we can see how the network 

was impacted in the time line when we isolated daniel_jackson and removed this node 

from the data set. 

24.1 Further information can be obtained form the following references: 

For knowledge diffusion and energy task see Schreiber, C. (2006) Human and 

Organizational Risk Modeling: Critical Personnel and Leadership in Network 

Organizations, PhD Thesis, Carnegie Mellon University, CMU-ISRI-06-120 

24.2 For binary task accuracy 

Lin, Z., K. Carley. 1997. Organizational response: The cost performance tradeoff. 

Management Sci. 43(2) 217-234. 
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25 Near Term Impact Results Menu 

 

Save the Construct launch scripts : Information on Construct can be obtained at the 

following URL: http://www.casos.cs.cmu.edu/project/construct/index.html. 

Show text report on the ORA main window : Displays the report in Panel 3 of the ORA 

Main Interface. 

 

Save the completely evolved MetaNetworks : Will save as an ORA Meta-Network any of 

the simulation cases with a checkmark in the Select column. 

 

Save the html report : Navigate to a directory to save an html file that can be displayed in 

a browser. 

 

Save the text report : Navigate to a directory to save an text file. 

 

Save the Knowledge Diffusion line chart : Saves the chart as a .png file that can be used 

in other documents. 

 

Save the Task Accuracy line chart : Saves the chart as a .png file that can be used in other 

documents. 

 

Save the Energy Task line chart : Saves the chart as a .png file that can be used in other 

documents. 

 

Save the Knowledge Diffusion result CSV file : Saves the results as a .csv file that can be 

used in other programs. 
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Save the Task Accuracy result CSV file : Saves the results as a .csv file that can be used 

in other programs. 

 

Save the Energy Task result CSV file : Saves the results as a .csv file that can be used in 

other programs. 

Close :  

 

Copy the chart in the clipboard : Copies the window to the clipboard that can be pasted 

into other programs. 

 

 

 

Standard Deviation ranges : Standard Deviations* displays the range of values for a 

particular instance. 

Grid lines in the chart : Displays the grid lines for values. 

Legends in the chart : Displays the legend underneath the chart. 

Event annotations in the chart : Displays the event annotations within the chart. 
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Deviation from the baseline : Using the baseline numbers the chart shows the offset for 

the simulation. 

Show actual values : Uses he actual calculated values in the chart. 

 
Background color : choose the background color of the chart of either white or gray. 
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26 ORA Reports 

Reports are one of ORA's core functions. You can access ORA reports from the main 

interface drop-down menu bar or from the Reports button, which should appear in the 

right panel of the main interface after you have loaded a Network. 

From the Main Menu select Analysis => Generate Reports; or 

Select the [Reports] button 

 

ORA Reports provide a computational tool to analyze data that comprise a network as 

representated by a Network(s). They are driven by a variety of key measures* proven 

useful to researchers in the analysis of networks. 

27 ORA Reports 
27.1 Reports 

Reports are one of ORA's core functions, which also include the Visualizer and Chart 

tools. You can access ORA reports from the main interface drop-down menu bar or from 

the Reports button, which should appear in the right panel of the main interface after you 

have loaded a MetaMatrix. 

27.1.1 From the Main Menu select Analysis => Generate Reports; or 

27.1.2 Select the [Reports] button 

The red ellipses on the screen shot below highlight how to access ORA Reports from the 

main interface. 
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ORA Reports provide a computational tool to analyze data that comprise a network as 

representated by a MetaMatrix or MetaNetworks. They are driven by a variety of key 

measures proven useful to researchers in the analysis of networks. 

27.2 Reports Explained 

All Measures - Runs a collection of measures and categorizes the output according to risk 

categories. Each category analyzes a particular aspect of the Meta-Matrix structure. 

Belief - The Belief report contains the most common beliefs shared by most people, the 

beliefs with the highest GINI coefficient, the most strongly held beliefs, the most likely to 

change beliefs, the most neutral individuals, and the most opinionated individuals. 

Capability - This report is used to assess an individuals' and organizations' capability to 

perform tasks. 

CPOF - Analyzes the creation and modification of events and tasks and agent 

collaboration over time. 

Change in Key entities - Analyzes the changes over time of the agents that score the 

highest in measure values. 

Communicative Power - Analyzes one or more mental map models, classifying concepts 

according to their values for selected measures. 

Communicators - Analyzes the communication network (agent by agent) and gives high 

level statistics on its structure. 

Complete - Computes all network analysis measures. 

Context - Compares measured values against various stylized forms of networks in an 

effort to characterize the networks topology. 

Core Network - Computes the core network and reports general statistics. 

Drill Down - Computes the drill down from a selected organization and then to a selected 

agent 

Event Analysis - Computes the central events with respect to other network entities. 

Group Talk - Analyzes the relationships between agent and knowledge. 

Immediate Impact - Computes the key actors of a network, and then isolates them 

individually to determine the effect on measure values. 

Influence Net - Displays the influence network and gives high level statistics on its 

structure. 

Intelligence - Identifies key entities and groups who by virtue of their position in the 

network are critical to its operation. 

Located Subgroups - Identifies the subgroups present in the network using various 

grouping algorithms. 

Location Analysis - Computes the central locations with respect to other network entities 

Management - Identifies over and underperforming individuals and assesses the state of 

the network as a functioning organization. 

Merchant Marine - Analyzes the relationships between crew members, owners, vessels 

and locations of the Merchant Marine Vessel data. 
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MRQAP - For multivariate cases, if your dependent variable is continous or count data 

(like in a negative binomial case), you should use MRQAP. If your dependent variable is 

binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform 

MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent 

to using a linear probability model). You do need to interpret your results accordingly. 

Potential Errors - Detects potential errors in agent to agent interactions based on the 

expected interactions from cognitive similarity and expertise. 

QAP Analysis - Computes QAP Correlation and Regression (Dekker and Y-Permutation 

methods) on input matrices. QAP is designed as a bivariate test (only two variables). 

Generally, QAP is perfectly fine for almost any bivariate network problem. 

Semantic Network - Analyzes one or more mental map models, computing the central 

graphs and key concepts and statements. 

Shortest Path - Computes the shortest path between two entities and general statistics on 

the paths. The Sphere of Influence on each entity is also computed. 

Simmelian Ties Analysis - Calculates the number of Asymmetric, Sole-Symmetric, and 

Simmelian ties in all Agent by Agent and Organization by Organization graphs and 

computes the standard measures on them. 

Sphere of Influence - For each individual, identifies the set of actors, groups, knowledge, 

resources, etc. that influence and are influenced by that actor. 

Standard Network Analysis - Calculates the standard network analysis measures (degree 

centrality, betweenness, centrality, etc.) 

Trails - Analyzes the trails that an entity class makes through another entity class; for 

example, how vessels pass through ports.  

Version Test - Recomputes the measures contained within the DyNetML file and 

compares them with the existing measures. This is a diagnostic tool. 

28 Report Overview 

All Measures - Runs a collection of measures and categorizes the output according to risk 

categories. Each category analyzes a particular aspect of the Network structure. 

 

Belief Propagation - The Belief Propagation Report contains the most common beliefs 

shared by most people, the beliefs with the highest GINI coefficient*, the most strongly 

held beliefs, the most likely to change beliefs, the most neutral individuals, and the most 

opinionated individuals. 

 

Capabilities - The Capability Report is used to assess an individuals' and organizations' 

capability to perform tasks. 

 

CPOF - Analyzes the creation and modification of events and tasks and agent 

collaboration over time. 

 

Change in Key entities - Analyzes the changes over time of the agents that score the 

highest in measure values. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\reports\beliefs\beliefReport.html
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Communicative Power - Analyzes one or more mental map models, classifying concepts 

according to their values for selected measures. 

 

Communicators - Analyzes the communication network (agent by agent) and gives high 

level statistics on its structure. 

 

Content Analysis - Used in conjunction with AutoMap. Creates a new Network 

(Semantic Network Union) and will reveal the most frequent concepts and the least 

frequent concepts. 

 

Context - Compares measured values against various stylized forms of networks in an 

effort to characterize the networks topology*. 

 

Core Network - Computes the core network and reports general statistics. 

Custom - Lets the user define a custom set of measures and output formats, name the 

report, and then add it to the list of custom reports callable from the main interface. 

 

Drill Down - Computes the drill down from a selected organization and then to a selected 

agent 

 

Group Talk - Analyzes the relationships between agent and knowledge. 

Immediate Impact - Immediate Impact computes the key actors of a network, and then 

isolates them individually to determine the effect on measure values. 

Influence Net - Displays the influence network and gives high level statistics on its 

structure. 

 

Key Entity - Runs a report on the Network for Overall Complexity, Social Density, 

Social Fragmentation, Communication Congruence, Knowledge Congruence, 

Performance as Accuracy, and Avg Communication Speed. (Replaces the Event 

Analysis, Intelligence, and Location Analysis Reports). 

 

Located Subgroups - Identifies the subgroups present in the network using various 

grouping algorithms. 

 

Management - Identifies over and underperforming individuals and assesses the state of 

the network as a functioning organization. 

 

Merchant Marine - Analyzes the relationships between crew members, owners, vessels 

and locations of the Merchant Marine Vessel data. 

 

Potential Errors - Detects potential errors in agent to agent interactions based on the 

expected interactions from cognitive similarity and expertise. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\reports\mentalModel\mentalModelReport.html
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Public Health - Runs measures on the network and the sub-networks created by grouping 

people with the same value for the choosen attribute. 

 

QAP/MRQAP Analysis - Computes QAP Correlation* and Regression (Dekker and Y-

Permutation methods) on input matrices. 

 

MRQAP - For multivariate cases, if your dependent variable is continous or count data 

(like in a negative binomial case), you should use MRQAP. If your dependent variable is 

binary, you should use ERGM (P*) which is forthcoming in ORA. One can perform  

 

MRQAP on data that have a dichotomous dependent variable (basically, this is equivalent 

to using a linear probability model). You do need to interpret your results accordingly. 

 

QAP Analysis - Computes QAP Correlation and Regression (Dekker and Y-Permutation 

methods) on input matrices. QAP is designed as a bivariate test (only two variables). 

Generally, QAP is perfectly fine for almost any bivariate network problem. 

Semantic Network - Analyzes one or more mental map models, computing the central 

graphs and key concepts and statements. 

 

Shortest Path - Computes the shortest path between two nodes and general statistics on 

the paths. The Sphere of Influence on each entity is also computed. 

 

Simmelian Ties Analysis - Calculates the number of Asymmetric, Sole-Symmetric, and  

 

Simmelian ties* in all Agent by Agent and Organization by Organization graphs and 

computes the standard measures on them. 

Sphere of Influence - For each individual, identifies the set of actors, groups, knowledge, 

resources, etc. that influence and are influenced by that actor. 

Standard Network Analysis - Calculates the standard network analysis measures (degree 

centrality, betweenness, centrality, etc.) 

 

Trails - Analyzes the trails that an entity class makes through another entity class; for 

example, how vessels pass through ports.  

 

Unique Trails Report - Analyzes the path of an entity class through locations over time. 

Version Test - Recomputes the measures contained within the DyNetML* file and 

compares them with the existing measures. This is a diagnostic tool. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23q
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\reports\mentalModel\mentalModelReport.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23s
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23d


 

49 

 

29 Report Selection Wizard 

The Report Selection Wizard provides step-by-step help to perform common analytical 

reports on your data with a series of pop-up windows requesting input. This tool will help 

identify the reports that are most relevant to the type of information provided.  

From the main menu select Analysis => Report Selection Wizard 

This will bring a series of dialog boxes asking for the Networks, aspects, what you want 

to know, and what you're concerned about. After answering thequestions ORA will run 

the reports that are more concerned with what you've indicated you need. 

 

 



 

50 

 

 

 

After selecting [Finish] ORA will generate it's reports and open them in both your 

browser and also in panel 3 of the main interface. Below is the beginning of the report 

run on the stargate dataset. 

Since this function has such a large number of possibilities it's impossible to demonstrate 

them all. 

29.1.1.1 Your actual report will be much longer. 

 

29.2 MANAGEMENT REPORT 

Input data: embassy_tanzania_ct_period3 

Start time: Mon Jul 16 15:42:34 2007 

29.3 KEY INDIVIDUALS 
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29.4 Emergent Leader (cognitive demand) 

Measures the total amount of cognitive effort expended by each agent to do its tasks. 

Input graph(s): Agent x Agent 

   

Rank Value Agent 

1 0.378917 fazul_mohammed 

2 0.353604 khalfan_mohamed 

3 0.305313 mohamed_owhali 

4 0.280313 jihad_mohammed_ali 

5 0.276083 mohammed_odeh 

6 0.243792 abdullah_ahmed_abdullah 

7 0.192542 mohammed_salim 

8 0.183771 ahmed_the_german 

9 0.180042 wadih_el-hage 

10 0.177292 ahmed_ghailani 

29.5 Report continues... 

30 Simulated Annealing Network Optimization 
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Select the Measures you would like to optimize. Note that you can select multiple 

measures to be optimized simultaneously. Graph Level* allows you specify the Entity 

type (Agent, Agent; knowledge, knowledge; Task, Task; Resource, Resource). The black 

circles below highlight the areas of the Network Optimizer window pane that allow you 

to customize your network optimization. 

 

After you have selected the measures you are interested in optimizing, select the [Next] 

button. 

 

Choose the sub-networks that to be varied during the optimization process. If you chose 

Monte Carlo method you should also specify if you would like to run optimization with 

fixed or random density, and if you want to keep at least one non-zero element in every 

row of sub-Network. 
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Select the [Next] button 

Then choose the optimization criterion: Sum or Product. 

 

Select the [Next] button 
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Specify the location for the data log file, without specifying an extension. Select Verbose 

if you want to analyze the whole process of optimization. 

 

Select the [Finish] button 

The data log file will be displayed in the bottom panel of the main ORA Main Interface 

window. 

31 Meta-Network Anonymizer 

The Meta-Network Anonymize tool removes IDs (and optionally Titles) from any chosen 

NodeSet. 

This is particularly helpful if you are discussing sensitive network information about real 

people and wish to remove their names from the network model.  

From the main menu select Data Management => Meta-Network Anonymize…. 
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1. Select a Meta-Network : All active Meta-Networks appear in the dropdown menu. 

Select the Meta-Network to anonymize. 

2. Select the node class to anonymize : Placing a checkmark in the box next to the 

NodeSet selects the NodeSet to be anonymized. Both the ID and Title will be 

replaced by an identical value. 

3. Anonymize node titles : A checkmark in this checkbox tells ORA to also 

anonymize the title attribute. 

4. Create decoder files : Creates a .CSV* file for future reference with the Encoded 

ID/Title and Original ID/Title 

31.1 Example 

On the left is the Agent NodeSet was selected without the Anonymize node titles 

checked. If the Anonymize node titles had been checked the NodeSet would have been 

changed as appears on the right. 

NOTE : ORA places the same value in both the Node ID and Node Title when Anonymize 

node title is checked. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c


 

56 

 

 

31.2 Writing The File 

When the [Anonymize] button is selected ORA writes a .CSV* file. The Save box allows 

the user to navigate to a directory to save the file. 

Encoded ID,Original ID 

A-1,A01 

A-2,A02 

A-3,A03 

A-4,A04 

31.3 Node Title 

If the Anonymize node title is selected then ORA will also write the original Title to the 

file. 

Encoded ID,Original ID,Title 

E-1,E01,revanna_meeting 

E-2,E02,summit_meeting 

E-3,E03,revanna_bombardment 

E-4,E04,sgc_meeting 
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32 Network Algebra 

The Network Algebra allows you to perform mathematical operations on two Meta-

Networks. The options in ORA are addition, subtraction, and multiplication. 

Note: The term Network Algebra is synonymous with Matrix Algebra in computational 

parlance. Also, the following images display "Matrix Algebra" in the title bar. This may 

or may not be the case for the most recent version of ORA.  

These functions help spot strong and weak connections within a Meta-Network. 

I start with one Network loaded. 

 

From the menu select Data Management => Network Algebra… 

The Network Algebra dialog appears. There are six areas which you can manipulate. 

These are each described below the dialog box. 

Note : Both Networks should be the same dimensions. 

1. Select a MetaNetwork 
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This dropdown menu will show all the Networks you currently have active. To 

perform a math function on a Meta-Network, highlight it in the dropdown menu. 

2. Select an Operation 

 

This option allows you to choose which operation, Add, Subtract, or Multiply, 

you want to perform on the Networks. 

o Add: Adds together corresponding cells of two different Networks. 

o Subtract: Subtracts corresponding cells of two different Networks. 

o Multiply: Multiplication is slightly different than the add or subtract. The 

number of rows in the first Meta-Network must equal the number of 

columns in the second. A Meta-Network can be multipied by itself to help 

reveal specific strong and weak areas. 

 Add Networks:  

 Subtract Networks:  

 Multiply Networks:  

 Dot Products Networks:  

 Set the Diagonal:  

 Add by a Scalar:  

 Subtract by a Scalar:  

 Multiply by a Scalar:  

 Divide by a Scalar:  

 Transpose:  

3. Select Network 1: 

Next select the first Network you want to work with. 
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4. Select Network 2: 

Then select the second Network to do the algebra on. 

 

5. Add Network: 

If you wish, you can add additional Networks to the equation. Different selections 

in the previous choices will give you different options in each dropdown. 

 

6. Enter a name for the new Network: 

When everything is set, type in the name for your new Network. 

Finally, select [OK] to create you new Network. You can then create more 

Networks if desired. When done, select [Cancel] to remove the dialog box from 

the screen. 

Your new Network will now appear in the box with your Meta-Network. Next 

highlight the Network you just created. 

 

Next, select the [Visualize Only this Network] button 

 

You will get a warning box asking if you're sure you want to visualize only one Network. 

Select [OK] to run the visualizer or close the box. 
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This will bring up the visualizer displaying the Network. Your display will depend on the 

Network selected. In this particular example there are only Agents and Links connecting 

Agents displayed in the Visualizer and the Legend. 

 

 

Now we'll create a second Network by using the multiply operation. The second Network 

will put knowledge into the mix. 

32.1.1 Note : Remember to name your file something different. 
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Highlight your newly created Network and select the Visualize Only this Network once 

again and select OK in the dialog box. 

 



 

62 

 

This time, since a Network with knowledge was selected the Visualizer and Legend 

display both Agents and Knowledge and also the Links connecting them all. Also the 

Matrix Algebra selected was multiplication it creates links which were not in the original 

Network. 
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33 Data Management 

 

These sets of menu items enable you to control the addition or removal of Meta-

Networks, Meta-Nodes, and Networks as well as adding Attributes to a Meta-Node. 

The Matrix Algebra*, Meta-Network Transform*, and Meta-Network Union… also 

create new Meta-Networks, Meta-Nodes, and Networks but do it with Mathematical 

operations. 

Meta-Network Algebra… – Enables you to perform mathematical operations on two 

Meta-Networks. 

Meta-Network Transform… – Tools which enable you to clean up a visualizer display 

making it easier to read. 

Meta-Network Anonymize… – Used for resetting the NodeID (and optionally the Node 

Title) to anonymous values. 

Meta-Network Union – Creates a single Meta-Network from two (or more) existing 

Meta-Networks. 

Meta-Network – Used for adding or removing Meta-Networks from use. 

Node Class – Enables you to add, remove Node sets, as well as, change the size of the 

Node set. You can also add an Attribute to an existing Node Set. Depending on what you 

have selected different options may be greyed out. 

Network – Similar to Node Class in that you can add or remove Networks. This function 

also enables you to Set the Diagonal of a graph to either -1, 0 or +1. Useful for setting 

consistent values on an agent-by-agent Network. 
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34 Meta-Network Union 

The Meta-Network Union is used to combine two or more Meta-Networks together. 

There are tools to select which Meta-Networks to use or exclude and how to combine the 

link weights. ORA can save out the result as an entirely new MetaNetwork file.  

 

The Select a collection of meta-networks has two options.  

 Currently loaded in ORA will create a new Meta-Network from all the Meta-

Networks loaded into ORA (except the ones that are sxcluded). 

 All files in the directory allows you to navigate to a directory in which are stored 

multiple Meta-Networks. 

Next is Select filters which narrows the Meta-Networks to use. 

 Use only meta-networks in the date range: filters meta-networks which fall 

outside the selected dates. This information is maintained in a separate document 

file. 

 Use only meta-networks with source: filters meta-networks which contain the 

source information contained in a separate document file. 
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Next is Select how to combine edge weights: contains the options for reducing the 

amount of edges within a Meta-Network. 

 

I start out with two Meta-Networks, stargate_summit_allies and 

stargate_summit_badGuys and I will join them together into a single Meta-Network. 

Both the existing Meta-Networks contain 15 nodes. 

 

From the main menu select Data Management => Meta-Network Union… 

 

There is now a new Meta-Network in panel 1 called Union which is a combination of the 

two other Meta-Networks. 
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35 Matrix Transform 

On some occasions the display in the Visualizer is too cluttered to make much sense of 

your network model. ORA offers a variety of ways to clean up the display in order to 

make it easier to view your data. 

In the main menu select Data Management => Meta-Network Transform…. 

 

The Meta-Network Transform dialog box will appear. It consists of three sections. The 

top section display a dropdown menu with all the currently active Meta-Networks. Use 

this menu to select the Meta-Network. The bottom section has two tabs. The Entire Meta-

Network contains choices on how to transform the Meta-Networks. The Individual 

Networks tab allows you to select to work on onlyindividual networks. 

35.1 The "Entire Meta-Network" tab 

Remove Isolates 

Removes any isolates* from the selected meta-network. 

Remove Pendants 

Removes any pendants* from the selected meta-network. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23i
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23p
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Symmetrize by Method 

Symmetrize turns directed or asymmetric network data into undirected or symmetric data. 

All three methods use a pair of values from the upper and lower portions of the table (e.g. 

cell 1, 3 is compared to cell 3, 1). If a network had a link from A to B but not from B to A 

then symmetrizing the network would create a reciprocal link from B to A. 

 Maximum Compares the values and uses the larger of the values. This is called 

using the strongest value. 

 Minimum Similar to Maximum only it uses the lower, or weaker, value. 

 Average takes the two values and averages them. 

Symmetrize bipartite graphs: 

Symmetrize bipartite graphs* combines networks in the Meta-Network that are 

transposes of each other; for example, if there is an Agent x Location Network and a 

Location x Agent Network, then a single Agent x Location Network is created by 

combining the edges from both Networks. 

This is used to reduce the number of Networks in a Meta-Network when Link 

direction does not matter. 

Remove Links: 

When using weighted links this functions allows for links to be removed from view. You 

can choose form six options for the removal of links. 

 

Binarize (set link weights to one): 

Binarize* takes all links weighted greater than 0 and make them all equal to "1". All links 

will be either 1 or 0. 

Create partition Networks by attribute: 

This partitions the Node Set according to the values of the specified entity attribute and 

then creates a group of new graphs based on the partitioned Meta-Node. This kind of 

grouping is often done in network analysis to understand how some Meta-Nodes are 

embedded in various social roles or how they interact within larger Meta-Nodes. The 

dropdown menu will contain all the attributes in the meta-network. 

Example, if you have an Agent Meta-Node that has a gender attribute for each node that 

takes on values male and female, then using this feature four new Agent x Agent 

Networks would be created that contained links from males to males, males to females, 

females to males, and females to females. No new Meta-Node is created and no data is 

changed. 

Create union matrices 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23b
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This creates new graphs that are the union of all graphs of the same type. If the Meta-

Network had two Agent x Agent Networks, then using this feature would create a new 

Agent x Agent Network which would contain all the links that were present in the 

original two Networks. 

Create a meta-matrix (one matrix with one node class) 

Creates a new Meta-Network with a single NodeClass and a single Network. The nodes 

are prefixed with the name of the nodeCLass they were taken from. 

35.2 The "Individual Networks" tab 

Choose one or more networks to transform by placing a checkmark in the box. If you 

want to exclude a network, remove the checkmark. 

Then select one or more transformations to apply : 

 

Symmetrize by method :  

Symmetrize is a tool that is used to turn directed or asymmetric network data into un-

directed or symmetric data. All three methods use a pair of values from the upper and 

lower portions of the table (e.g. cell 1, 3 is compared to cell 3, 1) 

Remove links :  

When using weighted links this functions allows for links to be removed from view. You 

can choose form six options for the removal of links. 

Binarize (set link weights to one) :  

Will take any weighted link and make them all equal to "1". 

Transpose the given matrix :  

36 Copy / Paste 

ORA offers multiple options for copying Meta-Networks, NodeSets, and Newtworks. 

Copy/Paste Editor Values: 

The easiest way is to use the Ctrl-C keystroke to copy and the Ctrl-V keystroke to paste. 

A duplicate of the Meta-Network, NodeSet, or Network will appear underneath the 

original. 

Copy / Paste Meta-Network duplicates the selected Meta-Network. 

Copy / Paste NodeSet duplicates the selected NodeSet. 

Copy / Paste Network duplicates the selected Network. 

Copy / Paste Values duplicates the values selected in the Editor. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\editMenu\cpMatrix\cpMatrix.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\editMenu\cpNodeSet\nodeSet.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\editMenu\cpNetwork\cpNetwork.html
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37 Copy / Paste Meta-Network 
37.1 Create New Network from Existing Network 

What follows are procedures to create a new Network with previously existing data. This 

is useful to do to experiment on your data by duplicating an entire Network thus 

preserving the original data set. 

Highlight the Network you want to duplicate. 

 

From the main menu select Edit => Copy Meta-Network. 

Notice that only the Copy Meta-Network is available. The Paste Meta-Network option is 

greyed out. Once you have copied a Meta-Network the Paste Meta-Network will become 

active indicating you have information in the clipboard. 

 

From the main menu select Edit => Paste Meta-Network. 

At this point the Paste Meta-Network will become solid. 

 

There will now be a second Meta-Network with the same name as your original file. 
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It's best to differiante this from the original file so we'll attach -NEW to the end of the 

filename. In panel 2 you'll find a textbox titled Meta-Network ID. Change the name to 

whatever you need in order to differentiate it form the original file. 

 

You'll notice in panel 1 that each Meta-Network now has an individual name. 

 

38 Copy / Paste Network 

Copy / Paste Network is very much like Copy / Paste NodeSet, the ability to quickly 

duplicate Networks.  

First, select the network to duplicate. 

 

From the main menu select Edit => Copy Node Network(s) 
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From the main menu select Edit => Paste Node Network(s) 

 

A dialog box will appear asking for the name of the new Network. Type in a new name 

and select [OK]. 

 

Your new Network set will appear underneath the selected Network 

 

You can also select multiple Networks for duplication. ORA will ask you to input a new 

name of each of the newly created Networks. 
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39 Copy / Paste NodeSet 

If you find the need to run a destructive routine on a nodeset then creating a duplicate is a 

good idea.  

First, select the node to duplicate. 

 

From the main menu select Edit => Copy Node Class(es) 

 

From the main menu select Edit => Paste Node Class(es) 

 

A dialog box will appear asking for the name of the new nodeset. Type in a new name 

and select [OK]. 

 

Your new node set will appear underneath the selected NodeSet. 
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You can also select multiple NodeSets for duplication. ORA will ask you to input a new 

name of each of the newly created NodeSets. 

 

40 Copy / Paste Editor Values 
40.1 Creating a new Meta-Node 

There are times you need to create a new Meta-Node with existing values from another 

Meta-Node. What follows are procedures to accomplish this task:  

In this example a second Meta-Node will be created from the original set of nodes. 

[agent] size: 30. 

 

Select the Add New Node Class... button. 
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This will bring up the Create node Class dialog box. I give it a new name, Agent-new, 

leave the type as Agent, and set the Enter a size for the NodeSet to 4 in order to create a 

new set with only the members of SG-1. Then select the [OK] button. 

 

A new NodeSet will appear in the left panel, Agent-new [Agent]: size 4. 

 

Go back to the original NodeSet. 

 

Move the pointer into the topmost cell. Click in the cell col_jack_o'neill. Without 

releasing the button slide down four cells to teal'c. 
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From the main menu select Edit => Copy Editor Values. 

 

Re-Select the new NodeSet. 

 

Move the pointer into the topmost cell and click the button. Now drag the pointer down 

to the bottom cell. 

 

From the main menu select Edit => Paste Editor Values 
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The values are now copied into the new NodeSet. 

 

41 Edit Menu 

Below is an image of the Edit Menu. Further below is a description of the Edit Menu 

functions accessible through the Edit Menu.  

 

Copy Editor Values / Paste Editor Values 

Used to transfer information between Meta-Nodes. The Meta-Nodes created can be 

identically sized (allowing you to paste an entire column in) or a smaller, subset 

allowing you to choose only a portion of the original set. 

Copy Meta-Network / Paste Meta-Network 

Used for quickly creating duplicate Meta-Networks. When you first start the program 

the Paste Meta-Networks is greyed out. It will only become active once you've used 

the Copy Meta-Network menu item. 

Preferences 

Contains settings for controlling the environment for working within ORA. 

42 Preferences 
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42.1 Setting up your environment 

The ORA preferences tool allows you to group Reports and a set of files to open 

automatically thus saving the analyst time when revisiting data reports. 

42.2 Reports 

From this window you can rename and restore report names, export settings for automatic 

loading, and import previously created data sets. Below is the default preference window. 

 

To rename a report Right-click on the name. A small box will popup, Rename this 

Report. If you wish to rename this report Left-click the box. 
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A dialog box will appear. Enter the name you want to rename the choosen report. 

 

In this case I chose the name fizzbin. 

 

To rename the report select OK. The report formerly known as Change in Key Modes is 

now know as fizzbin. 
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Now say you wish you hadn't renamed all those reports cause a name like fizzbin really 

doesn't make much sense. Select the button marker Reset report names. A dialog box will 

appear asking if you want to reset your report names. 

Note: Resetting report names resets ALL report names! 

 

Now all your reports names are back to their defaults. 
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Now let's say that you know that you don't need ever single report to show up in the 

program. You can set which reports are visible and hidden. By unchecking the box to the 

left of the name the report will be invisible to the program. 
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42.3 Export Settings 

After you've finally decided which reports you want visible (and invisible) and what you 

want all your reports to be called you can save this setting for future reference. So even if 

someone else changes report names or visibility settings you can call your personnel 

setting up and quickly resume your work. 

First select the Export Settings button at the bottom of the dialog box. This will bring up 

a second dialog box. Select OK to confirm this is the action you wish. If not, select the X 

in the top-right corner. 

 

This will bring up a Save dialog box. Type in the name you want to save your settings at 

and select Save 

 

So the next time you start up the program and names and settings have been changed you 

can select Import Settings, navigagte to the directory you saved you Settings file and 

have ORA reset the nanmes and visibility settings. 
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Save this file in a place you remember so you can call up your settings quickly. 
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42.4 Data Sets 

This dialog box controls what Networks will load up during startup. There are three 

options. 

 

42.5 1. Do not load any files at startup 

ORA will start up with no files loaded in panel 1. 

42.6 2. Restore presviously loaded workspace 

Whatever files were loaded (and saved) when you quit the program last will be reloaded 

the next time the program is started. 
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42.7 3. Load specified files below is a little more involved. 

First select the Load specified files below radio button. Then select the Add Files button. 

 

The Open dialog box will appear. Navigate to the directory of the files you want to 

automatically open. Select one or more files. In order to select more than one file press 

and hold the Ctrl key while selecting multiple files. You will see them appear in the File 

name text field. When you have selected all your files select the Open button. 
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In the Ora preference dialog box the files you selected will appear under the Add Files 

button. 

 

If at some time in the future you wish to delete one or more of the files you selected from 

automatically opening up on startup you can clear multiple files form the list. Select one 

or more files (pressing and holding the Ctrl key for multiple files. Then select the OK 

button. 
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You will be prompted to confirm your choice. 

 

If you selected Yes then the selected files will be removed from the list of files to load at 

startup. 
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43 CASOS Email Parser (CEMAP) 

CEMAP is an ORA tool that primarily allows you to pull network data in the form of 

emails into ORA. However, the CEMAP tool could be used to convert any sources of 

data in the world into DyNetML, ORA's native file format, for analysis.  

Setting up CEMAP is similar to setting up a new ISP mail client. What follows are 

procedures to configure this tool and how to use it.  

 

Each email has an identifying number in a long number showing the date, for example: 

[20060308042751s1500bii66e]. The 20060308 is in the year/month/day format and says 

this email was sent on March 8, 2006. 

 

The CASOS Email Parser (CEMAP) that is launched through AutoMap/ORA 

(http://www.casos.cs.cmu.edu/projects/automap/software.html) enables the extraction of 

different types of network information from emails (e.g. who exchanges information, 

who provides what information, etc.). The following image shows what types of 

information can be extracted with CEMAP. 

 

Network type1 Social network (SN) represents social network data that can be extracted 

from email headers (e.g. agent-agent networks). In Social Nnetworks, entities represent 

people, and edges represent exchanged emails (frequency count). This network type does 

not require any text coding in AutoMap. 

 

Networks types 2 and 3 are extracted by performing text coding in AutoMap. More 

specifically, Knowledge Networks (KK) represent semantic network or mental models 

that are contained in the bodies of individual emails. In KK, entities represent knowledge 

items, and edges represent the co-occurrence of terms in text. For Meta-Matrix (MM), 

texts are coded in AutoMap according to a taxonomy or ontology (e.g. meta-matrix, 

while are ontologies can be specified by the user). In MM, entities represent instances of 

categories (e.g. agent, knowledge, resources) of the ontology, and edges represent co-

occurrences of terms in texts. 
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Networks types 4 and 5 result from the combination of SN with KK and MM, 

respectively. In type 4, entities represent people and knowledge, and edges represent 

emails and mental models. In type 5, nodes represent the categories of the taxonomy as 

specified by the user, and the edges represent the co-occurrence of the terms that 

represent instances of the taxonomy in the corpus. For the creation of type 4 and 5, the 

extraction of type 2 and 3, respectively, is mandatory. 

 

CEMAP stores all network data as DyNetML files (a derivate of XML). This data can be 

analyzed with any package that reads DyNetML. We recommend using the ORA 

software for this purpose (http://www.casos.cs.cmu.edu/projects/ora/index.html). 
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43.1 The Top textfields 

 Input File -or- HTTP URL 

Input File -or- HTTP URL – Input Data Set. You specify the email client, inbox type, 

username, and password as semicolon separated values. The location can be either 

file or server (e.g. pop.gmail.com;INBOX;JohnDoe;JohnDoesPassword). 

43.1.1 NOTE : The following information is what is needed to access an 

email account. 

 Server – The IP address or URL of the server. 

 Port – The port on the server to connect to. 

 UserID – ID of the User. 

 Password – The User's Password for accessing the Mailbox. 

 Mailbox/Folder – The ID of the mailbox to use. 

lip>File Directories  

43.2 The Directory Buttons 

 This section allows the user to dictate where the end files will be written to. 

 Select Output Directory for full document bodies – Directory to save the body of 

the email text. 

 Select Output Directory for document bodies (new content Only) – Directory to 

save body of the email. Discards all the repeat material that is quoted from 

previous emails. 

 Select Output Directory for document bodies (forward content Only) – Directory 

to save Forwarding content. 

 Select Output Directory for SubjectLine Bodies – Directory to save the Subject 

Lines of the email. 

 Select Output Filename for Header Network file – Directory to write a single 

containing the Header. 

43.3 Checkboxes at the bottom 

 Anonymize Agents – Anonymize Agents changes the agents name (only agents) 

to A# (# is a number) in DyNetML. 

 SSL (Secure Sockets Layer) (For IMAP and POP3 only) – Creates a secure 

connection between a client and a server, over which any amount of data can be 

sent securely. 

 De-Dupe Messages – Ignores identical emails. 

The file prefix makes it possible to put all the files in the same directory 
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43.4 The Start Button 

The Start Extraction button begins the process. 

43.5 Extraction of network type 1 data: 

1. This network type is needed to perform social network analysis (SNA) based on 

header information only. 

2. In CEMAP, Analysis Type, select the type of your mail box. 

3. In CEMAP, Input Data Set, specify your email client, inbox type, username, and 

password as semicolon separated values, e.g. 

pop.gmail.com;INBOX;JohnDoe;JohnDoesPassword 

4. In CEMAP, Enter Destination Directory for Texts, put in a directory of your 

choice, e.g. C:\textInput. The email bodies will be stored in AutoMap format (.txt) 

under this directory. Make sure that this directory does exits on your machine. 

5. In CEMAP, Enter Destination File for Network, put in a directory AND filename 

of your choice. The filename extension needs to be .xml. e.g. C:\output\AA.xml. 

6. You are now ready to extract network type 1. In order to do so, press the Start 

Extraction button. As a result, CEMAP will extract network data from the email 

headers (e.g. agent by agent) and store it as one XML file under the directory that 

is specified in the Destination File for Network. 

7. You can pick up the output file and load it into the SNA package of your choice. 

We recommend using the ORA package 

(http://www.casos.cs.cmu.edu/projects/ora/download.php). 

To extract networks of type 2, perform Semantic Network Analysis in AutoMap. 

To extract networks of type 3, perform Meta-Matrix Text Analysis in AutoMap. 

To extract networks of type 4, merge networks of type one and 2. 

To extract networks of type 5, merge networks of type one and 3. 

CEMAP is a feature in AutoMap that will import email files into AutoMap to analyze the 

text in the emails, such as who exchanges information, who provides what information, 

etc. 

43.6 To use the feature: 

 In the AutoMap menu bar, select Tools => Open CASOS Email Parser (CEMAP). 

 In the ORA menu bar, select File => CEMAP Email-Importer…. 

Once that is selected the CASOS — Email Analyzer window will appear. The 

Email Analyzer window is where you will type in your information of what type 

of network you would like to create while importing your emails.  

43.7 The different types of imports are 

o Full email 

o Header information only 
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o Forwarded/New emails 

o Subject lines only 



 

93 

 

43.8 Type Selection 

Select the type of Format your email is in, from the drop down menu. 

o MBOX – A generic term for a family of related file formats used for 

holding collections of electronic mail messages. All messages in an mbox 

mailbox are concatenated and stored as plain text in a single file. The 

beginning of each message is indicated by a line whose first five 

characters are "From" (the so-called "From_ line" or "'From' line") and a 

blank line is appended to the end of each message. For a while, the mbox 

format was popular because text processing tools can be readily used on 

the plain text files used to store the e-mail messages. This is want you see 

when you View Source in a browser. 

o POP3 – (Post Office Protocol) version 3 (POP3) is an application-layer 

Internet standard protocol to retrieve e-mail from a remote server over a 

TCP/IP connection. 

o IMAP – (Internet Message Access Protocol) Is an application layer 

Internet protocol operating on port 143 that allows a local client to access 

e-mail on a remote server.  

o TXT – Exported email files from outlook – will require a Data (file) set 

identifier 

o CasosDB – for internal use only 

o DyNetml – Proprietary format for ORA. 

Once you have selected what type of format you would like to use, click on the 

Start Extraction button. This will begin the process of importing your emails. 
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43.9 Examples of POP3 and IMAP setups 

Below are examples of setting up CEMAP with POP or MAP servers. Refer to the 

documentation with a particular server regarding the exact Server, Port, or other 

pertinient information necessary. 
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44 Data Import Wizard 

ORA's Data Import Wizard allows the importing of files in a variety of File Formats.  

The idea behind the data import wizard is that users come to ORA with a variety of file 

formats from various different network analytical tools. Very rare is it that an analyst has 

a MetaNetwork ready to load. Moreover, network data may exist in a separate file or in a 

variety of file formats, which then need to be merged together. 

The ORA Data Import Wizard makes it easy for the user to take their data in its native 

format and separate files and convert it to a MetaNetwork, which in turn creates a 

DyNetML file. 

 

The files can be in any of the following formats: CSV, UCINET, GraphML, or Pajek. 

ORA uses the file extension to determine the native file format to assign to your network. 

Therefore, if you change a file extension from its native extension (e.g., GraphML file 

such as "example.gml" to "example.dot" ORA will not recogonize the data format). 

This section will review the basics of the Data Import Wizard. See Creating a Meta-

Network in the Lessons section for more comprehensive information on importing. 

From the Main Menu select File => Data Import Wizard…. This brings up the Import 

Data in ORA dialog box. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\createMN.html
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44.1 Primary Uses of the Data Import Wizard  

 Create a meta-network from separate network files: Use this option to select 

multiple networks in one of the several native file formats indicated above and 

pull them into ORA. The file formats don't have to match. ORA will then 

combine all the network files into one MetaNetwork, which will then be saved as 

a DyNetML* file (ORA's native file format). See Lesson 202 — Import into ORA 

 Create a meta-network from table data: Text files in the form of rows of Nodes 

and columns of Attributes will be used to populate existing NodeSets. See Lesson 

202 — Import into ORA 

 Import node attributes from table data: Text files used to import Attributes to a 

Node. See Lesson 202 — Attributes 

44.2 Importing other data formats  

If your file format is in any of the following native specifications, you can simply 

select which one using the appropriate radio button and select Next. 

ORA will pull the network data will create a MetaNetwork based on its 

knowledge of the native file format. The primary benefit here is that it saves you 

time from describing to ORA how your network is formatted (e.g., what is Who, 

what is a connection). The following formats are recognzied by ORA and can be 

imported directly using the Data Import Wizard: 

o AutoMap Thesaurus 

o DyNetML 

o Analyst Notebook – See Lesson 301 — Analyst Notebook 

o GMU Pythia 

o Caesar III 

o Path Finder 

o Trails 

o Thing Finder 

o PenLink 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn202.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn202.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn202.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn202.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn203.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn301_analystnotebook.html
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45 File Menu 

Below is an image of the File Menu accessible from ORA's main title bar menu. Further 

below are descriptions of the various tools accessible through the File Menu.  

 

Open Meta-Network… 

Open Meta-Network opens a single Network with the following formats: 

Dynetml* (the native ORA xml format), .dl, .##h (UCINet), .csv* (comma separated 

values, Excel spreadsheet out), .txt (text files), .raw, .net (Pajek), .graphml*, .stl* 

(GMU model), .lo (pathfinder) 

Data Import Wizard… 

Data Import Wizard contains additional options for importing Networks such as 

multiple file importing. See Lessons for more comprehensive information regarding 

this function. 

Import Database… 

Import Database is an advanced feature for importing a database. 

Import CASOS Database… 

Open Workspace… 

Open Workspace allows you to open an entire workspace that you were previously 

using. A workspace consists of a set of Meta-Networks that were all open at the same 

time, and saved as a workspace. 

CEMAP Parser… 

 
Save Meta-Network 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23g
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23s
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Initially this item is greyed out. Save Meta-Network only becomes active when 

you've made a change to a Network. You can use it as an indicator whether you've 

made a change to the active Meta-Network. Notice as you highlight each Meta-

Network the icon in the toolbar will be greyed out (no changes) or colored (changes 

made to that Meta-Network). 

Save Meta-Network As… 

Save Meta-Network As… save the changes you've made in a Meta-Network under a new 

filename. 

Save Workspace 

Save Workspace save the active Meta-Networks into a Workspace which can be 

opened up at a later date. 

 
Network Format Converter… 

Network Format Converter takes files from one format and convert it to an ORA 

format. 

 
Exit 

Close the program and leave 

46 Import Database 

The Import Database function is an advanced feature and is beyond the scope of this help 

file. However, to connect a database and import network information directly into ORA, 

please contact Jeff Reminga at CASOS for detailed instruction. 

46.1 Jeff Reminga — jreminga@cs.cmu.edu  
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47 Network Format Converter 

The Network Format Converter is a tool to take files from one format and convert it to 

ORA's native format, DyNetML.  

The image below shows the main interface with no Meta-Network loaded. 

 

From the Main Menu File => Network File Converter. 

The dialog box will appear. Go to the tab marked Load Network. 
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Move the pointer over the inverted triangle to select the format of the file to convert. 

Below is the list of file types available to convert. 

 

Select CSV then select the [Load] button. This will bring up the Open dialog box. 

 

Select the file you wish to convert and select the Open button. 

Your screen should now look like that below. 
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Now select the Save Network tab. Select the file format you want to convert your file to. 

In this case we'll leave it at DYNETML. 

 

Select the [Save] button. Then navigate to the directory you want to save your file. Then 

type in the name you want your file to be called. 

NOTE: Remember to type in the extension .xml so it will be recognized by ORA. 

 

In order to access this file in ORA goto File => Open Meta-Network and open it 

normally. 

Below is a screenshot showing the newly saved file agent_agent_labelled.xml. 
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48 Open Meta-Network 

Below is series of procedures describing how to load a Meta-Network into ORA. 

Most commonly, an analyst familiar with ORA will open a DyNetML* file. These files 

are in the XML* format. However, if your original data is not in this file format, an 

analsyt can use the Imort Data Wizard to convert the data to DyNetML.  

From the Main Menu select File => Open Meta-Network. This brings up the initial Help 

dialogbox. Select the [OK] button to continue. 

 

This brings up an Open dialog Box. Navigate to the directory with your DynetML files, 

select the Meta-Networks to work with in the Open dialog box, and click [OK]. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\BasicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\BasicTerms\basicTerms.html%23x
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\fileMenu\diw\diw.html
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The selected file will then appear in Panel 1 of the main interface. 

 

49 Open Workspace 

What follows are procedures to use the Open Workspace tool in ORA. This function 

allows you to open multiple files at once. The purpose of this tool is save the analyst time 

in revisiting a previous network analysis environment.  

 

From the Main Menu select File => Open Workspace 

 

The Open Workspace dialog box will appear giving you an explanation of it's function. 
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If you're sure, select [OK]. This brings up the Open ORA Workspace dialog box. 

Navigate to the directory where you saved your worksapce files and select one. 

 

Workspace files will have the extension OWS. 

All the files that were saved from a previous Save Workspace will be reloaded in the 

ORA. 

49.1 Save Meta-Network 

What follows are procedures for saving a Meta-Network.  

This option is initially grayed out when you first load a Meta-Network. This signifies that 

the Meta-Network is currently unchanged.  
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Whenever you make ANY change within he Meta-Network the option will become full-

color indicating it is time save changes.  

After clicking the icon in the toolbar, or selecting the menu item, it will become grayed 

out again till you change your Meta-Network once again. 
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49.2 No change in the Meta-Network 

 

49.3 After a change was made to a Meta-Network 

 

49.4 Save Meta-Network As… 

If you need to save a Meta-Network under a different name use select File => Save Meta-

Network As.... This will leave the original file intact and create a new Meta-Network 

with the new file name. 

49.5 Save Workspace 

While working with multiple Meta-Networks an analyst may want to retain that 

information for later use. To make it easier to reload the same files you can use the Save 

Workspace menu item. 

From the Main Menu select File => Save Workspace. This brings up the Save Workspace 

dialog box. This informs you exactly what you're going to do. 

 



 

107 

 

After selecting [OK] the Open ORA Workspace dialog box will appear. Navigate to the 

directory you want to save your worksapce files to. 

 

This Workspace can then be called up with the Load Workspace in a future session. 

50 Caesar III 

Caesar III is an software application for the design of decision making organizations at 

the operational and tactical levels; it takes into consideration cultural differences in 

coalitions and of adversaries. What follows in overview of how Caesar III and ORA cna 

work together.  

 

ORA can import data from Caesar III. See the Data Import Wizard for detailed 

instructions.  

 

The Design View and Analysis View can be generated from a series of matrixes 

describing the communications among decision makers (agents). The goal should be 

producing the matrixes out of a social network. The analysis view has cognition aspects. 

The nature of a link is determined by the timing of communication during the decision 

making process. 
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Meta-Networks are generated by ORA. Then through Caesar III's Design and Analysis 

Views their structure is analyzed. 

Reference at the George Mason University web site: 

http://sysarch.gmu.edu/main/software/ 

Contact George Mason University at the abvoe URL for instruction on downloading 

Caesar III data. 

51 Command and Control 
51.1 C2 Structure and Meta-Network 

A Meta-network is a representation of a complex adaptive system.  

As such a system it has agents, expertise, resources and tasks. Inherent in this data, Meta-

networks contain the C2 structure of an organization, which are the links of a social 

network among commanders represented in the following ways:  

 Command chains 

 Information sharing relations 

 Result/response sharing relations 

However, meta-networks may only have one commander-to-commander network without 

classifying the nature of links.  

An analyst oftentimes needs a method to infer the nature of relations among commanders 

based on a given meta-network. That is where this tool can help.  

ORA uses the task assignment and communication directions to infer the nature of a link. 
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51.2 C2 structure in CAESAR III 

Design View and Analysis View can be generated from a series of matrixes describing 

the communications among decision makers (agents). The goal should be producing the 

matrixes out of a social network. The analysis view has cognition aspects The nature of a 

link is determined by the timing of communication during the decision making process. 

51.3 Meta-Nework 

Network among people (, knowledge, resources, tasks, etc). Data for statistical analysis, 

not exactly an analysis tool. Reveal the organizational structure, influence propagation, 

command and control structure, etc. Widely used in organizational science, counter-

terrorism, structure reformation, etc. 

51.4 C2 structure extraction in ORA 

ORA provides a function, Command and Control Structure Generator. Automatic 

generation of C2 structure based on a target task and a social network among decision 

makers. Generated influence network is directly loadable in CAESAR III. It is not a 

complete C2 structure but a reasonable inference (or approximation). 

From the main menu select File ⇒ Command and Control Structure Generator. This 

brings up the Command and Control Structure Generator Wizard. 

 

51.5 C2 Structure Generation Procedure 

Determine a target task to analyze. Extract the task network of the target task. Extract the 

related (assigned) agents of the task network. The other agents are aggregated and 

represented as the outside world (IN and OUT). Regard the agent-to-agent network as a 

information sharing network. Determine the network level based on the link directions 

and network topology. Then, extract a command chain from links bridging different 

network level. Determine the result sharing requirement based on the task network (i.e. 

the link direction between the two tasks indicate the result sharing requirement) Then, 

create a result sharing network based on the requirements. 
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52 Extracting a Task Network for the Command and Control 

What follows are procedures and an overview of extracting a task network for command 

and control analysis using ORA with Caesar III.  

In a Meta-network, there are event-to-event networks and task-to-task networks 

contained in most data sets. We select one task to analyze and use this ORA tool to 

discover the steps needed for the task in question.  

In the images below, we are extracting a task network needed for the bomb_preparation 

task node. 

The idea is to find tasks should be completed to accomplish the objective, 

bomb_preparation (e.g., find the trace to a purchase_oxygen task. Provide_money —> 

get_money —> purchase_oxygen). 
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52.1 Assigned Agents 

Identify the task network. Find all the assigned agents. Agents directly linked to a task in 

the task network. 

 

52.2 Approximated Information Sharing Network 

Just the agent-to-agent network in a meta-network. 
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52.3 Inferred Command Chain 

Determine the network level. Find the inferred hierarchy of the organization. Find the 

command chain from the hierarchy. 

 

Red arrows are command chains. Purple arrows are social network links. 
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52.4 Inferred Result Sharing Network 

The task network defines the task prerequisites. Then, the result of a task should be 

informed to the agents doing the next task. Create a result sharing network by using the 

above inference rule. 

 

Ahmed_ghallani should inform the result of purchase_oxygen to the agents doing 

bomb_preparation. Purchase_oxygen is a prerequisite of bomb_preparation. 

52.5 Visualization by CAESAR III 

Generated by ORA. Target task : surveillance. Design view and analysis view in 

CAESAR III. 
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53 Create Expected Interaction Networks 

Below is an image of the Expertise Correlation tool in ORA and procedures on using the 

various options it contains: 

 

Below are links to the Measures section pertaining to each Correlation. 

Expertise Correlation… : Measures the complementarity of two agents based on their 

knowledge. 

 

Similarity Correlation  

Measures the degree of similarity between agents based on the number of knowledge bits 

they both have. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\cognitiveExpertise.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\cognitiveSimilarity.html
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Distinctiveness Correlation… : Measures how distinct are two agents based on the 

number of knowledge bits they hold oppositely. 

 

Resemblance Correlation… : Measures the degree of resemblance between agents based 

on the number of knowledge bits they both have or both do not have. 

 

54 Create Stylized Networks 

What follows are images of the Generate Networks menu in ORA. This tool is used to 

create Stylized Networks. Stylized networks are models built upon common network 

structures evident in many real world environments.  

 

54.1 Create Erdös-Rényi Network 

A model for generating random graphs by setting an Link between each pair of nodes 

with equal probability, independently of other Links. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\cognitiveDistinctiveness.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\cognitiveResemblance.html
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54.2 Create Core-Periphery Network 

The core-periphery structure of the network has a dense central core of key agents and a 

large periphery of marginal agents. 

The core-periphery structure is an ideal typical pattern that divides both the rows and the 

columns into two classes. One of the blocks on the main diagonal (the core) is a high-

density block; the other block on the main diagonal (the periphery) is a low-density 

block. The core-periphery model is indifferent to the density of ties in the off-diagonal 

blocks. 

 

When we apply the core-periphery model to actor-by-actor data (Core/Periphery), the 

model seeks to identify a set of actors who have high density of links among themselves 

(the core) by sharing many events in common, and another set of actors who have very 

low density of ties among themselves (the periphery) by having few events in common. 

Actors in the core are able to coordinate their actions, those in the periphery are not. As a 

consequence, actors in the core are at a structural advantage in exchange relations with 

actors in the periphery. 

54.3 Create Scale-Free Network 

Some nodes act as highly connected hubs (high-degree), although most nodes are of low 

degree. Scale-free networks' structure and dynamics are independent of the system's size 

N, the number of nodes the system has. In other words, a network that is scale-free will 

have the same properties no matter what the number of its entities is. 

Their most distinguishing characteristic is that their degree distribution follows a power 

law relationship, \mathbf{P(k) \sim k^{- \gamma}}, 

 

Where the probability P(k) that a node in the network connects with k other nodes was 

roughly proportional to , and this function gave a roughly good fit to their observed 

data. The coefficient may vary approximately from 2 to 3 for most real networks. 

54.4 Create Cellular Network 

54.5 Create Lattice Network 

A Lattice Network is a large-world network 

A graph in where nodes are placed at the integer coordinate points of the n-dimensional 

Euclidean space and each node connects to nodes which are exactly one unit away from 

it. (i.e. if the lattice is two dimensional and the length of the lattice is 2 along the first and 

2 along the second dimension, then it has 4 nodes and they're placed at coordinates (1,1), 

(1,2), (2,1), (2,2)) The two nodes are connected if the difference of one of their 

coordinates is one or minus one and all their other coordinates are exactly the same. 



 

117 

 

54.6 Create Small-World Network 

A type of graph in which most nodes are NOT neighbors of one another, but most nodes 

can be reached from every other node by a small number of hops or steps. A small world 

network, where nodes represent people and links connect people that know each other, 

captures the small world phenomenon of strangers being linked by a mutual 

acquaintance. 

 

The small-world behavior is characterized by the fact that the distance between any two 

inks is of the order of that for a random network and, at the same time, the concept of 

neighborhood is preserved. 

A Small-World Network is a regular network with a degree of random long range 

connections. It is rarely disrupted by the elimination of one node. 

54.7 Fixed Degree-Distribution Network 

A random graph is constructed by specifying as input: (a) the number of nodes in the 

network, and (b) the number of link for each node. The graph is random according to the 

input, however it should be noted that not all degree sequences are illogical so this 

algorithm may produce an empty graph as a result. 

55 Fixed Degree-Distribution Network 

Below are procedures for using ORA's Create Fixed Degree Distribution Network tool.  

This tool creates a random graph constructed by specifying as input: (a) the number of 

nodes in the network, and; (b) the number of links for each node.  

The graph is random according to the input, however it should be noted that not all 

degree sequences are illogical so this algorithm may produce an empty graph as a result. 

 

The input for the degree sequence is a comma delimited list of the number of edges. 

Correspondingly, the number of nodes is determined by the number of parameters 

entered.  
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To facilitate simplified entry, a shortcut can be made by specifying the number of nodes 

at a specific number of edges. Further, the node id in the generated graph will correspond 

with the position in the input string. 

 

Degree sequences that are illogical will be impossible to generate, e.g., 2@20 (two nodes 

with 20 ties each; impossible because the maximum ties a node can have in this network 

of size two is 1 tie.) Further, some networks can be difficult to produce due to the specific 

degree distribution and the random process used to construct the network, so the 

algorithm is designed to make up to 10 separate attempts at constructing the exact 

distribution. After 10 attempts, the algorithm will return the error meta-network. The user 

may chose to resubmit the same request for another up-to-10 attempts at making the 

network. 

For example, the following are valid input strings (with self-loops off and undirected): 

 1,5,3,0,1 - produces a 5 node network with one isolate and 2 pendants, etc. 

 3@2, 0, 0 - produces a 5 node network with 2 isolates and 3 nodes with 2 edges. 

 10@5,10@3 - will produce a 20 node network 

The following are valid input strings but illogical: 

 100,0,1 - is illogical and will produce a null meta-network named with an error 

message 

 3@2,1 - is illogical and will produce a null meta-network named with an error 

message 

 10@5,10@3,1 - is illogical will produce a null meta-network named with an error 

message 

55.1 Input Fields: 

Allow self-loops: 

Checked : allows the generation of a node tied to itself 

Unchecked : disallows the generation of a node tied to itself 

Construct directed-tie network 

Checked : generates directed network 

Unchecked : generates an undirected network 

If directed is inbound specified, else outbound is specified 

Checked : the degree list is incoming ties 

Unchecked : the degree list is outgoing ties 

Degree list: 

Enter the degree listing – in the desired node order. 
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56 Generate Networks 

Below is an image of the Generate networks menu, accessible from ORA's main title bar 

menu. Further below are descriptons of the various tools avaiable to Generage Networks. 

This tool is used to generate networks, often stylized networks, according to prefined 

algorithms. 

 

Influence Network Generator 

Used to create an Influence Network file for use in the external program Pythia. 

Command and Control Structure Generator 

Used to create Network files for use in the external program Caesar III. 

Generate Inferred Links 

Uses existing links to infer connections where data is incomplete or missing. For 

instance, if Node A is two paths removed from Node C and Node C is only connected 

to Node B, it could be inferred that Node A has a path to Node B.  

Randomize Existing Networks 

Scrambles the links of a graph. Randomize Networks is run on the same Network 

multiple times in order to help determine is existing Network is random or not. 

Create Stylized Network 

Generates new Networks using various Mathematical formulas including Erdős-

Rény, Core-Periphery, Scale-Free, Cellular, Lattice, and Small-World Networks. 

Create Expected Interaction Network 

Predicts the expected interaction of a network given known tasks and other available 

network data. 

Construct Trailset 

Used to create a data set to be used within the View Trail Set function. A Trail is a set 

of nodes and links that form a single unbroken chain, such that no node or link is 

repeated. 

57 Influence Network Generator 
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This tool takes a meta-network and generates an influence network that is readable by 

Pythia. Pythia (GMU) takes an influence net and reasons about it. ORA can generate 

influence nets for Pythia from meta-networks. ORA can read in a pythia influence net 

and assess its structure. When ORA generates an influence network, the user then has to 

work with Pythia and a SME to get the probability distributions to make sense. Basically 

by inferring the influence network from the meta-network via ORA you save a lot of the 

start up time in building an influence network. 

 

ORA provides a function, the Influence Network Generation. This function is used in 

conjunction with the external program Pythia. More information about the Pythia 

program can be found at: 

 

An Influence Network is a hypotheses regarding tasks, performance, event happening, 

and related events. This functions covers how to generate an influence network from a 

social network using ORA and examines the probability of event happenings based on 

the state and influence of supporting nodes. 

 

The file generated by this function is directly loadable in Pythia. It is not a complete 

influence network and the user will need to make adjustments to the generated networks. 

It uses basic ontological* interpretations and inferred baseline probabilities where the 

user specifies positivie/negative probability. 

We create an influence network based on: Extracting a task network whichdirects the 

target task to analyze. Then examine the complexity, importance, 

personnel/resource/expertise assignment of the tasks. 

The examinations become influence network nodes containing ontological 

interpretation when: The task is done — the task is complex — the task is important 

— there are sufficient actors associated with the task — resouces are available — 

expertise is available. 

Then links are created as in the task network and background hypotheses nodes link 

to a task node. 

57.1 Running the Routine 

From the main menu select File => Influence Network Generator…. This brings up the 

Influence network step by step creation dialog box. There are three options: Task Based, 

Event Based, and Belief Based. This example will follow the Task Based function. Each 

function contains similar step dialog boxes. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23o
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Select [Next] to continue. 

 

Step 1 : In the header bar it shows which function you're choosen and the number of steps 

involved. It also tracks which step you're currently on. From the dropdown menu select 

the task to be analyzed. The positive/negative influence values from task to task can be 

adjusted. Then select [Next]. 
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Step 2 : Settings for the Threshold of personnel, the positive/negative influence of the 

links and Heuristics* settings determining Baseline probability. 

 

Step 3 : Settings dealing with the Complexity of the personnel, expertise, and resources, 

the positive/negative influence of the links and Heuristics* settings determining Baseline 

probability. The parameters for complexity can be adjusted. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23h
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23h
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Step 4 : Settings dealing with the Out-Degree and Betweenness of the task, the 

positive/negative influence of the links and Heuristics* settings determining Baseline 

probability. The parameters for complexity can be adjusted. 

 

Step 5 : Settings dealing with the Resources directly linked to task or assigned to 

personnel, the positive/negative influence of the links and Heuristics* settings 

determining Baseline probability. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23h
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23h
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Step 6 : Settings dealing with the Expertise directly linked to task or assigned to 

personnel, the positive/negative influence of the links and Heuristics* settings 

determining Baseline probability. 

 

Step 7 : Displays the results before saving the file. When ready, select the [Convert] 

button. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23h
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Navigate to your selected directory, give it a filename and select [Save] 

 

The two other functions are Event Based (14 steps) and Belief Based (3 steps). Both of 

these follow the same procedure of setting you parameters and saving the file for use in 

Pythia. 

58 Extracting a Task Network for the Influence Network Generator 

What follows are procedures to extract a Task Network for the Influence Network 

Generator. 
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In a Meta-Network there is an event-to-event network and a task-to-task network. Choose 

one task to analyze. 

 

Here we look at bomb preparation. Find the tasks that need completed to accomplish the 

objective. Then trace from provide_money, get_money, purchase_oxygen.  

 

The complexity of the task depends on three items. Resources / Expertise required and 

number of person required.  

 Very Low (default baseline=1.0): 0 resource/expertise required / 1 person 

required. 
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 Low (default baseline=0.9): 1 resource/expertise required / Less than 3 persons 

required. 

 Medium (default baseline=0.8): Less than 4 resource/expertise required / Less 

than 4 persons required. 

 High (default baseline=0.7): Less than 8 resource/expertise required / Less than 7 

persons required. 

 Very High (default baseline=0.6): More than 7 resource/expertise required / More 

than 6 persons required. 
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The importance of the task is determined as using standardized degree centrality and 

betweenness (ranging (0~1): 

 Very Low (default baseline=0.4): Not connected to other tasks 

 Low (0.5): Low out-degree density and low betweenness in task network 

 Medium (0.6): Medium out-degree density and low betweenness in task network 

 High (0.7): High out-degree density or medium betweenness in task network 

 Very High (0.8): High out-degree density in task network 

 

The actor assignment of the task is determines is sufficient actors are associated with the 

task. 

 No personnel (default baseline=0): No assigned actors 

 Insufficient (0.25): Only 75% of resources/expertise are covered by assigned 

actors. 

 Almost sufficient (0.5): More than 75% of resources/expertise are covered by the 

assigned actors. 

 Sufficient (0.7): At most one person associated with each resource and each 

expertise connected to the task. 

 More than sufficient (0.8): More than one person associated with some resources 

and expertise connected to the task. 
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Resource / Expertise availability 

Finds if Expertise and Resource are directly accessible. The availability is determined as 

follows: 

 Redundantly available/accessible baseline probability=0.75): More than one 

person with the expertise associated with the task. 

 Available/accessible (0.6): One person with the expertise/resource is associated 

with the task. 

 Unavailable/unaccessible (0.25): No person with the expertise/resource is 

associated with the task. 

59 Pythia 

Pythia is a timed influence net application. Conversely, data from Pythia can be loaded 

into ORA using the Data Import Wizard.  

In conjunction with the Pythia application from George Mason University, data frm ORA 

can be loaded into Pythia to create organizational displays.  

What follows is a brief example of creating an organizational display using ORA with 

Pythia.  

Start from an ORA Task Network (shown below) 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\fileMenu\diw\diw.html


 

130 
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The data can be loaded into Pythia to create an organiziational display. 

 

Reference at the George Mason University web site: 

http://sysarch.gmu.edu/main/software/ 

Contact George Mason at the above URL for instructions on downloading Pythia and 

additional instructins on how to use the tool.  

60 Randomize Existing Network 

What follows are procedures for randomizing an existing network. 

Note : This is commonly done to test a hypothesis about a given network. If after 

conducting experiments, there is no significant difference between a hypothesis and a 

random graph, the evidence supporting the hypothesis could be weak. 

 

A random graph* is obtained by starting with a set of n nodes and adding Links between 

them at random. Different random network models produce different probability 

distributions on networks. 

 

The theory of random networks studies typical properties of random networks, those that 

hold with high probability for networks drawn from a particular distribution. For 

example, we might ask for a given value of n and p what the probability is that G(n,p) is 

connected. In studying such questions, researchers often concentrate on the limit behavior 

of random networks—the values that various probabilities converge to as n grows very 

large. Percolation theory* characterizes the connectedness of random networks, 

especially infinitely large ones. 

http://sysarch.gmu.edu/main/software/
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23r
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Random networks are widely used in the probabilistic method, where one tries to prove 

the existence of networks with certain properties. The existence of a property on a 

random network implies, via the famous Szemerédi regularity lemma, the existence of 

that property on almost all networks.  

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23s
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60.1 Creating a Random Graph 

This function randomizes the Links in a Network. 

From the menu select Generate networks => Randomize Existing Network 

 

The dialog box and form the drop down menu select the Network you want to randomize. 

 

In leftside panel a new Network will appear named after the selected Network and 

denoting it has been randomized. 

 

First, return to the original Network and select a one of the Networks such as the agent x 

agent. 

Then select the Visualize Only this Network. 
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You will get a visualization of the agent x agent Network. 

 

Now select the newly created randomized Network you just created. Select the same 

agent x agent graph as per the original Network. 

 

And again, select the Visualize Only this Graph. 
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As shown in the visualizer the links have been randomized. 

 

61 Construct TrailSet 

What follows are procedures for Constructing a Trailset in ORA. 

The Construct Trailset is used in conjunction with the Loom function. A Trailset is a set 

of nodes and links that form a single unbroken chain, such that no node or link is 

repeated. 

This function will take any Network and form a new Network usable by the Loom 

function. 

 

From the main menu select Generate Networks => Construct Trailset 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\visualizationMenu\loom\loom.html
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This will automatically create a new Network form the selected graph. 

 

Now you can use this new Network in the Loom function. 

62 Help Menu 

What follows are images and general descriptions of accessing ORA Help from within 

the ORA interface.  

 

Help Contents : Calls up this Help File System 

System Monitor :  

 

About Ora : Contains information regarding this software, the institute of origin, 

permissions and warranties, version and build dates, and Java usage. 

63 Attributes 

An attribute* is an extra container that can be attached to an Meta-Node. You can add a 

value to this container. To add an attribute to an Meta-Node right-click on the Meta-Node 

name. This will bring up the contextual menu below. 

63.1 Add Attribute 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\visualizationMenu\loom\loom.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23a
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Type in the name for your new attribute and select [OK]. Let's say we want to add other 

languages spoken by the nodes. 

 

The attribute you added will be inserted alphabetically in the editor. 

 

You can now assign any text to this attribute for any of the rows in the Network which 

can be used later to help define your Network. 

 

63.2 Add attribute (second option) 

There is a second way to add attributes in the Editor tab. Below the matrix is a section 

called Attributes which contains two buttons, [Create] and [Delete]. 
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Selecting [Create] brings up a dialog box and asks you to input the name for the new 

attribute. 

 

The new attribute is then inserted within the matrix. 

 

63.3 Delete Attribute 

And attributes can be removed jsut as easily by pressing the Delete button. The dialog 

box will present you with a dropdown menu where you can choose which attribute to 

delete. 

 



 

139 

 

63.4 Import Attribute 

The [Import] button allows for the quick importing or an attribute(s) through the Editor 

panel. Use a .csv file with rows as nodes and columns as attributes. This can be done 

with, or without, an ID column. 

 

1. Use the Textbox and Browse button to navigate to the csv file with the new 

attribute(s). 

2. Select the radio button to use either 1) an ID column, or 2) a file in the same order 

as NodeSet. 

3. This section contains all the attributes in the file. If one was choosen to identify 

the NodeSet then it will be greyed out. For attributes NOT greyed out you can 

chose to make then Categorical* or Continuous*. 

4. Select All / Clear All buttons places a checkmark in all columns or removes same. 

5. Placing a checkmark in the Create new nodes for unregonzied nodes creates new 

nodes into the select NodeSet if no node for an attribute currently exists. 

6. Import / Cancel tells ORA to begin the import or cancel the operation. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
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64 Contextual Menus 

What follows are descriptions and images relating to the contextual menus in ORA.  

Right-clicking on any Meta-Network, NodeSet, or Network brings up a contextual menu 

with the functions available with each. 

 

The first four are self-explanatory. Transform… opens up the Meta-Network 

Transform… dialog box. 

 

The first two are self-explanatory. Add Attribute … opens up the attribute function in 

order to add attributes to a nodeset. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\dataManagementMenu\mt\mt.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\dataManagementMenu\mt\mt.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\attribute\attribute.html
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The first two are self-explanatory. 

 Set Diagonal… : Used on a square network to set cells 1,1 through x,x to the same 

value. In binary view the choise are 1: True (+1) 2: True (-1) 3: False (0). In 

Numeric view you can put any value into the diagonal. 

 Fold Network… : This function creates a new network using matrix algebra. 

Below are four variations of a four x four network and the results when each is 

folded. 

 

 Save Network… : (also called Exporting a Network) Any Network can be saved 

individually to a file in one of the following formats: CSV*, DL, DyNetML*, or 

UNCINET (.##h). Also check File Formats for more information 

 Binarize Network : Turns all non-zero numbers to [1] and leaving all [0] 

untouched. 

 Remove Links… : Removes links in accordance to the selection in the dropdown 

menu (as seen in the images below). 

 

 Symmetrize… :  

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\BasicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\BasicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
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65 Contextual Menus - Multi Files 

Includes: Union Meta-Networks, Intersect Meta-Networks, Conform Meta-Networks 

There's also a separate contextual menu when you've got two or more Meta-Networks 

selected. Open up multiple Meta-Networks in the Main Interface. Load two or more files 

into Panel 1. We'll demonstrate this on two Meta-Networks containing Bob, Carol Ted, & 

Alice. The agents are identical but the tasks in each are different, except for driving 

which appears in both and has slightly different values. Inbetween the time of cookingIn 

and eatingOut Alice's feelings for Ted have grown. 

CookingIn and 

 

EatingOut 
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Highlight both of them by holding down the [Control] while clicking on each file. Then 

Right-click on one of the files. This brings up the contextual menu. 

 

The Add New MetaNetwork & Remove Selected Meta-Network are self-explanatory. 

The Union Meta-Network will create a new Meta-Network using one of five actions: 

sum, binary, average, minimum, or maximum. 

 

 Sum : In any identical network all values from all networks are added together. 

(i.e. bob's score of 4.0 in both meta-networks are added together for a total of 

8.0). 

 

 Binary : Then in the binary option it doesn't matter what numbers appeared in 

either meta-network as it uses only 1 or 0 as a result. If any cell has a non-zero it 

will contain a 1 as a result. 
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 Average : This option takes the sum of all identical cell values and divides them 

by the number of cells used. In cookingInted x alice contained a 2 while in 

eatingOut the value for tes x alice was a 1. This was averaged out to 1.5. 

 

 minimum : This function finds the smallest value in any identical cells and uses 

that in the final result. (i.e. for ted x carol and ted x alice both cells use the smaller 

value of "1" even though they are from different meta-networks. 

 

 Maximum : This function finds the largest value in any identical cells and uses 

that in the final result. (i.e. for ted x carol and ted x alice both cells use the larger 

value of "2" and "3" respectively, each taken from a different meta-network. 

 

Intersect Meta-Network works similar to the Union function and has the same five 

options. But in creating the new Meta-Network only nodes that appear in all Meta-

Networks are carried over to the new Meta-Network. 

 

For example: All four agents appear in both Meta-Networks and are brought over into the 

new Meta-Network. But though there were six tasks in the cookingIn and three tasks in 

eatingOut there is only one task (driver) in the new Meta-Network created from the 

intersect function. Only nodes found in all Meta-Networks are brought over. 
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And even though bob has a value for driver in cookingIn only carol has a value for driver 

in both Meta-Networks. 

 

Conform Meta-Network alters the selected Meta-Networks and makes them equal. union 

adds nodes that are found in one Meta-Network but not the other. inersect removes nodes 

that are not common to both. 

66 Creating A Network From An Excel Spreadsheet 

If you don't have a Network, you can create one from scratch. Below is step-by-step 

instruction on how to do this in ORA. 

 

We will create an square, agent-by-agent Network. We say it is square because all row 

headings correspond directly to column headings. This is important as it relates to 

specific measures ORA can run on a graph. If the graph is not square, some measures will 

not work. 

 

Open a blank Microsoft Excel work book. In column A we will enter the name of all the 

nodes that make up our social network or organization. 

66.1.1 NOTE : When creating your spreadsheet, do not add any additional 

titles, notes, or other headings, which will interfere with the 

"square" properties of the Network. 

 

Next, create column headings using the correlating names as they appear in row 

headings. Again, this will ensure that our Network will be square. 
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Next we will create links between each agent. We do this by entering a 1 if a direct 

connection or relationship exists and a 0 if it does not. Please note that headings that 

cross-reference themselves are considered redundant and thus are left blank or 0. 

In the example below, Redundant cells are filled in with red strips to illustrate the self-

loops. This redundancy should continue as a smooth diagonal line from the top left corner 

of your Network to the bottom right. 

 

66.1.2 NOE : If you don't end up with a diagonal line then your graph is 

not square. 

Using 1s and 0s to establish link, complete your spreadsheet. 

In the Network example, we have assigned links randomly. Within your organization or 

network, however, you can describe any direct connections or relationships you are 

interested in analyzing. For instance, you may determine that a direct connection exists if 

agents within your network consult with each other at least once a month; literally, it can 

be anything you decide. 

Below is our completed Network (The red fill illustrates cells that do not require input 

due to their redundancy*). 

 

Now that we have essentially built a Network from scratch using Excel, the next step is to 

save it in a compatible file format ORA can interpret. For Excel spreadsheets this will be 

the CSV* file format. 

From the main menu select File => Save As 

Make sure you save this file as a CSV (comma delimited) 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23r
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
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You have now created a Network from scratch which can be loaded into ORA. 
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Now return to ORA and load up your new Network. Below is a our new Network 

rendered in the ORA Visualizer. Notice the arrows only point from one node to another if 

there is a 1 in the column for a particular node. i.e. There is a "1" in the bob column for 

ted but a "0" in the ted column for bob. So an arrow points from ted to bob but NOT from 

bob to ted. 

 

For a more in-depth explanation for creating Meta-Networks see the lessons section 

under Meta-Network. 

67 Find 
67.1 Find a Sub-set within a NodeSet 

What follows are procedures for using the Find feature in ORA.  

By using the Find: textbox and the AND/OR selector you can display only the nodes you 

want to work with. This works by searching for Sub-Strings within the values. 

67.1.1 NOTE : A search for "male" will find all values of "male" as well 

as "female" because "male" is a sub-string of "female". 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\createMN.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\createMN.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\createMN.html
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Here is the whole NodeSet with only the gender and race attributes displayed. The 

AND/OR toggle is in it's default AND setting. 

 

First female is typed into the textbox and ORA will display all nodes where 

gender=female. 
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Next tauri is typed into the textbox (make sure there's a leading "space") and ORA will 

now only display nodes with gender=female and race=tauri. 

 

But if the AND/OR setting is switched to OR the NodeSet who display everything with 

EITHER gender=female OR race=tauri. 
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68 Hovering 

Hovering the pointer over various parts of the panels will reveal information about the 

Meta-Network.  

Hovering over the parts in Panel 1 will reveal different information about the Meta-

Networks, Meta-Nodes, and Networks. 
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69 Info Tab - Network 

When a Network is selected there are also two tabs, Info and Editor. 

The Info tab contains a textbox, Network ID in which you can change the name of any 

metwork, The Source and Target Nodesets, and whether this network is directed or not, 

the Link Count, and the Density. 

 

The two buttons underneath allow the choice of Visualize this Network which will send 

the entire Meta-Network to the visualizer or Visualize Only this Network which display 

only the currently selected Network. 

Below is an image of InfoTabs and Editor Tabs in ORA.  

 

The Editor tab has two views: Binary and Numeric.  

Binary view is used when you only need to extablish a connection between two nodes 

with no weights. It's a simple Yes or No arrangement. 
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The Numeric view allows you to treat links between various nodes with more or less 

importance. Notice that all the row nodes have a checkmarked connection to the column 

containing [yu] in the binary mode. This denotes they know one another. But in the 

numeric mode this value is a 0.5 which is used to denote previous acknowledgement but 

is an advesary. 

 

70 Info Tab - NodeSet 

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly designed to display 

information regarding the Meta-Networks, NodeSets, and Networks. But this is the area 

where you can rename the Node Class ID and the Node Class Type. Place the cursor in 

the box, make sure the entire name is highlighted, and type in your new name. 

This area also gives you the Node Count of the selected Node Set as well as the Attribute 

Names contained within the NodeSet. 
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The Editor tab contains most of the editing functions. 

 

1. The Search box for finding particular node(s) in a set. 

2. The <set filter> for displaying only a particular sub-set of node(s). 

3. The Checkboxes to designate which nodes to Delete or Merge. 

4. The Nodes buttons: Create, Delete, Merge, and Clean. 

5. The Attributes buttons: Create, Delete, and Import. 

6. Use the Select/Clear buttons to place, or remove, all cehckmarks from section 3.  
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71 ORA's Main Interface 

The ORA interface is organized into three resizable window panes.  

Panel 1 contains a tree directory of the current Meta-Network(s) loaded into ORA. This 

contains the Meta-Networks currently active plus all their Meta-Nodes and Networks. 

Panel 2 contains the basic information about the highlighted Meta-Network such as how 

many nodes are represented. This panel also allows quick access to ORA's Visualizer, 

Reports and Chart tools. By selecting the Visualize button, the currently loaded Network 

will render in the ORA Visualizer, which will load in a separate window. Panel 3 is 

empty when ORA is first started up. It will contain any reports that you run. 

All three Panels can be resized to your preference. 
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71.1 Panel 1 

Panel 1 contains all the Meta-Networks you currently have active. Clicking on the plus 

icon will expand the Meta-Network showing all the Meta-Nodes and Networks and 

clicking on the minus icon condenses the Meta-Network. 

 

And if you hover the pointer over a graph it will display information about that Network. 

 

71.2 Panel 2 

71.3 With Meta-Network selected 

Panel 2 displays the information regarding the Meta-Network itself. 

 

1. Name of the active Meta-Network: You can also use this textbox to change the 

name of the Meta-Network. 

2. Currently selected Meta-Network showing it's pathway. 
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3. Node Class Count: How many Meta-Nodes are contained with the Meta-Network. 

4. Node Count: Total number of nodes within the Meta-Network. 

5. Link Count: Total number of links within the Meta-Network. 

6. Network Count: Total number of graphs within the Meta-Network 

7. Total Density. 

71.4 Editor Tab with NodeSet selected 

When a NodeSet is selected changes can be made. 

 

The Nodes buttons allow you to search for particular nodes using the Find: box and 

And/Or criteria - Add, Delete or Merge Nodes - Add, Delete, or Change Attributes. 

Further information can be read regarding the Tabs in Panel 2 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\newNodes\newNodes.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\attribute\attribute.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\infoNodeSet\infoNodeSet.htm


 

159 

 

71.5 Editor Tab with Network selected 

 

Further information can be read regarding the Tabs in Panel 2 

71.6 Panel 3 

Panel 3, which at the start is blank, will contain any reports that are run on the Meta-

Network. See Generate Reports for more information. 

72 Main Interface Tasks 

There are a number of tasks that are performed from within the Main Interface to assist in 

controlling your Meta-Networks, NodeSets, and Networks.  

These functions are not associated with any of the Menu Items. 

For example, renaming Meta-Network, tool tips displayed while hovering, and creating 

and deleting Nodes & Attributes. 

73 Create a New Meta-Network 

What follows are procedures for creating a new Meta-Network. 

There are times you need to run measures on or visualize only part of an existing Meta-

Network. This section will show you the easy way to create sub-sets of an existing Meta-

Network. 

First duplicate the Meta-Network. Highlight the Meta-Network then from the main menu 

select Edit ⇒ Copy Meta-Network. Then from the main menu select Edit => Paste Meta-

Networks. It would be a good idea to rename this new Meta-Network immediately so as 

to not get it comfused with the original. You can do this in the Editor tab, see Renaming. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\infoNetwork\infoNetwork.htm
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\reports\reports.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\editMenu\cpMatrix\cpMatrix.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\renaming\renaming.html
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Next, expand the Meta-Network you want by clicking the [+] if it isn't expanded already. 

Highlight the nodeset with the nodes you want to remove. 

 

In panel 2 select the Editor tab which brings up the matrix with nodes on the vertical and 

attributes on the horizontal. Below each attribute is a <set filter>. Below left is the 

stargate_summit meta-network along with the ally attribute. I wish to make a new meta-

network of the good guys only. In the dropdown menu under ally I select no. These are 

the nodes I want to remove. 

 

Place a checkmark in the box of each node. Below the matrix in the section called Nodes 

are three buttons. Click the [Delete] button. The nodeset now contains only the nodes that 

had yes in the attribute ally. 

 

With this same procedure I created a Meta-Network of only the allies. 
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74 Node Buttons 

 

What follows are images and descriptions of some common button items and other 

interface elements in the ORA gui.  

74.1 Creating Node 

Highlight a NodeSet where the node is to be added. Click [Create]. 

 

You will be prompted to input the number of new nodes you want to create in the 

NodeSet. Input the number of nodes to add and select [OK] and the new node(s) will 

appear at the bottom of the nodeset. The new node can then be renamed by clicking 

inside the cell. 

74.2 Delete Node 

To delete a node from a NodeSet place a checkmark in the box(es) to the left of the 

node(s) and select [Delete]. Select [OK] and all nodes with checkmarks will be deleted 

from the NodeSet. 

74.3 Merge Nodes 

The Merge button combines the links and attributes of the selected nodes and creates a 

merged or combined node. The nodes that were merged are removed, and replaced with 

the combined node. Used primarily when data needs to be consolidated. 

Example: You have two nodes, jack and col_o'neill. These are actually the same 

person. Merge will combine their information into one node which could be named 

col_jack_o'neill. 
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Place checkmarks in the rows of the nodes you want to merge. 

 

From the drop down menus select the ID and Title to used for the merged node. 

 

And one node emerges with the attributes from both nodes. 

 

74.4 Clean Nodes 
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75 Renaming 
75.1 Renaming Meta-Networks, Meta-Nodes, and Networks 

Below are procedures for rename a Meta-Network, Meta-Node, and/or Networks. This 

helps makes the information clearer for you. Below I renamed one of the Meta-Nodes to 

those guys and also renamed the type to who?. You can see how it's reflected throughout 

the entirely of panel 1. So you can rename any Meta-Node in a Meta-Network for better 

readability. 

 

76 Visualize Buttons 

There are two Visualize buttons and they work slightly different.  

 

The Visualize this Network visualizes the choosen Network. In the Legend dialog box all 

NodeSets and LinkSets are available. 
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The Visualize Only this Network visualizes the choosen Network. But in the Legend only 

the NodeSet and LinkSet choosen are displayed. This is a much quicker means to display 

a Network. ORA only makes computations for the choosen Network. 
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77 Edit Menu 

Below is an image of the Edit Menu.  

 

78 Edit Menu 

Below is an images of the Edit Menu in ORA. What follows are descriptions of the 

various sub-menus accessible by the Edit Menu.  

 

Copy Editor Values / Paste Editor Values 

Used to transfer information between Meta-Nodes. The Meta-Nodes created can be 

identically sized (allowing you to paste an entire column in) or a smaller, subset 

allowing you to choose only a portion of the original set. 

Copy Meta-Network / Paste Meta-Network 

Used for quickly creating duplicate Meta-Networks. When you first start the program 

the Paste Meta-Networks is greyed out. It will only become active once you've used 

the Copy Meta-Network menu item. 

Preferences 

Contains settings for controlling the environment for working within ORA. 
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79 File Menu 

Many of these options are more fully covered in Lesson 2 - Load and Save Data 

 

Open Meta-Network… 

Open Meta-Network opens a single Network with the following formats: 

Dynetml* (the native ORA xml format), .dl, .##h (UCINet), .csv* (comma separated 

values, Excel spreadsheet out), .txt (text files), .raw, .net (Pajek), .graphml*, .stl* 

(GMU model), .lo (pathfinder) 

Data Import Wizard… 

Data Import Wizard contains additional options for importing Networks such as 

multiple file importing. 

Import Database… 

Import Database is an advanced feature for importing a database. 

Import CASOS Database… 

Import Attribute File… 

The Import Attribute File is used to add an attribute into a file. The file selected must 

be in the .csv format. 

Import AutoMap Theasaurus File… 

Import a file create in AutoMap. 

Open Workspace… 

Open Workspace allows you to open an entire workspace that you were previously 

using. A workspace consists of a set of Meta-Networks that were all open at the same 

time, and saved as a workspace. 

CEMAP Parser… 
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Save Meta-Network 

Initially this item is greyed out. Save Meta-Network only becomes active when 

you've made a change to a Network. You can use it as an indicator whether you've 

made a change to the active Meta-Network. Notice as you highlight each Meta-

Network the icon in the toolbar will be greyed out (no changes) or colored (changes 

made to that Meta-Network). 

Save Meta-Network As… 

Save Meta-Network As… save the changes you've made in a Meta-Network under a 

new filename. 

Save Workspace 

Save Workspace save the active Meta-Networks into a Workspace which can be 

opened up at a later date. 

 
Network Format Converter… 

Network Format Converter takes files from one format and convert it to an ORA 

format. 

CSV Table Converter… 

CSN Table Converter convert a .csv* file into an ORA format. 

 
Exit 

Close the program and leave 

80 Chart Menu 

Below is an image of the Chart Menu in ORA.  

 

 New Chart Window … :Opens a new window for charting a separate nodeset. 

 Save Chart Image … :Saves the currently displayed chart as a .png file. You will 

be asked to navigate to the directory of your choice. 

 Close Window :Closes the window. 
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81 Measure Charts 

Three charts are available: The Bar chart, Scatter Plot, Histogram, and Heat Map.  

ORA Charts can be accessed through the Main Interface by clicking the [View Charts] 

button in the Network Composer window pane or from the Main Interface drop down 

menu Data Visualization => Charts  

The following dialog window will appear. Select the NodeSet you are interested in 

charting and select the [Next] button. For this example, we will simply select the 

currently loaded Node: Agents. 
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When you select [Next >] the Chart Results box will appear. 

 

At the top are the three tabs for displaying the different charts: Bar Chart, Scatter PLot, 

and Histogram. 
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The Select a measure to view: dropdown menu will display the results of the selected 

measure in the box. 

 

The Sort By: dropdown menu allows you to sort the results by Value, Named, or 

<unordered>. 

 

The Show top: checkbox works with the textbox to the right allowing you to select the 

number of nodes to display. Removing the checkmark from the Show names checkbox 

displays the results with the names of the nodes. The [<Back] button returns you to the 

initial dialog box where you can select a different node class. 
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82 The Charts 

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and Histogram. 

82.1 Bar Chart 

A bar chart contains horizontal bars representing the individual nodes in the set. These 

rectangular bars are usually proportional to the magnitudes or frequencies of what they 

represent.  

Bar charts are used for comparing two or more values. The bars can be horizontally or 

vertically oriented. Sometimes a stretched graphic is used instead of a solid bar. 
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82.2 Scatter Plot 

A scatterplot uses Cartesian coordinates to display values for two variables. The data is 

displayed as a collection of points, each having one coordinate on the horizontal axis and 

one on the vertical axis. 

 

A scatterplot does not specify dependent or independent variables. Either type of variable 

can be plotted on either axis. Scatterplots represent the association (not causation) 

between two variables. 

 

A scatterplot can show various kinds of relationships, including positive (rising), negative 

(falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it 

suggests a positive correlation between the variables being studied. If the pattern of dots 

slopes from upper left to lower right, it suggests a negative correlation. A line of best fit 

can be drawn in order to study the correlation between the variables. An equation for the 

line of best fit can be computed using the method of linear regression. 
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82.3 Histogram 

In statistics, a histogram is a graphical display of tabulated frequencies. A histogram is 

the graphical version of a table which shows what proportion of cases fall into each of 

several or many specified categories. The histogram differs from a bar chart in that it is 

the area of the bar that denotes the value, not the height, a crucial distinction when the 

categories are not of uniform width (Lancaster, 1974). The categories are usually 

specified as non-overlapping intervals of some variable. The categories (bars) must be 

adjacent. 

 

The word histogram is derived from histos and gramma in Greek, the first meaning web 

or mast and the second meaning drawing, record or writing. A histogram of something is 

thus, etymologically speaking, a drawing of the web of this something. 
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83 Drill Down 

Below are procedures to trace a path through various nodes in different nodesets using 

ORA's drill down tool.  

DrillDown allows for any path to be followed. 

From the main menu select Data Visualization => Drill-Down Window. 

From the drop down textbox select the node you wish to start with. Here we'll begin with 

daniel_jackson. 

 

The dialog box below will appear confirming you want to discontinue your last drill-

down session. 
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Click on the node and a contextual menu will appear with all the links it has to other 

nodes. I select <event> (5 nodes). 

 

This shows the five events the daniel_jackson was at. 
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Next I select summit_meeting and from the contextual menu select <resource> (4 nodes).  

 

It drills down showing the five links to resource nodes connected to the summit_meeting. 

 

This can be continued for as long as you need. 

The [+] and the [-] buttons increase and decrease the font size. 
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84 Visualization 

Below are images fo the ORA Visualizer Menus.  

 

Measure Charts – When run this function will plot the three graphs, Bar Chart, Scatter 

Plot, and Histogram on the choosen Network. 

 

View Measures Over Time – Requires multiple Networks. First plots points for measure 

selected on each of the Networks active with the option to see a direct line from the 

earliest to the latest point. 

 

View Network Over Time – Requires multiple Networks. Displays nodes and links for 

each of the active Networks. 

Drill-Down Window – Allows for quick, plotting of nodes connected to a choosen node. 

 

GeoSpatial Networks – Analyze, forecast, and visualize a wide variety of spatial 

interactions and networks within a global-scale. 

View Trails – Works with nodes moving between places over time. Requires the use of a 

trailset. 

Network Visualizer 

View Entire Meta-Matrix – This menu item calls up the Visualizer. 

 

Path Finder – Calls up the Path Finder dialog box and uses the information input by 

the user to create a visualization. 

Sphere of Influence – Calls up the Sphere of Influence dialog box and uses the 

information input by the user to create a visualization. 
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Key Set Selector – Calls up the Key Set Selector dialog box and uses the information 

input by the user to create a visualization. 

Blank Visualization –  
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85 GeoSpatial Actions Menu 

 

Undo :  

Reset Nodes Colors and Size: Returns on nodes to their default colors and sizes. 

Color Nodes by Attribute or Measure: Colors the nodes using 

Color Nodes by Component:  

Color Nodes by Concor Grouping: Colors nodes using Concor Grouping*. 

Color Nodes by Newman Grouping: Colors nodes using Newman Grouping* 

Size Nodes by Attribute or Measure: Sizes nodes using numerical data. NOTE: You can 

not size by an attribute using non-numerical data. 

Compute Standard Measures for Visible Network:  

86 GeoSpatial File Menu 

Below are images of ORA's GeoSpatial file menu:  

 

Open Meta-Network… : Opens a NEW Meta-Network file into the Geospatial map. 

REMEMBER: The new file needs to have both longitude and latitude data. 

Add Data… 

Open Meta-Network… : Opens a NEW Meta-Network file into the Geospatial map 

without removing the currently active data. 

Add shapefile data 

Add csv data 
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add e00 data 

Save Map… 

The Save Map To PNG (as an image file), Save Map To SHP (as a shape file) and Save 

Map To DynetML (as an XML file) all save the current file to their respective formats. 

Navigate to the directory you want to save the file and select OK. 

Create Meta-Network From Visible Network… 

Copy Image To Clipboard : Saves a picture of the current map to the clipboard which can 

be pasted into another program for use in demonstration purposes. 

Close 

87 GeoSpatial Options Menu 

This section of help under development. 

 

Show Edges :  

Show Labels :  

88 GeoSpatial Tools Menu 

This section of help under development. 

 

Network Resolution :  

Legend :  
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89 GeoSpatial Network Toolbar 
89.1 Before running the Geospatial Function 

The most important point before running the Geospatial function is that the MetaNetwork 

contains the proper data. It requires two attributes*: Longitude & Latitude. Also be sure 

your GeoSpatial Network is in the DynetML* format. 

Highlight the MetaNetwork in the main interface then from the main menu select 

Visualization ⇒ GeoSpatial Networks. 

89.2 Toolbar 

 

Copy Image to Clipboard : Places a copy of the current map in the clipboard which can 

be pasted into another program. 

Pan Map : Place the cursor on the map and click the button. The map will re-center on 

those co-ordinates. 

Select Place : Click and drag to capture nodes for information to display in an 

information window. This information will be displayed in an expanding tree format. 

Click and drag the cursor to include the nodes to display. 
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A pop-up window will display information for all the nodes captured by the cursor. 

 

Zoom In : Place the cursor on the map and click the button. the map will re-center on 

those co-ordinates and also zoom in. 

Zoom Out : Place the cursor on the map and click the button. the map will re-center on 

those co-ordinates and also zoom out. 

 

Show Labels : Toggle the labels on & off. 

Show Links : Toggle the links on & off. 

Show Arrows : Toggle the arrows on & off. 

 

Font Size : Increase or decrease font size using the up & down arrows. 

Node Size : Increase or decrease node size using the up & down arrows. 

Link Width : Increase or decrease link width using the up & down arrows. 

MetaNode Manager :  
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90 GeoSpatial Network 

The Geospatial Network tool in ORA allows for the plotting of a Meta-Network on a map 

of the globe using longitude and latitude for placing the nodes. 

90.1 Important items to know before using the Geospatial Networks 

1. The Meta-Network MUST contain a location NodeSet AND that NodeSet MUST 

contain longitude and latitude data. 

2. The longitude and latitude use only numbers, not the n, e, s, & w normally 

associated with this terms. To put in a western or souther location, use a negative 

number. 

91 View TrailSet 

View TrailSet is a stand-alone program called up from ORA. Key points to View TrailSet 

are: 

 It always involves both subjects and locations. 

 Unlike a network, subject may revisit location. 

 The time stream is an integral part of the data. 

 Subjects exist at one location at a time (but longer relationship may be implicit in 

repeated visits). 

The Foci of Activity are figuring out where people tend to go and guessing what they do 

there? 

91.1.1 NOTE : Before you can use the View TrailSet function you must 

create a TrailSet 

From the main menu select Data Visualization => View TrailSet 

The Loom Input Chooser will appear which allows you to start Loom with any currently 

active TrailSet listed in the drop down menu. 
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After selecting your TrailSet you are presented with the Main Loom window. There are 

three panels to this window. 

1. agent – Clicking in the checkboxes will activate/deavtivate the agents from panel 

3. You can select multiple agents to be displayed simultaneously. 

2. location – List all the locations in the MetaMatrix. 

3. display – This panel holds the currently selected agents and locations. 
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First we'll select two of the agents for display. With both agent's color being a shade of 

blue it could be difficult to distinguish their lines if they were close together. Can you 

really tell which one is Ren'al and which direction she took after the convergence? 
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You can change the color of any of the active trails. Click on the colored circle to the 

right of the name. This brings up the Choose Trail Color box. For our example we'll 

choose a bright, light color to contrast the dark blue. 
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The trails are then much easier to read. 

 

Additionally if you Right-click on any of the colored bands in panel 3 an information 

menu will appear with details about that location. 
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92 View Measures Over Time 

Using the View Measures Over Time on a Network allows an analyst to see how a 

network measures change over multiple time periods.  

In this example three Networks are loaded into ORA. 

 

From the main menu select Data Visualization => View Measures Over Time 

A dialog box will appear stating it will run on the currently loaded Networks. If you have 

any Networks you do not want in the calculation hit [Cancel] and remove them from 

Panel 1 before proceeding. 

Once you have the Networks you wish to work with active, select [OK]. 
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The View Measures Over Time box will appear. It consists of three sections: 

1. Set Aggregation Level – A slider allowing you to choose between plotting all 

Networks or just the beginning and end points. 

2. The Measures selection tabs – Choosing a particular tab will reveal the measures 

that are capable of being run on that particular node. 

3. The Time / Value charting area – The area in which the plots will be plotted. 
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In this example I set the Aggregation Level to 1 and chose Clustering Coefficient. 

The program then plotted the three points form the three Networks I had loaded, 

tanzaniz_3, tanzaniz_4, and tanzaniz_5. 
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Moving the pointer to Aggregation level 2 draws a line form the beginning value to the 

ending value. 
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93 View Network Over Time 

The View Network Over Time tool allows you to set up multiple Networks that 

encompass various time frames and view them in succession. First, make sure you have 

two or more NetworksMetaNetworks active in the leftside panel. 

 

Now select form the menu Data Visualization => View Network Over Time 

This will bring up the visualizer along with the Time Viewer window. At the start the 

pointer starts at the first position. You can see in the blue ellipse that hum is connected 

singularly to file. 
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Moving the pointer to the second position you can see that hum is no longer connected to 

file but it still connected to another node inside the cluster. 

 

Moving the pointer to the third position causes hum to become a completely isolated 

node. file is still connected to the cluster. 
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93.1 Network Visualizer  

From this sub-menu, you can call up the Visualizer and presetting various Visualizer 

functions. 

The Entire Network:  

This will display the entire MetaNetwork that was currently selected. Any changes 

you need to make will have to be done one you're in the visualier. See The Visualizer 

section 

View from Path Finder:  

Calls up the Path Finder function in order to plot information for the visualizer to use 

to find the connexion between two nodes. 

View from Sphere of Influence:  

Calls up the Sphere of Influence function in order to plot information for the 

visualizer to use to find the connexion between two nodes. 

View from Key Set:  

Calls up the Key set function in order to plot information for the visualizer to use to 

find the connexion between two nodes. 
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94 The Visualizer 

95 Actions 

This section of the help contains a description of the functions of the Action Menu: 

: 

Undo : Undoes a variety of actions performed in the Visualizer. 

 
Add Node(s) : Function for adding Nodes directly into the Visualizer. 

Add Link : Function for adding links directly into the Visualizer. 

 
Isolates 

Periphery : Moves Isolates back to their original position. 

Hide Isolated Nodes : Remove any node which has zero links connecting it to other 

nodes. 

Combine into MetaNode : Collects all the Isolate nodes into a Meta-Node. 

Move into Column : Moves all isolates to the right side of the screen in a column. The 

isolated nodes can be moved back using the Periphery option. 

Hide Pendant Nodes : Remove any node which has only one edge connecting it to 

another node. 
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Recursively Hide Pendants : This function will run the both the Hide Pendant routine 

until there are no more Pendants. 

Recursively Hide Pendants and Isolates : This function will run both the Hide Pendant 

and Hide Isolate routines until there are no more Pendants or Isolates. 

Show All Nodes: Any nodes that were previously hidden will be revealed. 

Show All Nodes Except Isolates : Reveal any nodes that were previously hidden with the 

exception of nodes that have no links connecting them to another node. 

Set Title : Allows the user to specify a title for the visualizer picture. Useful for creating 

slides that need a labeled picture. The title will appear centered at the top. If you wish to 

remove the title call the function up a second time, leave the textbox blank, and press 

[OK]. This will delete the title from the screen. 

 
Reset Node Colors and Size : If colors and sizes have been changed this option will reset 

them to the defaults. 

Color Nodes by Attribute or Measure : This allows the user to select a node attribute and 

color code the nodes according to its value for the attribute. 

For Attribute: Each node will be colored depending on the value of it's attribute. 

For Measure: The user selects a measure to compute on the visible network and then 

the nodes are colored according to its value for the measure. 

Color Nodes by Component : This computes the components of the visible network and 

then color codes the nodes according to which component it is in. A component is a 

single piece of a network whereby any two nodes in a component are connected by a 

sequence of links. 

Color Nodes by Concor Grouping* : This computes the CONCOR algorithm on the 

visible network and then color codes the nodes according to which CONCOR group it 

belongs. 

CONCOR then divides the data into two sets on the basis of these correlations. Then, 

within each set (if it has more than two actors) the process is repeated. The process 

continues until all actors are separated. The result is a binary branching tree that gives 

rise to a final partition. 

Color Nodes by Newman Grouping* : This computes the Newman algorithm on the 

visible network and then color codes the nodes according to which Newman group it 

belongs. 

Each pair of actors is correlated then each row extracted and correlated with each 

other row. Shows how similar is the vector of similarities of actor X to the vector of 

similarities of actor Y? Repeat this process over and over. The elements are iterated 

correlation matrix converge on a value of either +1 or -1. 

Size Nodes by Attribute or Measure : Allows the user to scale node sizes based on a 

measure or node attribute. Measures are run on the visible network. 

NOTE : All of the operations are on the visible network, that is, whatever nodes and 

edges are currently displayed in the visualizer. 
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Compute Standard Measures for Visible Network : Compute Standard measures 

computes the following collection of measures on the visible network: Total Degree 

Centrality, Betweenness Centrality, Eigenvector Centrality, Cognitive Demand, Resource 

Exclusivity, Task Exclusivity, Knowledge Exclusivity. The measure values can then be 

viewed within the Entity Status Window. 
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96 Add Edge 

IMPORANT NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be 

sure to use either the File => Save Meta-Network As… (to save the entire Meta-Network 

with additions) or File => Add Meta-Network to Ora (to create a new Meta-Network 

using only the currently visible nodes). Changes can not be saved back to the currently 

open Meta-Network. 

 

1. Start node : The start of a directed edge. 

2. End node : The end of a directed edge. 

3. Insert Nodes as they're clicked : Fills in the textboxes for Node. The first click 

adds the node in the Start node section. The second click adds the node to the End 

node section. Any further clicks will make the previous End node the start node 

and the newly clicked node becomes the new End node. 

4. Use an Existing network will place the links within the choosen network form the 

dropdown menu and Use a new network creates a new network from the name in 

option 5. 
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5. New Network ID: is the name for the new network from option 4. 

6. Link Weight : The weight to assign the edge between the nodes. 

96.1.1 Since this function creates directed links a second edge would need 

created for reciprocal action. 

Example: If a connexion was made starting with A to B, a second connexion would 

need to be made starting with B to A. 

96.2 Adding a Missed Link 

If after the Meta-Network was constructed and it's noticed an link is missing (e.g. 

janet_frazier should have been connected to gen_hammond), the missing link can be 

added immediately without returning to the editor. 
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From the Visualizer menu select Actions => Add Edge(s). 

 

Be sure that the Insert Nodes as they're clicked has been checkmarked and that Use an 

existing network is selected with the correct network is visible in the dropdown. Then 

select the [Create Edge] button. 

 

The two nodes are now connected with a directed link. 

96.2.1 NOTE : this created a directional link from janet_frazier to 

gen_hammond but not the other way. To make it go both ways, a 

second link from gen_hammond to janet_frazier would need to be 

created. 
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97 Add Node 

IMPORANT NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be 

sure to use either the File => Save Meta-Network As… (to save the entire Meta-Network 

with additions) or File => Add Meta-Network to Ora (to create a new Meta-Network 

using only the currently visible nodes). Changes can not be saved back to the currently 

open Meta-Network. 

 

The Add Node(s) function allows addition of nodes to the current Visualizer. These 

added Nodes are not added to the currently open Meta-Network. If there is a need to save 

the Meta-Network with the added nodes then use the menu item File => Save Meta-

Network to File… and create a new Meta-Network. 

Below is the NodeSet for Stargate with the original 16 node NodeSet. 
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From the main menu select, Actions => Add Node(s) which brings up the Add Node(s) 

dialog box. 

 

1. Use an Existing nodeset :  

allows for for a NodeSet selectable in option 2 or Use a new nodeset creates a 

new empty NodeSet. 

2. This dropdown gives the option for selecing a pre-existing NodeSet to place the 

new node. 

3. The Node ID: textbox is used for giving the new node an ID. 

4. The Number to Create: specifies the number of new nodes. 

NOTE : If the Number to Create is larger than 1 then the text placed in section 3 for 

Node ID will be used as a prefix for all new nodes crated. 

 

After inputting the information to add node A17, the Visualizer will now display the new 

node as A17 with no connexionx. In order to display this node with a title will require 

saving the Meta-Network and changing the information within the ORA Editor. 
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97.1 Adding Multiple Nodes 

The procedure for adding multiple nodes is similar to adding a single node. The 

exception is the text in the Node ID: textbox. When adding multiple nodes only use a 

prefix. ORA will attach numbers, starting at 1, for each node. 

Here's the addition of three new nodes and the prefix A will be used. Three nodes, A_1, 

A_2, and A_3 are created on screen. 

 

NOTE : You can only use a prefix ONCE. ORA will not accept any previously used 

prefixes a second time. 
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To add additional nodes use a different prefix. 

 

NOTE : Now either save the altered Meta-Network using the File => Save Meta-Network 

As… to a new filename or continue with Add Link(s). 

98 Add Nodes and Links in Visualizer 

ORA allows the addition of Nodes and Links directly into the Visualizer to create 

customized Networks on the fly. 

Add Node(s) : allows for the addition of one or more nodes directly into the Visualizer. 

These nodes will initially contain Node IDs only.  

Any titles or attribute settings will be made after the Meta-Network is saved into a new 

file. These nodes can be added to existing NodeSets or completely new NodeSets. 

Add Edge(s) : allows for the addition of edges connecting nodes (either previous nodes or 

newly constructed nodes) to enhance, or create, Networks. 

 
NOTE : Changes done using Add Node(s) and Add Link(s) are transient. Be sure to use 

either the File => Save Meta-Network As… (to save the entire Meta-Network with 

additions) or File => Add Meta-Network to Ora (to create a new Meta-Network using 

only the currently visible nodes). Changes can not be saved back to the currently open 

Meta-Network. 

98.1 The difference between the Save options. 
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Save Meta-Network As… writes a complete set of NodeSets and Networks to the 

DynetML file. If only saves the visible nodes. If none of the nodes of a NodeSet are 

visible, then an empty NodeSet will be saved to the file. 

Add Meta-Network to Ora saves directly into ORA and creates only NodeSets and 

Networks that are currently visible in the Visualizer. 

99 Brand New Network 

This function also allows the creation of Networks from Scratch. First, remove the 

checkmarks from all the NodeSets in the Legend to remove them from the screen. 

 

99.1 The DataSet 

Next prepare your data for inclusion. Here is a small, five node, NodeSet. 

A01 col_jack_o'neill 

A02 maj-samantha_carter 

A03 daniel_jackson 

A04 teal'c 

A05 gen_hammond 

From the main menu select Actions => Add Node(s). 
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In the dialog box activate the Use a new nodeset radio button. Underneath, in the Type: 

dropdown menu, select the type of NodeSet. Then in the New NodeSet ID: textbox give 

it a name. Then select the [Create Node(s)] button. 

 

The five nodes will appear in the Visualizer with the prefix and attached numbers. Now 

it's time to connect the nodes. 
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From the Visualizer menu select Actions => Add Link(s). 

 

After selecting [Create Link] a new link will be drawn in the Visualizer. 
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Now switch the NodeSet to use to Use an existing network, select the newly created 

NodeSet in the dropdown, and create the rest of the links. 

 

All of the links are now complete. 

 

Save the Meta-Network with either Save Meta-Network As… or Add Meta-Network to 

Ora and use the ORA editor to add in titles and attributes. 
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100 Color Nodes by Attribute 

When the agent-by-agent network is opened all the nodes deafult to the color red. ORA 

has default colors for all the arious NodeSets. But ORA can also color the nodes based on 

their individual attributes. Here's the default agent-by-agent NodeSet in red. 

 

From the Visualizer main menu select Actions … Color Nodes by Attribute or Measure. 

This brings up the Node Color Selector dialog box. 
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Selecting the down arrow for Select an Attribute:. Highlight an attribute from the list. 

ORA gives default colors to the nodes. 

 

In some instances the color distinction isn't highly visible. And for presentation purposes 

a good contrast is necessary. 

To bring up the Color Selector click on the color you want to change. 
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Select a new color from the swatches. Then select [OK] 

 

Your new color choice is now reflected in the dialog box. 

 

And the nodes with the attribute you selected are now a new, and brigher, color. 
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101 Compute Standard Measures 

This functions runs four standard measures: 

 

Cognitive Demand: Cognitive Demand measures the total amount of effort expended by 

each agent to do its tasks. Individuals who are high in cognitive demand value are 

emergent leaders. Removal of these individuals tends to be quite disruptive to networks. 

 

Centrality, Betweenness: Betweenness tells us which node is the most connected to other 

parts of a network. For example, Betweenness can tell us which person in a network is 

the most central to the network as a whole. Betweenness measures the number of times 

that connections must pass through a single individual to be connected. 

 

Centrality, Eigenvector : Eigenvector Centrality reflects one's connections to other well-

connected people. A person connected to many isolated people in an organization will 

have a much lower score in this measure then those that are connected to people that have 

many connections themselves. This would be true even if such a WHO might have a high 

amount of actual connections (i.e. high degree centrality). 

 

Centrality, Total Degree: Degree Centrality tells us the relative number of direct 

connections a WHO might have in a network; the higher the score the more likely a 

WHO might be likely to receive and potentially pass on critical information that flows 

through the organization. 

 

These values can be viewed either by hovering over a node and revealing the tooltip or 

double clicking a node and bringing up the Node status dialog and selecting the Measures 

tab. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\cognitiveDemand.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\centralityBetweenness.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\centralityEigenvector.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\measures\centralityTotalDegree.html
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102 Isolates 
102.1 Periphery 

Places isolates that were moved into column back to their original positions. 

102.2 Hide Isolate Nodes 

To further simply a visualization, it may prove useful to remove isolated nodes from the 

visualization.  

Isolated nodes are not directly linked or connected to other nodes, which share direct 

links with each other. In the screen shot below, the red ellipses highlights an isolated 

nodes which need removed. 

 

Select from the Main Menu: Actions => Hide Isolated Nodes. 

In the screen shot below, after removing isolated nodes, the visualization is further 

simplified.  

 

102.3 Combine into MetaNode 

This option will combine all the Isolates into one MetaNode. This can be expanded right-

clicking to bring up the contextual menu. 
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102.4 Move into Column 

This function is used to move isolate nodes from the main viewing area to move easily 

view the connected nodes. These will be lined up on the left side of the screen. 

NOTE : The original dataset was changed in order to create the isolates. 

NOTE : If the names are unviewable and off the screen, change the position of the labels 

The isolates can be returned to the original position using the Periphery options. 

: 

103 Removing Pendants 

Pendants share links with only one other node. Their linkage is tangential and therefore 

isolated from the core linkages you may be interested in examining. Pendant Nodes, like 

Isolated Nodes, can be removed. 

From the drop down menu in the Visualizer select Tools => Hide Pendant Entities.  

Below is a Before/After screen shot of the visualization before showing the removal of 

the pendant entities. 

 

104 Resize Nodes by Attribute 
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Resize by Attribute uses the numerical value of an attribute to size the nodes. Sizes will 

be scaled accordingly. Below is an attribute created for this example.  

The numbers range from 0 to 10 and denote approximate rank. 10 denoting general/leader 

down through the ranks to 5 for civilians and finally 0 for persons not involved. 
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From the main menu select Actions => Size Nodes by Attribute or Measure. Then select 

the attribute to use for the sizing. When finished, select [Close]. 

NOTE : Sizing nodes by attributes only works with attributes of numerical content. Alpha 

content will have no affect on the size of the nodes. 

 

Each node will now be displayed according to the value in the chosen attribute. 

NOTE : The numerals are not displayed in ORA and are shown only for display 

purposes. 

 

105 Resize Nodes by Measure 
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ORA has the capability to visualize nodes by scaling them relative to each other in 

relation to common SNA Measures or Attributes as selected within the ORA Visualizer.  

 

The key benefit to sizing nodes by Measure or Attribute is the ability to conceptually 

capture which nodes in your network figure more prominently in terms of measures by 

simply gauging their size visually and intuitively. 

 

First, visualize one of your networks. Below is the Stargate agent x event network to find 

the agent with expertise regarding events in the scenario. 
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From the main menu select Actions => Size Nodes by Attribute or Measure. 

From the bottom textbox I selected Cognitive Expertise. Each of the nodes in turn grows 

to reflect it's value from that measure. 

 

The display now changes to reflect each node's value by size. 

 

We'll compare two nodes: daniel_jackson and teal'c.  

daniel_jackson's cognitive expertise value is 0.2400 and is displayed with a large red 

circle while teal'c's value is 0.1556 is displayed by a much smaller red circle. The values 

can be read in the Node Status dialog box. 
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105.1 Cognitive Measure for daniel_jackson 

 

105.2 Cognitive Measure for teal'c 

 

106 File Menu 

Below is an image of the file menu from ORA's main interface.  

 

Open Meta-Network… 

This opens an Open File dialog box so you can navigate to a directory and open a 

Meta-Network into the Visualizer. 

Save Image to File… 

This opens a Save As… dialog box and allows you to save an image of the current 

Visualizer in one of the formats listed below. 

 

Save Meta-Network to File… 

After you've made changes to the information you can save the current status of the 

Meta-Network into a new file in a DynetML* format. 

Copy Image to Clipboard 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23d
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Similar to the Save Image to File… only saves it to the clipboard where you can paste 

it into an image-editing program. 

Add Meta-Network to ORA 

Save the curently visibile network into a new Meta-Network titled, New Meta-

Network. This new Meta-Network can be renamed accordingly. 

Visualize in 3-D 

Close 

Close the Visualizer and returns to the Main Interface. 
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107 Link Color 

In ORA you can color links according to several preferences.  

 

107.1.1 NOTE : For this example all the nodes are colored black so 

as to decrease the color confusion. 

 

NOTE : For this example the link weights have been drastically altered from the original 

values to assist in display purposes. 

 

NOTE : Below is a warning for the placement of the Min and Max sliders. When the 

sliders are set to the absolute left and right positions this causes all the colors to be set to 

red. Move the sliders in to prevent this. 
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107.2 Even Distribution - The Full spectrum 

 

The colors used are evenly distributed across the chosen spectrum. Using a NodeSet with 

weights of 2, 4, 6, 8, & 10 would have three colors chosen at evenly spaced intervals 

across the spectrum. 
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107.3 Even Distribution - The Limited spectrum 

 

Limiting the spectrum to smaller set will cause some of the numbers to contain very 

similar colors. This might make it dificult to tell the various shades of blue apart. Use this 

only when there are a very limited number of values. 
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107.4 Scale to Weight 

 

When scaling to weight the 100 values cause a spread to occur that makes all other values 

in the same general color area. 
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107.5 Link Values 

 

When a link is bi-directional and the weights of the links are not the same the Visualizer 

will color the link that was drawn last. 

107.6 Change link Color 

After setting the type Even Distribution/Scale by Weight the color of the links can be set 

manually through the color changer. Click on the color box of any of the links to bring up 

the color change dialog box. Select a new color and select [OK]. 
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108 Comments 

While in the Visualizer Comments can be added to the display. Right-click a node and 

from the contextual menu select Add Comment. The comment is placed in a colored box 

with a dashed arrow connecting them to the original node. 

NOTE : These comments are not saved when exiting the Visualizer. 

NOTE : The main use of these comments would be in creating screenshots for display in 

order to add commentary for a report. 

Below is a section of the Stargate scenario with the unexpected appearance of Osiris. 

 

108.1 Adding a Comment 

A comment is added stating Osiris's arrival changes the plan. 

 

From the main menu, under the Tools item, the font size and color, as well as the color 

fot eh box, can be changed. 
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108.2 Adding Multiple Comments 

It is also possible to add multiple comments to the same node. 

 

108.2.1 REMEMBER: These comments are not saved when exiting 

the Visualizer. 

108.3 Deleting a Comment 
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A comment can be deleted by first selecting that comment. A right-click brings up the 

contextual menu. From this menu select Delete Selected Node(s). 

109 Node Images 

Nodes can be replaced with various symbols or pictures. There are a few items to note. 

1. All images should be reduced to a maximum of 40 x 40 pixels before using in 

ORA. Bigger images will be reduced to this size and the image quality may be 

degraded. 

2. If a picture is placed on a background with the color R=255, B=0, G-192 the 

background will be changed to the color of the node. 

109.1 Setting a Image Folder 

The Set Picture option is designed with modularity in mind, with adding new images as 

easy as putting a folder with images in the include\OraFiles\images\visualizer\node 

folder. The dialog will automatically read that folder for subfolders, use the subfolder 

names as categories, and the images inside the subfolders as the images for each 

category. 

109.2 Set Picture 

Right-click on any node and select Set Picture from the contextual menu. The Node 

Selector dialog box will appear. The drop down menu contains various types of node 

images. With a node selected a custom image can be applied. 

 

109.3 Custom 
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The Custom option allows for the inclusion of a user's own icons. 

The custom category is used for images that have been previously loaded in the current 

meta-network. Clicking OK applies the currently selected node's image to all nodes 

selected in the visualizer.  

Additional information can be found in the Node Shaper section. 

The [New Image] button brings up a navigation box from which to navigate any directory 

and select an image file. The picture types can be jpg/jpeg, gif, or png. These will all be 

collected into the Custom section. 

 

NOTE : Remember to reduce the picture size BEFORE importing it into ORA. 

 

To set a new image right-click the node and select Set Picture. This brings up the picture 

dialog box. Locate the appropriate picture and select it. A black border will appear 

around the image. Select [OK] will set the picture to the node. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\nodeManip\nodeManip.html
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110 Options 

Below is an image of the options menu in ORA.  

 

Log Scale Nodes – 

Show Mouse Overs – Toggles the information boxes on and off whenever you hover the 

mouse over a node or link in the visualizer. 

 
Show Links – Toggles on/off the display of links between nodes. 

Show Link Weights – Toggles whether the weight of various links is displayed. 

Show Arrows – Toggles on/off the display of the arrows of the links. 
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Show Self Links (Loops) – Shows whether there is a connection between a node and 

itself. It is designated with a circle pointing back to itself. 

 

Link Color – Options for coloring the links. 

 

 
Show Labels – Toggles on/off the display of the labels of the nodes. 

Load Node Images –  

Label Style – Determines the placement of the labels of the nodes. 

 

Node Style – Rotates between the three sizes and styles for the display of the nodes. 

 

Match Source Node colors the link the same as the source and Match Target Node 

will change the color to match the target. Helpful when you need various points of 

reference for the links. 

 
Show Comment – Toggles on/off the display of comments 

Set Comments Font – Set font for ALL comments 

Set Comments Color – Set color for ALL comments 

 
Set Title – Type in the title for this screen shot 

Set Title Font – Select the font for the title 
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Show Title –  
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Title Location –  

 

 
Black and White Only – Removes all colors form the visualizer. 

Background Color – Changing the background color changes it in both the Visualizer and 

the Legend. 

 

110.1.1 NOTE : Some of the possible background colors can make it 

difficult to view the visualizer. Your best choice is black (although 

white is used in the examples for easier printing). 

 
Background Image – Allows you to chose a .jpg, .gif, or .png to use as a background. 

 

Please be aware that some pictures may make viewing the network somewhat difficult. 
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111 Creating A Meta-Node 

A Meta-Node contains multiple nodes collapsed into one. You can create Meta-nodes 

based on the nodesets in your organization, or you can create MetaN-nodes based on the 

attributes of the nodes.  

To create Meta-nodes, you must access the Meta-node Manager. There are two ways to 

do this: 

From the drop down menu select Tools => Meta-Nodes of select the Meta-Node Manager 

button on the toolbar. 

 

And it brings up the Meta-Node dialog box. 

 



 

237 

 

1. Expand all meta-nodes expands all meta-nodes to their respective single nodes. 

2. Select how to create links between Meta-Nodes: 

o Absolute count of the links : Counts each link from any node in the Meta-

Node to any other node as 1.0. 

o Proportion of the maximum possible links :  

o Block model links and weights :  

3. Meta-Node Creation is controlled by three buttons: 

o By Node Class : Creates Meta-Nodes based on current NodeSets. 

o By Most Recent Grouping : Creates Meta-Nodes based on the most recent 

use of the Group Viewer. 

o By Attribute… : Creates Meta-Nodes on one individual attribute. 

4. Select an Attribute : ALlows for the selection of the attribute to group on. 

5. Funnel nodes without this attribute : Collects all noes without the above attribute 

and places them into one collective Meta-Node. 

112 Meta-Node - Attribute 

This button creates Meta-Nodes using a single attribute. It's used in conjunction with the 

Funnel Nodes checkbox. Below is an image of the Select an attribute box:  

 

Choosing group without the Funnel Nodes checked creates a confusing display. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\groupViewer\groupViewer.html
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Next place a checkmark in the Funnel nodes box and select groups for a cleaner display. 

 

 

Leaving the Funnel nodes option unchecked works best with fewer NodeSets. Below 

only the agent and tasks NodeSets were used. Without funneling the individual tasks can 

be viewed as to which agent Meta-Node they connect to. It also reveals that groups in 

area 1 are not connected to any tasks and that groups in area 2 are all the agent nodes that 

had no groups affiliation. 
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113 Meta-Node - Recent Grouping 

Recent Groupings is used in conjunction with he Group Viewer. 

Content under development  

114 Meta-Node - Node Class 

Node creation is done via three buttons in the Meta-Node Creation section. 
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This button will create Meta-Nodes for each NodeSet. 
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115 Drill Down Wizard 

With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall 

node class (knowledge, tasks, resources, agents) or by choosing individual nodes from a 

checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer: 

From the ORA Visualizer Main Menu select Tools => Drill Down. 

The following window box will appear. 

 

The top sections allows you to chose the ndoes for use. The bottom tabs allow for 

choosing specific nodes within a set. 
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116 Drill Down Wizard Example 

Using the Embassy Meta-Network, we will render the various node classes using the 

Drill-Down Wizard Tool. The screen shot below displays the Embassy Meta-Network as 

it should first appear in the Visualizer. 
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From the Main Menu select Tools => Drill Down. 

This will bring up the Drill Down dialog box as shown below). 
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Here, select the node class Knowledge by selecting the Knowledge check mark box. The 

screen shot below, displays the end result that you should now see in the Visualizer. 

 

Next, with the Knowledge node box checked, add the node class Task. The screen shot 

below displays the end result. 
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Next use the search bar feature of the Drill-Down Wizard to narrow the search. 

Enter the word Bombing in the Visualizer search field below. Then select the check box 

on the bombing row. The screen should now reflect your new search parameters. 

Everything not associated with bombing has been turned off. 
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247 

 

117 Drill Down Wizard Explained 

The ORA Drill Down Wizard can be broken down into three primary sections of input: 

1. Section 1: enables you choose individual node sets or combination of node sets to 

display in the Visualizer. 

2. Section 2: of the Drill Down Wizard enables you to search for a particular node 

within your Meta-Network. This can be handy when you dealing with large 

nodesets and the one you are interested in finding is not easily located. 

3. Section 3: enables you check mark an individual node within your Meta-Network 

by node class if so desired. 
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118 Node Status 

The Node Status Window is used to reveal pertinent information about one selected node. 

The window can be brought up by either selecting it from the main menu, Tools => Node 

status or by double-clicking the node in the visualizer. The dialog box below will appear.  

There are four tabs available which will display the node's information. 

 

You can switch nodes by selecting any other node in the visualizer. ORA will 

automatically change the display. 
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This tab display all the attributes for the node selected as well as it's value. 
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The Neighbors tab displays which other nodes have a connection as well as the strength 

of the link. 

 

119 Group Viewer 

The Group Viewer helps separate nodes into distinct groups.  

We'll use one of the networks for each of the groups to further examine the breakdown. 

There are six groupings which can be called up: 

 Clique 

 CONCOR 

 FOG 

 Johnson 

 K-FOG 

 Newman 

 



 

251 

 

120 Group Viewer-CONCOR 

Below is an image of the Group Viewer window and procedures for using this tool.  

 

120.1 Parameters 

Use out-links (matrix rows)? The links leading out of the choosen node into another 

node. 

Use in-links (matrix columns)? The links leading into the choosen node from another 

node. 

120.2 Example 

The example uses the network agent x task. Foe each of the three possibilities in, out, 

both the display is shown with the number of groups set to 4. The resulting displays show 

how the in and out links affect the groupings. 
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120.3 Use both in-links and out-links 

 

120.4 Use in-links 

 

120.5 Use out-links 
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121 Group Viewer-FOG 

Below is an image of the Group Viewer FOG window and procedures for using this tool.  

 

FOG stands for Fuzzy Overlapping Groups. Individual nodes can have lnks to multiple 

groups at varying strengths. This function shows those multiple links. 

121.1 Parameters 

Select the number of trees per node:  
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Select the tree size:  

121.2 Example 

I used the agent x task network and ran the FOG group viewer on is. Following is the 

progression of groups from 1 to 3 using the parameters in the dialog above. 
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 The group at the bottom right consists primarily of the SGC members. 

 The group at the bottom left consists primarily of the Tok-ra and the Tollan. 

 The top group has one singular member and links to three members of the other 

groups. 

Osiris is the only person not belonging to any of the above mentioned groups and the 

function placed her in the group it deemed most fitting. 
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122 Group Viewer-Johnson 

Below is an image of the Group Viewer Johnson window and procedures for applying the 

Johnson algorithm.  

 

122.1 Parameters 

Relationshop type:  

 Similarity 

 Dissimilarity 

Link method:  

 SingleLink 

 CompleteLink 

 AverageLink 
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123 Group Viewer - K-FOG 

Below is an image of the Group Viewer K-Fog window and procedures for applying the 

K-FOG algorithm.  

 

123.1 Parameters 

Select the number of trees per node:  

Select the tree size:  

Using the numbers Number of trees per node=2 and tree size=2 I created ten sets of runs 

for 2 groups. Below is a sample of the first run.  
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After 10 runs the following numbers were obtained. Each run gave successively variying 

results with the top ten nodes with multiple links as follows: 

TOTAL RUNS 10 

defend_revenna 9 

hide_data_crystal 6 

present_plan_to_sgc 5 

find_tunnel_crystals 4 

fly_cargoshop 4 

create_memory_drug 4 

Ren'al 3 

infiltrate_summit 3 

find_ring_room 3 

poison_jaffa_at_gate 3 

124 Group Viewer-Newman 

Below is an image of the Group Viewer window and procedures for applying the 

Newman grouping algorithm: 
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The Newman grouping is used to find clusters in a network. I began increasing the 

number of groups to view until the larger cluster began to break up. 

 

In this case the nodes remained clustered (with only one or two nodes breaking off) until 

I reached 4 as the number of groups. Then the network broke up into two large and two 

small clusters. The nodes in each of the two large clusters have a commonality as to the 

organizations they belong to and the tasks they were assigned. 

125 KeySet Selector 

Below is an image of the Stargate data set visualized. We will use the KeySet selector to 

simplified this visualization.  
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125.1 Visualizer Commands 

The Show Only Checked Items, Add Checked Items, Show All But Checked Items, 

Remove Checked Items all work on selecting/deselecting nodes within the table from 

where they can be checked or unchecked for display. 

Create Meta-Node 

Highlight Checked Items 
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126 Keyset Selector Examples 

Following is a short example of the KeySet Selector. It covers the main aspects of the 

tool only. 

 

In the Filter Commands textbox the word poison is typed which causes all nodes with 

poison in any attribute to be revealed. Pressing the [Select All] button places a checkmark 

in all the nodes.  
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Lastly in the Visualizer Commands pressing the [Show Only Checked Items] button 

hides all but the checked items. 

 

The [Clear All] button is pressed to clear all the checkmarks. poison is replaced in the 

Filter Commands with the word sg-1. Be aware that even though only nodes with sg-1 are 

to be added the two nodes with sg-17 also appear as sg-1 is a sub-string of sg-17. SO 

instead of using the [Select All] button checkmarks are manually placed inthe checkboxes 

desired. 
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The [Add Checked Items] button is pressed and the four new nodes are added to the 

visualizer. 

 

With the four nodes of sg-1 still checkmarked press the [Highlight Checked Items]. The 

four nodes are now displayed in a larger format. 

 

The last button, [Create Meta-Node] will cull nodes into a Meta-Node. 
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127 Legend 

The Legend dialog box allows you to quickly hide and reveal nodes and links in the 

visualizer.  

Use the checkboxes to change a NodeSets visibility. When you first call up the Visualizer 

all the boxes will contain checkboxes... 

 

...and in the Visualizer all nodes and links are revealed. A little hard to make heads or 

tails of something like that. 
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By using the Legend checkboxes you can selectively show/hide nodes and links. Deselect 

the checkbox to the left of Agent. Instantly all of the Agent nodes are hidden along with 

any connections they had with the rest of the nodes. The node structure is a little easier to 

see now. 

 

Next think about a particular set of connexions you'd like to see, say a task x task 

network and how the agents relate to the tasks. 
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From the Legend box menu select Control => Hide All nodes Then again from the menu 

Control => Refresh Legend. Now place checkmarks in the checkboxes for agent, task, 

and task x task. All the tasks will be linked together as per your network and all the 

agents will have connexions to the tasks they are associated with. 

 

Another example is how knowledge relates to specific tasks. From the Legend menu 

select Control => Hide All Nodes. Now place checkmarks next to knowledge, task, and  
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Now the Visualizer reveals which knowledge is required for which specific tasks. 

 

128 Legend Control Menu 

Below is an image of the Legend Control window: 

 

Show All Nodes : Will bring into view all entities in the MetaMatrix. Good to use if you 

need to make a fresh start. 

Hide All Nodes: Hides every entity. Good starting point when you only wish to display a 

small subset of entities. 

Refresh Legend : After using the menu items above and/or using the checkboxes this item 

will bring the visualizer up to date. 

129 Legend Edit Menu 

Below is an image of the Legend Edit Menu and a description of this tool: 

 

Copy Legend Image to Clipboard : Copies an image of the entire legend that can be 

pasted into an image-editing program. 

130 Node Color 
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The color of a NodeSet can be changed in the Visualizer. Below are procedures for doing 

this task.  

130.1.1 NOTE : This color change is in effect for as long as the 

Visualizer is open. If you close and re-open the Visualizer the colors 

will revert to their default colors. 

Here is a section with the default colors of red for agents and cyan for tasks. 

 

Open the Legend window (if it's not open already) and click once on the NodeSet you 

want to change. This will bring up the Color Change dialog window. 

 

Select [OK] and the new color will be displayed for the choosen NodeSet. 



 

270 

 

 

The newly selected color appears in both the Visualizer and Legend windows. 
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131 Node Shaper 

The Node Shaper allows you to change the size of individual node(s) or assigning 

pictures. Below is an image of the Node Shaper widow and a description of how to 

change the shape of the nodes in your model.  
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1. Select a Style : Select from three Node Style Sizes or use an image in it place of 

the node. 

2. Select a Shape : An optional shape can be used instead of the NodeSet's default 

shape. The node will retain it's default NodeSet color. 

3. Select Node to Re-Shape : The bottom section contains the controls for selecting 

which nodes to work with. Typing anything in the Find textbox will automatically 

filter out non-matching nodes. 

4. NodeSet tabs : Select which NodeSets to view. ALL shows every node or the tabs 

will show only their individual NodeSets. 

5. Checkboxes : Place a checkmark in the box next to the nodes you want to change. 

6. Filters : Use for filtering based on individual attributes. You can filter on more 

than one attribute at at time. An example can be found in Create a new Meta-

Network 

7. Select/Clear All buttons : Will either Select or Clear all VISIBILE nodes. If a 

checkmarked node has been filtered out and is currently NOT visible when the 

Clear All button is pressed, then that node will retain it's checkmark and be 

affected by future changes. 

8. Apply/Load Changes : After any changes have been made to the top portions 

selecting the [Apply Changes] buttons will cause them to be dsplayed int he 

Visualizer. 

9. Close :  

132 Node Shaper Examples (using images)  
132.1 Original agent x agent Network 

Below is the agent x agent network in the normal medium sized nodes.  

We will proceed to change the shape of the nodes to varrying sizes as well as add image 

and picture icons to the nodes.  

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\newNet\newNet.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\mainInterfaceTasks\newNet\newNet.html
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132.2 Multiple Sized Nodes 

By using the Find textbox and the Filters I placed checkmarks in all members of the 

SGC. Then the Large Node Style was selected the the the [Apply Changes] button was 

pressed. 

 



 

274 

 

132.3 Picture Replacement 

Here three different symbols were used to denote 1) the SG-1 team (the blue circles), 2) 

the SG-17 team (the green circles), and 3) the SGC who are not members of either team. 

This was accomplished by filtering which group was to be displayed. Then chekcmarks 

were palced and Image Node Style was selected. Then for each group an individual 

picture was applied to all the selected nodes ogether. 

 

Lastly is the ability to assign a picture of the actual person the node represents (or 

location, object, etc.). 

132.3.1 NOTE : It's suggested that any picture to be used should be 

reduced to a maximum of 40 x 40 pixels before importing as this is 

the size ORA will reduce it automatically. 
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133 How the Node Shaper Changes the NodeSet 

What follows are examples of how the Node Shaper changes the NodeSet. 

Whenever the Node Shaper is called and a node is assigned something other than it's 

default shape new attributes will be added to Every NodeSet, not just the NodeSet you're 

working with. 

 Drawing Type : This will define what type of node is to be drawn, shape of 

image. There are three options for size (small, medium, and large) and one option 

for image. 

 Nodes Shape : There are four large shapes (circle, rectangle, ellipse, and 

hexagon), eight medium shapes (circle, hexagon, downtriangle, pentagon, 

diamond, square, uptriangle, and octagon), and one small shape. 

 Image : Contains the name of the file associated with that node. 

Changing one node will create these three attributes and place the default value in every 

node in every NodeSet. Any of these attributes can be manually changed from within the 

Main Interface Editor. 
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This is useful if you have changed many nodes and want to restore them all to their 

defaults quickly and easily. The quickest way is using the Copy and Paste method. 

 

Column "1" contains the modified values. In column "2" three values of medium are 

highlighted and copied using Ctrl-C. In column "3" the cursor is moved to the top cell 

and Ctrl-V is used to paste those three values in. In column "4" this is repeated until all 

values are back to their defaults. 

If the Image attribute contained a filename then changing Drawing Type to image will 

relink that file to the picture. Any of the four Drawing Type values can be placed in this 

column. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\editMenu\cpValues\cpValues.html
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134 View Networks OverTime 

The Networks Over Time loads multiple Meta-Networks into the Visualizer and displays 

them as Time Slices. What follows are procedures to do this: 

First, highlight the Meta-Networks to load into the Visualizer. For this example I divided 

the whole Stargate Summit network into four disinct phases. 1) The meetings; 2) What 

was supposed to happen; 3) What did happen; 4) The attack on the Tok'ra homeworld. 

These are Summit 1-4. 

 

The diklog box appears for you to verify you've choosen the correct Meta-Networks. 

Place a checkbox in the ones you want or Check All. Then select [View]. 
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To control the Over Time function from the main menu, select Tools => Networks Over 

Time. 

 

The Phase Duration has two controls. Transition Phase duration sets the amount of time 

in milliseconds for the fading out of the previous set and the fading in of the new set. The 

Display Phase duration sets the amount of time in milliseconds that a set will be 

displayed before moving to the next set. 

 

Constant maintains a node's position throughout all Timeslices. Determined by Timeslice 

allows you to move a node independently in each Timeslice. 

Record Node Locations upon Exiting a Meta-Network maintains a node's position when 

changing Timeslices. NOTE: It does not maintain the node's positions after you exit the 

Visualizer. Upon returning to the Visualizer all nodes will be in default positions. 

The Slider bar controls which Timeslice is displayed. The buttons at the botton, [Play] 

and [Stop] control the motion display. 



 

279 

 

134.1 Summit-1 

The initial meetings between the SGC and the Tok'ra 

 

134.2 Summit-2 

The plan as it was supposed to go 
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134.3 Summit-3 

What really happened when Osiris showed up unexpectedly. Instead of poisoning the 

Summit daniel_jackson decides to forgo that action after hearing the information from 

Osiris. He's almost found out but still escapes. 

 

134.4 Summit-3 

What was happening back on Revenna while daniel_jackson was at the Summit. 

 

134.4.1 NOTE : Measures and reports run on these multi-

MetaNeworks are for all connexions, not the individual 

MetaNetworks. 
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135 The Path Finder 

The Path Finder is used to find, not only, the shortest path between two nodes but also 

paths to other nodes when particular situations occur. Below is an image of the The Path 

Finder tool and a description of its various elements.  

 

135.1 The interface contains four sections: 

Start node : Select the NodeSet/Node to begin the path. 

End node : Select the NodeSet/Node to end the path. 

Options : Options regarding link parameters and which NodeSets to use. 

Advanced Options : Options regarding whether, and how, to use one particular node 

within the set. 
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135.2 Using only Agent nodes (tolerance = 0) 

Using only the Agent NodeSet the pathway requires three intervening nodes. 

 

135.2.1 NOTE : For this example the values in the Network have 

been altered from the regular values. 

135.3 Tolerance of "1", nothing else checked. 

135.3.1.1.1 Shortest path: 1 

 

135.3.1.2 There is the direct link from gen_hammond to 

col_jack_o'neill and the secondary pathway with teal'c in the 

middle. 

135.4 Use link direction 

135.4.1.1.1 Shortest path: 2 

The path direction must lead from the source to the target. 

 

135.4.1.2 The link from gen_hammond to col-jack-o'neill is 

removed as it's a directional link in the wrong direction. The 

shortest link is "2". 
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135.5 Use link weight (Remove links with negative values) 

135.5.1.1.1 Shortest path: 6 

135.5.2 Use link weights finds the shortest path from A to B using 

minimal weights as opposed to minimal number of links. Also the 

shortest path is the total of the link weights — not the number of 

links total. 

 

135.5.2.1 The shortest path is from col_jack_o'neill to teal'c (5) 

then from teal'c to gen_hammond (1) for a total of "6". 

135.6 Use link weight (Convert negative links to positive values) 

135.6.1.1.1 Shortest path: 3 

Uses the absolute values of numbers. A negative number becomes a positive number. 
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135.7 Use link direction and link weight with absolute values 

135.7.1.1.1 Shortest path: 3 
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136 Sphere of Influence  

Each node within a network has a unique Sphere of Influence or Ego Network. 

Essentially it's a direct relationship with it's neighbors as a function of specified path 

length. The ORA Visualizer allows you to focus on this relationship by creating an Ego 

Map centered on any particular node you choose. 

From the Visualizer's Main Menu select Tools => Sphere of Influence. 

The following dialog box will then appear. From here you can select the Size of your 

sphere's influence, the nodeSets, and Key Sets to use. 
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136.1 Select a sphere of influence radius 

The drop down box allows you to choose the path length for a particular node(s). The 

value starts out at 0. Below is an example of a radius of 0, 1, 2, and 3. In many other 

cases the links will branch out as you increase the radius. 

 

Auto-Zoom : Maximizes your ego network within the Visualizer. 

Auto-Center : Keeps the visualized Ego Network centered within the visualizer display. 

Hide connections between levels : Removes any connections between nodes that do not 

have a connection to any node in the filter. 

 

Expand only these nodes : Allows you to select the components you wish to have 

displayed in a node's Sphere of Influence. 

Filter Commands : Used for selecting the filters to use on the current visualization. 

Node selection table : Allows the selection of individual nodes for visualization. First 

selected is symbiote_poison in the botom table. Then the NodeSets events and locations 

were added. Only the nodes that are linked to the original symbiote_poison are displayed 

in the visualizer. 
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136.2 A Sphere of Influence Example 

This example will show how to take one node and expand upon it to show how it is 

related to nodes in other nodesets. First, from the table at the bottom, select a node. Here 

we select the symbiote_poison. From the Expands only these nodes: place a checkmark in 

location. It reveals that symbiote_poison is connected to two locations, revenna and 

hasaraSystem_spaceStation. 

 

Next we'll place a checkmark next to tasks:. This reveals that there are two tasks that 

relate directly to symbiote_poison, poison_jaffa_at_gate and poison_summit. 
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Now that we've got a couple of nodes on the screen let's increase the radius of the sphere 

to 2. The tree will now display all nodes within 2 links of symbiote_poison. 

 

Lastly you can eliminate any nodesets by removing them from the list. Remove the 

checkmark from tasks: to reveal only the locations up to two links away. 

 

The Sphere of Influence allows you to hone your search and show only the nodesyou 

need to see. 
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137 Visualizer Tools 

The ORA Visualizer provides a suite of tools to visually analyze your Meta-Network: 

 

Drill Down 

With the ORA Drill-Down Wizard you can quickly visualize ego networks by overall 

node class knowledge, tasks, resources, agents) or by choosing individual nodes from 

a checklist. The ORA Drill-Down Wizard is only accessible through the Visualizer: 

Node Status 

The Node Status Window is selected by default. It first pops-up when you select any 

node in the Visualizer. This window provides you with a snapshot of the currently 

selected node by displaying that nodes unique Attributes, Measures, and Neighbors. 

Group Viewer 

Allows viewing of current display to be viewed in various grouping: CONCOR, 

Newman, Johnson, FOG, and K-FOG 

Key Set Selector 

Helps put a set of arbitrary items on the screen. 

Legend 

Allows for toggling visibility of nodex and links on the fly.  

Meta-Nodes 

A Meta-Node contains multiple nodes collapsed into one. You can create Meta-Nodes 

based on the NodeSets in your organization, or you can create Meta-Nodes based on 

the attributes of the nodes. To create Meta-Nodes, you must access the Meta-Node 

Manager. 

Path Finder 

The Path Finder allows you to focus or drill down on a particular node, or multiple 

nodes, that you may be interested in analyzing in greater detail. 

Sphere of Influence 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\drillDown\drillDown.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\entityStatus\entityStatus.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\groupViewer\groupViewer.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\keySet\keySet.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\legend\legend.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\createMetaEntity\creatingAMetaEntity.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\pathFinder\pathFinder.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\sOI\sphereofInfluence.html
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Each node within a network has a unique Sphere of Influence or Ego Network, 

essentially it's direct relationship with it's neighbors as a function of specified path 

length. 
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Block Maps 

Block Maps display varrying intensities of data by displaying "blocks" correlating to 

the value of data. For instance, a block map displaying node centrality values would 

reserve the largest block for the node highest in that value. Color is used to as well to 

visualize different values with the the darkest color reserved for the highest value. 

Block Maps can also be referred to as heat maps.  

Networks Over Time 

Allows you to view a version of your network across multiple time periods.  

Node Shaper 

Allows the altering of nodes on an individual basis including shape, size, and image 

changes. 

Vector Maps 

138 Hide Links With Weight 

ORA can visualize your network with only the more weighted links displayed. Below are 

procedures to accomplish this task.  

You can select to hide links either Less Than or Greater Than a certain value. Below is an 

agent x location network. And there are three tooltips displayed for jacob_carter for the 

values of 1.0, 2.0, and 3.0. We'll keep the hiding style as Less Than. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\blockmap\blockmap.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\overTime\overTime.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\nodeManip\nodeManip.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\tools\tools.html
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First we'll increase the value to 1.1 hiding all lower values. The link to the 

hasaraSystem_spaceStation is removed from view. The others, however are still on the 

screen. 

 

Now let's increase the value to 2.1. This removes the link from jacob_carter to revenna. 

 

If we increases to value to 3.1 then all of the links would be removed. 

In this way you can remove links which are of lesser important to concentrate on a 

smaller set of data. 
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139 Hyperbolic View 

The Hyperbolic function creates a bulge within your visualization adding a sense of 

depth. By moving the slider from right to left, you can increase or decrease this bulge 

effect and create different depth-added views. By moving the network around the 

window you can create the view you need. The Hyperbolic radio button and slider can be 

found at the bottom of the window. 

This tool is useful when nodes may be very tight on screen such as the ones in the 

following images. Using the Hyperbolic tool you can help space them out for easier 

viewing. Here is how to do so: 

 

139.1.1.1 Note : The Hyperbolic function, when selected, converts 

the slider to this feature. This is also true of using the zoom 

and rotate functions. Use all three in conjunction to get your 

visualization just the way you want it. Scroll down below this 

screen shot for another when viewed with the Hyperbolic 

feature. 
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Select the Hyperbolic tool and move the slider to the right. Then click-and-hold on some 

part of the white background and move the entire network to the left. You will notice the 

space between the nodes begins to increase the closer them come to the center of the 

screen. 

 

Now the nodes are able to be read much easier. 

139.1.1.2 Note : It is useful to use this tool in conjunction with the 

Rotate and Magnify tools to obtain just the view you desire. 
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140 Show / Hide Labels 

Node labels, which often prove helpful in describing Networks, can sometimes clutter a 

visualization. Thus, it may be necessary to eliminate labels from your visualization.  

The following procedure will help clarify the screen when it is clouded by the many 

labels: 

140.1.1 To remove labels go to Visualizer tool bar and find the Show 

Labels button. 

 

This initial screen shot shows the visualizer with all the labels. 

 

When you click the Label button on the Visualizer tool bar ORA toggles the labels on 

and off. Note that now a much more clearer conceptual picture of the network is 

produced. You can flip between the two views. 
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141 Removing nodes In The Visualizer 

You can remove nodes directly from the ORA Visualizer by right clicking on a node and 

selecting Hide Node. Below is an example of removing an node using the Hide Node 

tool.  

Find the node you want to hide. Here we will hide ren'al.  

 

Place the cursor over the node and right-click on the node to bring up the contextual 

menu. Highlight Hide node. gen_hammond and the four task nodes are now separated 

from the rest of the network. 
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142 Rotating A Visualization 

You can rotate a visualization with the slider bar at the bottom of the interface or from 

the tool bar at the top. To do this from the slide bar, click the rotate option toward the 

bottom of the interface. This activates the rotate feature.  

As you move the slider from the left to right, your visualization will rotate 

correspondingly. From the tool bar, you can click inside the rotate icon, which will turn 

the visualization depending on exactly where you clicked.  

In the screen shot below, the yellow ellipses highlight where to access ORA's rotate tool 

both at the bottom and top of the visualizer interface. 

Note : Use the rotate feature in tandem with the magnifying glass to find a visualization's 

maximum screen size. 
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143 The Tool Bar Explained 

This section explains the function of each of the toolbar's buttons. 

When you first load a Meta-Network you will see the pause button depressed in the 

Visualizer tool bar. You can layout the Meta-Network by clicking the play button.  

The visualization will space apart across the screen. This is called laying out a Network. 

The Visualizer is separating nodes and links that, at first, appear on top of each other.  

You can pause this process again when you think the Meta-Network is satisfactorily 

spaced apart or you can let ORA lay out the entire Meta-Network. Your computer speed, 

as well as the complexity of Meta-Network, will determine how long this takes.  

143.1 Copy Paste 

 

The Copy Paste feature allows you quickly capture a visualization and save it to be 

pasted into another document later. 

143.2 Play / Pause 

 

The Play Pause function works very similar to the play pause feature on any device. The 

pause button (two vertical bars) is depressed, the Visualizer stops laying out a Meta-

Network. When the play button is depressed (right pointed triangle) ORA Visualizer 

begins laying out the Meta-Network as described above. The red ellipse highlights on the 

tool bar where this feature is located and accessible. 

143.3 Magnifying / Maximizing 

 

The Magnifying Glass icon with the plus sign inside it, allows you to instantly fill the 

Visualizer window pane with the currently rendered Meta-Network. The red circle in the 

screen shot above highlights where to access this feature on the Visualizer tool bar. 

If there are any nodes off screen, clicking the button once will bring all the nodes into 

view on the screen. 

NOTE : This function works well when selecting a small part of your overall Meta-

Network and magnifying it to fill the visualizer screen. 
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143.4 Rotating The Visualization 

See also Rotating a Visualization  

 

To Rotate your visualization look for the word next to the Noon-pointing sundial icon in 

the tool bar. This feature is another way to manipulate your visualization to fill the entire 

visualizer window pane. 

NOTE : Use this feature in conjunction with the magnifying glass function to work your 

visualization into largest size possible. 

Show Labels 

See also Show/Hide Labels  

 

The Show Labels button allows you to toggle the labels on & off in the visualizer. 

Default is is ON. 

143.5 Show links 

 

The Show Links button allows you to toggle the links on & off in the visualizer. Default 

is is ON. 

143.6 Show Arrows 

 

The Show Arrows button allows you to toggle the arrows on & off in the visualizer and 

show directional data. Default is is OFF. 

143.7 Font Size 

 

The Font Size allows for setting the size of the font in the visualizer 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\tb\rotating\rotatingAVisualization.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\tb\labels\showLabels.html
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This allows you to change the size of the font to suit you needs for each individual 

visualizer set. It ranges from 4, which is almost unreadable, to extremely large numbers, 

which can also be unreadable by virtual of overcrowding. So pick the size of font that 

best suits your screen. 

143.8 Node Size 

 

The Node Size allows for changing the node size, larger or smaller by increments of one. 

Four is the smallest size possible and creates a very small, almost indisguishable dot. As 

the number increases is becomes easier to see the indivdual nodes until the number gets 

to a point where is can simply overpower the screen. But this gives you the ability to 

customize the entity size to suit your needs. 

 

143.9 Link Width 

 

The Link Width allows for changing the general width of the lin, larger or smaller. And 

as the options before you can pick the exact size which best suits your needs for the 

display. 
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143.10 Meta-Node Size 

See also Creating a Meta-Node  

 

Use the Meta Node Manager to handle creating and removing Meta-Nodes. 

143.11 Node Sizes 

 

The Toggle Node Size button rotates through three sizes for the nodes (as seen below). 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\menuTools\createMetaEntity\CreatingAMetaEntity.html
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143.12 Pointers 

 

The Visualizer uses two modes of pointers. 

The left pointer, Pan Image, controls the movement of the screen. Press and hold the 

mouse button and move the mouse to move the screen. 

The right pointer, Select Nodes, selects a group of nodes. Press and hold the mouse 

button. Moving the mouse selects nodes within the area scanned area. 

NOTE : Selecting a second set of nodes will De-Select the first set. 

NOTE : Dashed marquee used in example only. Not seen in actual program. 

 

143.13 Hide Links by Weight 

Hide Links by Weight  

 

Use the Hide Links with Weight to select which links to display. As long as there are 

links with different values you can hide links of smaller values leaving only the more 

important links visible. This can assist in seeing links that might normally be too 

cluttered to view. Below left is a Meta-Network with all links in view. Below right is the 

same Meta-Network with links less than 2.0 hidden. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\tb\links\linkWeights.html
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144 Zooming 

At the bottom of the Visualizer interface is a sliding zoom bar (image below).  

You can drag the scrollbar left (to zoom out) or right (to zoom in).  

 

In the screenshot below the zoombar has been set to the far left, the absolute zoom out 

possible. At this point very little is distinguishable. 
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In the next shot the zoombar has been placed almost to the far right, absolute zoom in. It 

allows for extreme closeups of various parts of the Meta-Network. 

 

Note : Clicking on the Magnifying glass in the Visualizer tool bar will set the view to 

include all visible nodes. 
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145 FOG — Fuzzy Overlapping Groups 

The ORA Visualizer can locate FOG Groups (Fuzzy Overlapping Groups) within your 

MetaMatrix. To access the ORA Compute Fog Groups you must first be working in the 

Visualizer. 

FOG indicates that nodes can belong to more than one groups in varying strengths and 

that there is a likelihood that those nodes will participate in events associated with the 

groups it is connected to.  

You will be presented with the normal visualizer display. 

Before you start it is a good idea to Show link Weights. This will assist you in seeing 

more clearly the strength of the connections from each node to each group. 

From the Visualizer menu select Option => Show link Weights 

From the Visualizer menu select Tools => Group Viewer 

 

After the Group Viewer appears select FOG form the drop-down menu. Then select the 

[Compute] button. 
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The display starts out with all agents connected to one single group. You'll notice that 

some links are weighted heavier than others. 

 

Under Select a number of groups to see: increase the number to 2 groups. For this 

example let's concentrate on ali_mohamed. At 2 groups he is connected to both of them. 

Thusly he still has contact with the entire network. His connection with the group on the 

left is stronger than his connection to the group on the right. 

 

Now let's increase the display to 3 groups. ali_mohamed is still connected to 2 groups but 

there is a third group he is not connected to. 
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After an increase to 4 groups you can see that ali_mohamed is still connected to bascially 

the same people as before but the grouping is again changed and ali_mohamed is 

connected to 3 of the 4 groups. You'll notice that the strength of the link to the group in 

the lower left is the strongest connection and he has no connection to the group in the 

lower right. 

 

Our final increase to 5 groups shows little change to the groups on the left but the groups 

that ali_mohamed are not connected to have split into 2 separate groups. 

 

By left-clicking on any node or group you bring up the Node Status dialog box from 

where you can retrieve information about it's attributes, measures, and neighbors. 
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145.1.1 IMPORTANT! 

 
After you run the the FOG Group viewer there are Node Sets and Graphs that are created 

in the Matrix. These will be displayed in any future work in the Visuzlizer. If you do not 

need them after you are done with the Group Viewer then don't forget to delete them. 

Deleting the Node Set for the FOG group will delete any associated Graph. 

 

 

146 MouseOvers 

When you pass the pointer over any Node int he visualizer a yellow tooltip box will 

appear showing information on links to other nodes as well as values for measures than 

have been run. 

Below is a screenshot comparing two mouseovers. 
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Attribute: If an attribute is empty ORA will leave a blank line for that attribute. Only 

if the attribute has a value will it be displayed. 

Neighbors: displays all the links to other nodes. 

The option to turn the mouseovers ON or OFF can be found on the menu at Options => 

Show Mouse Overs. The checkmark denotes whether or not the mouseovers are active. 
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147 Visualizer Patterns 

This is a list of common patterns that can make it easier to find various clusters as the 

underlying structure of your network.  

147.1 No 

Link

s 

 

147.2 2-

Grou

p 

 

147.3 Bow

tie 

 

147.4 Chai

n 

 

147.5 Circl

e 

 

147.6 Star 
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148 The ORA Visualizer 

The ORA Visualizer renders a Meta-Network graphically. It allows you to interact with 

your data in a variety of ways: remove key actors, isolate certain links, or focus on any 

particular relationship by using tools such as the Path Finder and grouping algorithms. 

Below is a visualized Meta-Network of the Stargate Summit/Last Stand dataset. In this 

view all nodes and links are visualized. 
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Most of the time it's easier to visualize the idividual networks. Below is the agent x event 

network. 

 

With the tools in the Visualizer you can pick the exact nodes and links you wish to 

visualize. 

149 Visualizer Contextual Menus 

Most of the functions you'll need in the Visualizer are accessible from ORA's in ORA's 

contextual menu by right-clicking on any of the entities inside a visualization.  

Below is an image of the contextual menu that appears when you right-click a node in the 

Visualizer:  
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Select Node 

Select Node highlights the selected node. Selecting a node a second time un-

highlights it.  

Hide Node 

Hide Node removes the selected node (along with all links) from view in the 

Visualizer. 

Center Node 

Brings the node to the center of the visualizer. 

Pin Node 

Works as a toggle in pinning and unpinning a node. While a node is pinned it is 

unaffected when the [Play] button is pressed or the user moves other nodes around the 

screen. Allows for the creation of a more understandable screen display. 

Expand Node 

Shows all nodes and links connected to the selected node. 

Set Picture 

Combine into Meta-Node 

Multiple nodes can be selected and combined into a Meta-Node which will contain 

links to all the nodes that the individual nodes had. The four large circles of SG-1 are 

selected. The and green circles show which tasks are associated with these agents. 

Press, and hold, the Control key while selecting each node for the Meta-Node. Then 

without releasing the Control key, right-click one of the nodes to bring up the 

contextual menu. Select Combine into Meta-Node. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\visualizer\tb\removeEntity\removeEntity.html
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After combining the task nodes that were linked to the individual nodes are now linked to 

the sg-1 Meta-Node. 

 

149.1.1 NOTE : If additions or deletions of NodeSets needs done 

expand the Meta-Node before proceeding. 

Add Comment 

 

Attaches a comment to the currently selected node. Good for making notes for display 

purposes. 
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Delete Selected Node(s) 

Allows for the deletion of nodes form a Meta-Network from within the Visualizer. 

 

149.1.2 NODE : This deletion is permanent once the Meta-Network is 

saved. If there is any question regarding the deletion then remove 

the Meta-Network from ORA before saving and reload the Meta-

Network. 

149.2 Pin SubMenu 

 

Pin All Nodes 

Globally pins all nodes. Nodes are unaffected by the [Play] button or the movement 

of other nodes. 

Unpin all Nodes 

Removed the pinning of all nodes. 

Pin Selected Node(s) 

If the selected node(s) is unpinned this makes the selected node immobile in the 

visualizer. 

Unpin Selected Node(s) 

If the selected node is pinned this makes the node mobile again and will be affected 

by the Play button. 
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149.3 URL SubMenu 

 

Attach URL 

Can attach a URL that is associated with the node. The first time this function is used 

it will create a new attribute in the NodeSet and give the node's attribute the value 

you typed in. 

Go To URL 

Will open up your default browser and go to the URL that is saved for the node 

selected. 
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150 Charts 

151 ORA Charts 
151.1 Charts 

Three charts are available: The Bar chart, Scatter Plot, Histogram, and Heat Map. ORA 

Charts can be accessed through the Main Interface by clicking the View Charts For This 

MetaNetwork button in the MetaMatrix Composer window pane or from the Main 

Interface drop down menu. 

From the Main Menu select Data Visualization => Charts; OR 

Select the [Charts] button. 

In the screen shot below, ellipses highlight both methods to access ORA Charts. 
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After choosing Reports, the following pop-up window will appear. Select the network 

you are interested in Charting and select the [Next] button. For this example, we will 

simply select the currently loaded network Agents. ORA produces the following Bar 

Chart, displayed in the screen shot below. 

 

By now, you should be able to access ORA Charts by loading a MetaNetwork by either 

using the [Charts] button in the MetaNetwork Composer window pane or from the Main 

Menu of the main interface. See Chart Types Explained for more detailed information 

about the four chart types. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\charts\chartTypesExplained\chartTypesExplained.html
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151.2 Chart Types Explained 

 

Below are examples of each type of ORA charts: Bar Chart, Scatter Plot, and Histogram. 

151.3 ORA Bar Chart 

A bar chart, also known as a bar graph, is a chart with rectangular bars of lengths usually 

proportional to the magnitudes or frequencies of what they represent. Bar charts are used 

for comparing two or more values. The bars can be horizontally or vertically oriented. 

Sometimes a stretched graphic is used instead of a solid bar. 
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151.4 Scatter Plot 

A scatterplot, scatter diagram or scatter graph is a chart that uses Cartesian coordinates to 

display values for two variables. The data is displayed as a collection of points, each 

having one coordinate on the horizontal axis and one on the vertical axis. 

A scatterplot does not specify dependent or independent variables. Either type of variable 

can be plotted on either axis. Scatterplots represent the association (not causation) 

between two variables. 

A scatterplot can show various kinds of relationships, including positive (rising), negative 

(falling), and no relationship. If the pattern of dots slopes from lower left to upper right, it 

suggests a positive correlation between the variables being studied. If the pattern of dots 

slopes from upper left to lower right, it suggests a negative correlation. A line of best fit 

can be drawn in order to study the correlation between the variables. An equation for the 

line of best fit can be computed using the method of linear regression. 
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151.5 Histogram 

The word histogram is derived from histos and gramma in Greek, the first meaning web 

or mast and the second meaning a drawing, record or writing. A histogram of something 

is thus, etymologically speaking, a drawing of the web of this something. 

In statistics, a histogram is a graphical display of tabulated frequencies. Moreover, a 

histogram is the graphical version of a table which shows what proportion of cases fall 

into each of several or many specified categories.  

The histogram differs from a bar chart in that it is the area of the bar that denotes the 

value, not the height, a crucial distinction when the categories are not of uniform width 

(Lancaster, 1974). The categories are usually specified as non-overlapping intervals of 

some variable. The categories (bars) must be adjacent. 
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152 Over-Time Viewer 

The Over-Time Viewer enables you to study changes within your organization or 

network over a time period. For instance, the overall centrality value of your network can 

be analyzed as it relates to network data compiled over the years, say, 2000, 2001, 2002. 

Please note that the time interval is dependent only on your data collection samples. Such 

an analysis can then be compared to external or internal events. 

As an example, let us say you are interested in learning how the events of September 11, 

2001 affected a terrorist organization or how the passing of anti-terrorism legislation 

impacted the same network. In either case, you can run measures in the Over Time 

Viewer on your network samples (loaded as multiple MetaNetworks) then compare the 

results against such external events. 

152.1.1.1 There are three lessons showing the functions of the 

Overtime Viewer. 

1. Lesson 5: Overtime Viewer 

2. Lesson 6: Immediate Impact 

3. Lesson 7: Near Term Impact Analysis 

153 Over-Time Viewer 

The Over-Time Viewer enables you to study changes within your organization or 

network over a time period. For instance, the overall centrality value of your network can 

be analyzed as it relates to network data compiled over the years, say, 2000, 2001, 2002. 

Please note that the time interval is dependent only on your data collection samples. Such 

an analysis can then be compared to external or internal events. 

As an example, let us say you are interested in learning how the events of September 11, 

2001 affected a terrorist organization or how the passing of anti-terrorism legislation 

impacted the same network. In either case, you can run measures in the Over Time 

Viewer on your network samples (loaded as multiple MetaNetworks) then compare the 

results against such external events. 

154  

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L5-OverTimeViewer\overTimeViewer.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L6-immediateImpact\immediateImpact.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L7-nearTermImpactAnalysis\nearTermImpactAnalysis.html
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155 Measures 

156 ORA Measures 

ORA contains well over 100 measures. A measure is a function that takes as input a 

Meta-Network and outputs a single value or a vector of values. Consider the measure 

Density. The output for this measure is a single number used to analyze an organization. 

By default, all measures are run on a Meta-Network. To view which measures are 

available, go to the Tools menu and select the Measures Manager. 

 

The Measures Manager dialog box will appear. A drop down box displays the measures 

in ORA. 
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The Measures Manager categorizes measures in the following ways: Entity Level, Graph 

Level, and Risk Category. 

An Entity Level Measure is one that is defined for, and gives a value for, each entity in a 

network. If there are x nodes in a network, then the metric is calculated x times, once 

each for each node. Examples are Degree Centrality, Betweenness, and Cognitive 

Demand. 

A Graph Level Measure is one that is defined for, and gives a value for, the network as a 

whole. The metric is calculated once for the network. Examples are Centralization, Graph 

Hierarchy, and the maximum or average Betweenness. 

Some reports use a predefined set of measures, and these are not affected by the Measure 

Manager selections (for example, the Intel, Context, Located SubGroups, Sphere of 

Influence, and Immediate Impact reports). The Risk Report, however, uses only the 

measures selected in the Measure Manager. 

The following sets of entities (with their abbreviated symbol) are used throughout the 

document: Agent (A), Knowledge (K), Resource (R), and Task (T). The following 

networks defined on these entity sets are used throughout the documentation. 

 

Symbol Entity Sets Name 

 U V   

AA Agent Agent Communication Network 

AK Agent Knowledge Knowledge Network 

AR Agent Resource Capabilities Network 

AT Agent Task Assignment Network 

KK Knowledge Knowledge Information Network 

KR Knowledge Resource Training Network 

KT Knowledge Task Knowledge Requirement Network 

RR Resource Resource Resource Substitute Network 

RT Resource Task Resource Requirement Network 

TT Task Task Precedence Network 

156.1 Input: 

This lists each of the Networks that are required as input to the measure. If a measure 

takes as input a specific network from the Meta-Network, such as the Agent x 

Knowledge (AK) matrix, then it is listed. If the measure runs on any square (unimodal) 

network then N is given. A measure can require more than one input matrix. 

a. Each input matrix can have one or more of the following requirements:  

i. square: the matrix must have the same number of rows as columns 
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ii. binary: it must be binary data (i.e. any lnks in the network are assumed to 

have a weight of one) 

iii. symmetric: the network must be undirected 

b. ORA does the following when a network does not meet one or more of the above 

requirements: 

i. square: measure is not computed 

ii. binary: measure is computed, and edge weights are ignored (all edges are 

given value one) 

iii. symmetric: measure is computed, and the matrix is first symmetrized 

using the union method 

A complete list of all measures available in ORA, along with references, input and output 

specifications, can be found in the following Ora Measures sections. 

157 Access Index: Knowledge and Resource 

The average shortest path length between entities, excluding infinite distances. 

The Boolean value is true if a particular agent is the only agent who knows a piece of 

knowledge and who is known by exactly one other agent. The one agent known also has 

its KAI set to one. 

Ashworth, 2003 

TYPE: Entity Level 

INPUT: 

Knowledge: AK: binary; AA: binary 

Resource: AR: binary; AA: binary 

OUTPUT: Binary 

The Knowledge Access Index (KAI) for agent i is defined as follows: 

let 

 

for Resource replace AK with AR 

Then 

 

for Resource replace KAI with RAI 
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158 Actual Workload, Knowledge and Resource Based 

The knowledge an agent uses to perform the tasks to which it is assigned. 

Carley, 2002 

TYPE: Entity Level 

INPUT:  

Knowledge: AK: binary; KT: binary; AT: binary 

Resource: AR: binary; RT: binary; AT: binary 

OUTPUT:  

Actual Workload for agent i is defined as follows: 

 

for Resource replace AK with AR and KT with RT 

Note how Potential Workload is the first matrix product. 

Measure: Average Distance 

The average shortest path length between entities, excluding infinite distances. 

TYPE: Agent Level 

INPUT: N: square, binary 

OUTPUT: Graph Level: 

 

Let G=(V,E) represent a square network. Define a set S of all pairs (i,j) of entities such 

that i can reach j. Then average the shortest paths. 

let S = {(i,j) | j is reachable in G from j } 

Then, 
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159 Boundary Spanner 

An entity which, if removed from a network, creates a new component. This is often 

called a Gate Keeper entity. 

High betweeness, low centrality. An employee with few direct connections, but if 

removed from the network will result in an unconnected sub-group. 

Cormen, Leiserson, Riverest, Stein, 2001 p.558 

TYPE: Agent Level 

INPUT: N: square, binary, symmetric 

OUTPUT: Entity level: Binary  

A Boundary Spanner is an articulation point of N, as defined in the referenced book. 

160 Boundary Spanner 

An entity which, if removed from a network, creates a new component. This is often 

called a Gate Keeper entity. 

High betweeness, low centrality. An employee with few direct connections, but if 

removed from the network will result in an unconnected sub-group. 

Cormen, Leiserson, Riverest, Stein, 2001 p.558 

TYPE: Agent Level 

INPUT: N: square, binary, symmetric 

OUTPUT: Entity level: Binary  

A Boundary Spanner is an articulation point of N, as defined in the referenced book. 

161 Boundary Measures 

Boundry Spanner :  

Boundry Spanner, Potential  
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162 Breath Column/Row 

This is the fraction of entities with column/row degree greater than one. 

TYPE: Entity Level 

INPUT: N: binary 

OUTPUT:  

Let d = the Column degree vector of the network N 

Then, the Column Breadth of N is: 

 

NOTE: Row breadth is identical, except that d is defined using the row degree, rather 

than the column degree. 

163 Capability 

This computes the number of connections for each entity. Then scales the value based on 

the variation from the average degree 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT:  

Let RD = the vector of row degrees for each entity in the network. Scale RD by dividing 

each element by the largest value in RD. 

Then the Capability of node i is: 

 

Note that for the most connected entity, this value tends to 1.0, for the least connected 

node it tends to 0, and for the average connected entity it tends to 0.5. 
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164 Centrality, Betweenness 

Betweenness tells us which node is the most connected to other parts of a network. For 

example, Betweenness can tell us which person in a network is the most central to the 

network as a whole. Betweenness measures the number of times that connections must 

pass through a single individual to be connected. 

This measure indicates the extent that an individual is a ―broker of indirect connections‖ 

among all others in network. One might say someone with high Betweenness is a 

gatekeeper of information flow. People that occur on many shortest paths among other 

People have highest Betweenness value. Betweenness is one of the key measures used by 

those interested in networks. 

Freeman, 1979 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT:  

Let G=(V,E) be the graph representation for the network. Let n=|V|, and fix an entity 

. 

For , let be the number of geodesics in G from u to w. 

If , then set . 

Define the following: 

let 

 

let  

Then Betweenness Centrality of the entity .  

Note: if G is not symmetric, then between is normalized by (n-1)(n-2). 
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165 Centrality, Bonacich Power 

The Bonacich Power Centrality computes the centrality of each entity based on the 

centrality of its neighbors. Beta should be chosen such that its absolute value is less than 

the reciprocal of the larges eigenvalue of N. 

Bonacich P, 1987 — Factoring and weighing approaches to clique identification, Journal 

of Mathematical Sociology, 2 (January, 1972), 113-120. 

TYPE: Entity Level 

INPUT: N: square 

 

OUTPUT:  

Let A = adjacency representation of the network N. Then Bonacich Power Centrality for 

the network is the solution c to the following system of linear equations: 

, where I is the identity matrix, and e a vector of ones. 

Note that if beta is 0, then c is simply equal to the row degree of each entity. 

The values of c are not normalized. 
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166 Centrality, Closeness 

Closeness reveals so-called people in the know. Closeness measures the path length from 

one person to another in a network. For example, it tells us which person is central to an 

organization. Moreover, Closeness reveals how long it takes information to spread from 

one individual to others in the network. High scoring individuals in Closeness have the 

shortest paths to all others in the network. It would follow such individuals could monitor 

the information flow in an organization better than most others that have a lesser 

Closeness value. The ones with the highest value in this measure will often times have 

the best picture of what is happening in the network as a whole. 

Freeman, 1979 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT:  

Let G=(V,E) be the graph representation of the square network. 

Fix 

 

let 

, if every entity is reachable from v. 

Then Closeness Centrality of entity 

. 

If some entity is not reachable from v then the Closeness Centrality of v is |V|. 
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167 Centrality, Eigenvector 

Eigenvector Centrality reflects one's connections to other well-connected people. A 

person connected to many isolated people in an organization will have a much lower 

score in this measure then those that are connected to people that have many connections 

themselves. This would be true even if such a WHO might have a high amount of actual 

connections (i.e. high degree centrality). 

It follows that a person well-connected to well-connected people can spread information 

much more quickly than one who only has connections to lesser important people in a 

network. People with higher scores of Eigenvector Centrality could be critical when rapid 

communication is needed. 

Bonacich P, 1972 

TYPE: Entity Level 

INPUT: N: square, symmetric 

OUTPUT:  

Calculates the eigenvector of the largest positive eigenvalue of the adjacency matrix 

representation of a square network. A Jacobi method is used to compute the eigenvalues 

and vectors. 
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168 Centrality, In Degree 

Degree Centrality measures how many other people are connected to a particular WHO 

we are interested in studying. For example, it can tell us how many people someone in an 

organization talks to based on their degree centrality value? Degree Centrality is one of 

the key measures used by those interested in networks. 

How you measure degree centrality depends on whether the network is symmetric (i.e. if 

A is connected to B is B connected to A?) and whether you want an answer that is 

normalized (i.e. to lie between 0 and 1 so that you can compare the degree centrality 

across networks of different size). 

Wasserman and Faust, 1994 

TYPE: Entity Level 

INPUT: N 

OUTPUT:  

Consider the matrix representation X of a network with m rows and n columns. Each 

column j is assigned an in-degree centrality based on the sum of entries in its column. 

The In-Degree Centrality for column j 

 

This measure is also called Column Degree Centrality. 
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169 Centrality, Information 

Calculates the Stephenson and Zelen information centrality measure for each entity. 

Information centrality is a network metric that accounts for indirec as well as shortest 

(geodesic) paths among entities. Information centrality is similar to betweenness, except 

that betweenness considers only shortest paths geodesics, whereas information centrality 

also considers more circuitous paths weighted by the inverse of the path length (the 

number of links along the path). Entities high in information centrality are more likely to 

get more information and to get information faster. 

Wasserman and Faust, 1994 (pg. 195) 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT: Entity Level: 

 

Calculates the measure described on pg 195-6 of Wasserman and Faust. Isolates (entities 

with no edges) are first removed from the network, and the measure computed on the 

resulting sub-graph. The isolates are given centrality value 0. 
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170 Centrality, Inverse Closeness 

The average closeness of a entity to the other entities in a network. Inverse Closeness is 

the sum of the inverse distances between an entity and all other entities. This is defined 

for directed networks. 

Wasserman and Faust, 1994 (pg 195) 

TYPE: Node Level 

INPUT: N: square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of the square network. 

Fix  

let 

 

if i is not reachable from v. 

Then, Inverse Closeness Centrality of entity v = dist/(|V|-1). 
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171 Centrality, Out Degree 

Degree Centrality measures how many other people are connected to a particular WHO 

we are interested in studying. For example, it can tell us how many people someone in an 

organization talks to based on their degree centrality value? Degree Centrality is one of 

the key measures used by those interested in networks. 

How you measure degree centrality depends on whether the network is symmetric (i.e. if 

A is connected to B is B connected to A) and whether you want an answer that is 

normalized (i.e. to lie between 0 and 1 so that you can compare the degree centrality 

across networks of different size). 

Wasserman and Faust, 1994 

TYPE: Entity Level 

INPUT: N: square 

OUTPUT:   (If N is binary) 

Consider the matrix representation X of a network with m rows and n columns. Each row 

i is assigned an out-degree centrality based on the sum of entries in its row. 

The Out-Degree Centrality 

 

This measure is also called Row Degree Centrality. 
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172 Centrality, Total Degree 

Degree Centrality tells us the relative number of direct connections a WHO might have in 

a network; the higher the score the more likely a WHO might be likely to receive and 

potentially pass on critical information that flows through the organization. 

Total Degree Centrality is one of the key measures of social network analysis and 

Dynamic Network Analysis. 

Wasserman and Faust, 1994 (pg 199) 

TYPE: Entity Level 

INPUT: N:square 

OUTPUT:  

Consider the matrix representation X of a square network with n entities. Each entity is 

assigned a value based on the sum of its row and columns. 

The Total Degree Centrality for 

 

Note that the diagonal values are ignored. 

Clique Count 

Computes the number of distinct cliques to which each entity in a square, undirected 

network belongs. 

Counts the number of sub-groups where the members are completely connected to each 

other. It is reflects sub-structures in the network that contribute to a cohesive whole. 

Wasserman and Faust, 1994 (pg 254) 

TYPE: Node Level 

INPUT: N:square, symmetric 

OUTPUT:  

A clique of an undirected, square network is defined in Wasserman and Faust as a 

maximal complete subgraph of three or more nodes. The clique detection algorithm 

employed is the Bron-Kerbosch maximal clique algorithm, which is Algorithm 457 of the 

Collected Algorithms from CACM. 
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173 Clustering Coefficient, Watts-Strogatz 

Measures the degree of clustering in a network by averaging the clustering coefficient of 

each entity. The clustering coefficient of a entity is the density of its ego network which 

is the sub graph induced by its immediate neighbors. 

Clustering Coefficient (graph level)  

Definition 

The average of the proportion of links between each employee and his or her direct 

neighbors divided by the number of links that could possibly exist between them. 

Interpretation 

The clustering coefficient gives a sense of the local characteristics of the network--

how information spreads by means of employee groups. A higher clustering 

coefficient supports local information diffusion as well as a decentralized 

infrastructure because employees are likely to share information and know what is 

happening in their work group. 

Watts and Strogatz, 1998 

TYPE: Graph Level, Entity Level 

INPUT: N: square, binary 

OUTPUT: 

Graph Level:  

Entity Level:  

let G=(V,E) be the graph representation of a square network. 

Define for each node its Clustering Coefficient :  

let Gv = ego network of entity v 

Then Clustering Coefficient for 

 

Then Clustering Coefficient for the> 
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174 Cognitive Demand 

Cognitive Demand measures the total amount of effort expended by each agent to do its 

tasks. Individuals who are high in cognitive demand value are emergent leaders. Removal 

of these individuals tends to be quite disruptive to networks.  

Note: The minimum input requirement is the AA network. All other networks are 

optional. 

Carley, 2002 

TYPE: Agent Level 

INPUT: AA:binary; [AT:binary]; [AR:binary]; [RT:binary]; [AK:binary]; [KT:binary]; 

[TT:binary] 

OUTPUT: Agent Level: 

 

The Cognitive Demand for an agent i is an average of terms, each of which measures an 

aspect of its cognitive demand. Each term is normalized to be in [0,1]. The number of 

terms depends on the input networks. The computation of each term for agent i is detailed 

below: 

let x1 = # of agents with which i interacts 

= sum(AA(i,:)) / (|A|-1) 

let x2 = # of tasks to which i is assigned 

= sum(AT(i,:)) / |T| 

let x3 = sum of the # of agents assigned to the same tasks as i  

= sum(ATA(i,:)-ATA(i,i)) / (|T|(|A|-1)), where ATA = AT*AT' 

let x4 = # of resources i manages 

= sum(AR(i,:)) / |R| 

let x5 = # of knowledge i manages 

= sum(AK(i,:)) / |K| 

let x6 = sum of # resources i needs for all its tasks 

= sum(ATR(i,:)) / (|T|*|R|), where ATR = AT*RT' 

let x7 = sum of # knowledge i needs for all its tasks 
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= sum(ATK(i,:)) / (|T|*|K|), where ATK = AT*KT' 

let x8 = sum of resource negotiation needs i has for its tasks 

= HammingDistance(AR(i,:), [AT*RT'](i,: )) / |R| 

let x9 = sum of knowledge negotiation needs i has for its tasks 

= HammingDistance(AK(i,:), [AT*KT'](i,: )) / |K| 

let x10 = sum of agents that i depends on or that depend on i 

let w = # number of agents assigned to each task 

= colsum(AT) 

let s = # agents that dependent on each task 

= (T+T')*w 

let v = # tasks that agents are dependent on  

= AT*s 

Then, x10 = v(i) / ( |A|*|T|*(|T|-1)). 

Then Cognitive Demand for agent i is the average of the above terms. 
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175 Cognitive Distinctiveness 
175.1 AKA: Cognitive Distinctiveness, Relative or Distinctiveness Correlation 

Measures how distinct are two agents based on the number of knowledge bits they hold 

oppositely. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits they have exactly 

opposite. Then normalize this sum by the total number of knowledge bits. In effect, this is 

the exclusive-OR of their knowledge vectors. 

 

Note that the CD output matrix is symmetric. 

Relative Cognitive Distinctiveness normalizes each element of CD as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 
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176 Cognitive Expertise 
176.1 AKA: Cognitive Expertise, Relative or Expertise Correlation 

Measures the complementarity of two agents based on their knowledge. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits that j knows that i 

does not know. Then normalize this sum by the total number of knowledge bits that agent 

i does not know. 

 

Note that the CD output matrix is NOT-symmetric. 

Relative Cognitive Expertise normalizes each element of CE as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 
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177 Cognitive Resemblance 
177.1 AKA: Cognitive Resemblance, Relative or Resemblance Correlation 

Measures the degree of resemblance between agents based on the number of knowledge 

bits they both have or both do not have. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits they have in common 

- whether known or unknown. Then normalize this sum by the total number of 

knowledge bits. 

 

Note that the CR output matrix is symmetric. 

Relative Cognitive Resemblance normalizes each element of CR as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 
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178 Cognitive Similarity 
178.1 Cognitive Similarity, Relative or Similarity Correlation 

Measures the degree of similarity between agents based on the number of knowledge bits 

they both have. 

Carley, 2002 

TYPE: Dyad Level 

INPUT: AK: binary 

OUTPUT:  

For each pair of agents (i,j) compute the number of knowledge bits they have in common. 

Then normalize this sum by the total knowledge between them. 

 

178.1.1.1 Note that the CS output matrix is symmetric. 

Relative Cognitive Similarity normalizes each element of CS as follows: 

 

Thus, the elements of the ith row are normalized by the ith row sum. 
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179 Communication 

Measures the degree of similarity between agents based on the number of knowledge bits 

they both have. 

Carley, 2003 

TYPE: Agent Level 

INPUT: AA:binary; AT:binary; AR:binary; RT:binary, TT:binary 

OUTPUT:  

Communication uses the concepts from Communication Congruence: 

Handoff, Co-Assignment, and Negotiation.  

let H, C, and N be defined as in Communication Congruence. 

let M(i,j) = [AA + (H+H') + C + (N+N')](i,j) > 0, and M(i,i) = 0 

Note that the transpose of H and N is used to make the communication reciprocal. 

let d = sum(M(i,:)) 

let d = d / (|A|-1), normalizing d to be in [0,1] 

Then Communication for agent i is d. 

180 Component Measures 

Component Count, Strong:  

Component Count, Weak:  

Component Memebers, Weak:  
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181 Component Count, Strong 

The number of strongly connected components in a network. 

Wasserman and Faust, 1994 (pg 109) 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Given a square, symmetric network G=(V,E), the Strong Component Count is the number 

of strongly connected components in G. This is computed directly on G, whether or not G 

is directed.  

182 Component Count, Weak 

The number of weakly connected components in a network. 

Wasserman and Faust, 1994 (pg 109) 

TYPE: Graph Level 

INPUT: N:square, binary, symmetric 

OUTPUT:  

Given a square, symmetric network G=(V,E), the Weak Component Count is the number 

of connected components in G. Such components are called weak because the graph G is 

undirected. 
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183 Component Members, Weak 

Assigns each entity an integer which corresponds to the weak component in the network 

to which it belongs. 

Wasserman and Faust,1994 

 

TYPE: Node Level 

INPUT: N:square, binary, symmetric 

OUTPUT:  

Given a square, symmetric network G=(V,E), the Weak Component Member for a entity 

is the weak component to which the entity belongs. The components are numbered from 

1 to the number of weak components (Weak Component Count). 

184 Congruence Measures 

Agent Knowledge Needs/Waste :  

Communication :  

Organization Agent Knowledge/Resource Needs :  

Organization Agent Knowledge/Resource Waste :  

Organization Task Knowledge/Resource Needs :  

Organization Task Knowledge/Resource Waste :  

Social Technical :  

Strict Knowledge :  

Task Knowledge Needs/Waste :  
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185 Congruence, Agent Knowledge Needs /  

Congruence, Agent Resource Needs 

The number of skills that an agent lacks to complete its assigned tasks expressed as a 

percentage of the total skills required for the assigned tasks. 

Lee, 2004 

TYPE: Agent Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

Agent Knowledge Needs compares the knowledge needs of the agent to do its assigned 

tasks, with the actual knowledge of the agent. 

Let N = AT*KT' = knowledge needed by agents to do assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge needed but not available. 

Then, Agent Knowledge Needs for 

 

Agent Resource Needs is analogous, replacing AK with AR, and KT with RT. 
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186 Congruence, Agent Knowledge Waste /  

Congruence, Agent Resource Waste 

The number of skills that an agent has that are not needed by any of its tasks expressed as 

a percentage of the total skills of the agent. 

Lee, 2004 

TYPE: Agent Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

Agent Knowledge Waste compares the knowledge of the agent with the knowledge it 

actually needs to do its tasks. Any unused knowledge is considered wasted. 

Let N = AT*KT' = knowledge needed by an agent to do its assigned tasks. 

for Resource replace KT with RT 

We need to sum the knowledge the agent has but which is not needed. 

Then, Agent Knowledge Waste for 

 

The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 



 

352 

 

187 Congruence, Communication 

Measures to what extent the agents communicate when and only when it is needful to 

complete tasks. Hence, higher congrunce occurs when agents don't communicate if the 

tasks don't require it, and do when the tasks require it. 

Communication needs to be reciprocal. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AA: binary, AT: binary, [AR/RT]: binary, [AK/KT]: binary, TT: binary 

OUTPUT:  

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both exist, then the 

measure first concatenates them into [AK AR], [KT RT] and uses them. 

Communication Congruence = 1 iif agents communicate when and only when it is 

needful to complete their tasks. There are three task related reasons when agents i and j 

need to communicate: 

(a) Handoff: if i is assigned to a task s and j is assigned to a task t and s directly precedes 

task t. 

(b) Co-Assignment: if i is assigned to a task s and j is also assigned to s. 

(c) Negotiation: if i is assigned to a task s and j is not, and there is a resource r to which 

agents assigned to s have no access but j does. 

The three cases are computed as follows: 

(a) let H = AT*TT*AT' 

(b) let C = AT*AT' 

(c) let N = AT*Z*AR', where Z(t,r) = [AT'*AR - RT'](t,r)<0 

Note that C is always symmetric, but not necessarily H and N. 

let Q(i,j) = [ (H+H') + C + (N+N')](i,j) > 0. 

Communication Congruence requires reciprocal communication, explaining the 

transposes of H and N to make them symmetric. 

let d = hamming distance between Q and AA, which measures the degree to which 

communication differs from that which is needed to do tasks. 

The maximum value for d is d_max = |A|*(|A|-1) 

Then Communication Congruence = 1 - (d /d_max), which is in [0,1]. 
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188 Congruence,  

Organization Agent Knowledge Needs /  

Organization Agent Resource Needs 

Across all agents, the skills that agents lack to do their assigned tasks expressed as a 

percentage of the total skills needed by all agents. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

As in Agent Needs, let N = AT*KT' 

for Resource replace KT with RT 

Then 

 

Organization Agent Resource Needs is analogous, replacing AK with AR, and KT with 

RT. 
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189 Congruence,  

Organization Agent Knowledge Waste /  

Organization Agent Resource Waste 

Across all agents, the skills that agents have that are not required to do their assigned 

tasks. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

As in Agent Waste, let N = AT*KT' 

for Resource replace KT with RT 

Then 

 

The equation for Organization Agent Resource Needs replaces AK with AR, and KT with 

RT. 
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190 Congruence,  

Organization Task Knowledge Needs / 

Organization Task Resource Needs 

Across all tasks, the skills that tasks lack expressed as a percentage of the total skills 

needed by all tasks. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

As in Task Needs, let S = AT'*AK 

for Respource replace AK with AR 

Then 

 

The equation for Organization Task Resource Needs replaces AK with AR, and KT with 

RT. 
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191 Congruence 

Organization Task Knowledge Waste / 

Organization Task Resource Waste 

Across all tasks, the skills supplied to tasks via agents that are not required by them, 

expressed as a percentage of the total skills needed by all tasks. 

Lee, 2004 

TYPE: Graph Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT: Graph Level: 

 

As in Task Waste, let S = AT'*AK 

for Resource replace AK with AR 

Then 

 

The equation for Organization Task Resource Waste replaces AK with AR, and KT with 

RT. 
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192 Congruence, Social Technical 

Social technical congruence represents the proportion of coordination requirements that 

were satisfied through some type of actual coordination activity carried out through some 

means of communication.p>  

Cataldo et al, 2006 

TYPE: Task Level 

INPUT: AT, TT, AA 

OUTPUT: Real Number in [0,1] 

 

A representation of the coordination requirements among the different workers is 

obtained by multiplying AT, TT and transpose of AT matrices. This product results in a 

people by people matrix where a cell ij indicates the extent to which person i works on 

tasks that share dependencies with the tasks worked on by person j. In other words, the 

resulting matrix represents the Coordination Requirements or the extent to which each 

pair of people needs to coordinate their work. Formally, the Coordination Requirements 

(CR) matrix is determined by the following product: 

Let, CR = AT * TT * transpose(AT) 

Given a particular CR matrix constructed from relating product dependencies to work 

dependencies, we can compare it to an Actual Coordination (CA) matrix that represents 

the interactions workers engaged in through different means of coordination. 

Diff (CR, CA) = card { diffij | crij > 0 & caij > 0 } 

|CR| = card { crij > 0 } 

We have, 

Congruence(CR, CA) = Diff (CR, CA) / |CR| 
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193 Congruence,  

Strict Knowledge/Strict Resource 

Measures the similarity between what knowledge is assigned to tasks via agents, and 

what knowledge is required to do tasks. Perfect congruence occurs when agents have 

knowledge when and only when (strictly) it is needful to complete tasks. 

Carley, 2002 

TYPE: Graph Level 

INPUT:  

Knowledge: AK:binary; AT:binary; KT:binary 

Resource: AR:binary; AT:binary; RT:binary 

OUTPUT:  

Knowledge Congruence = 1 iff agents have knowledge when and only when it is needful 

to complete their tasks. Thus, we compute the knowledge assigned to tasks via agents, 

and compare it with the knowledge needed for tasks.  

let KAT = dich(AK'*AT) 

for Resource KAT becomes RAT and replace AK with AR 

let 

 

for Resource replace KT with RT 

let <d = d / (|K|*|T|), which normalizes d to be in [0,1] 

for Resource replace |K| with |R| 

Then Knowledge Congruence = 1 - d 
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194 Congruence, Task Knowledge Needs / 

Congruence, Task Resource Needs 

The number of skills not supplied to a task, and required to do the task, expressed as a 

percentage of the total skills required for the task. 

Carley, 2002 

TYPE: Task Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT:  

 

Task Knowledge Needs compares the knowledge requirements of each task with the 

knowledge available to the task via agents assigned to it. It is similar to Knowledge 

Congruence, but quantifies only the under supply of knowledge to tasks. 

Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge required but not supplied. 

Thus, 

 

The equation for Agent Resource Needs replaces AK with AR, and KT with RT. 
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195 Congruence, Task Knowledge Waste / 

Congruence, Task Resource Waste 

The number of skills supplied to a task via agents that are not required by it expressed as 

a percentage of the total skills required for the task. 

Carley, 2002 

TYPE: Task Level 

INPUT: AK/AR:binary; KT/RT:binary; AT:binary 

OUTPUT: Task Level: 

 

Task Knowledge Waste compares the knowledge requirements of each task with the 

knowledge available to the task via agents assigned to it. It is similar to Knowledge 

Congruence, but quantifies only the over supply of knowledge to tasks. 

Let S = AT'*AK = knowledge supplied to tasks via assigned agents 

We need to sum the knowledge supplied but not required. 

Thus, 

 

The equation for Agent Resource Waste replaces AK with AR, and KT with RT. 



 

361 

 

196 Connectedness, Krackhardt 

Measures the degree to which a square network's underlying (undirected) network is 

connected. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N:square, symmetric 

OUTPUT:  

The Connectedness of a square, symmetric network is the Density of its Reachability 

Network. 

197 Constraint, Burt 

The degree to which each entity in a square network is constrained from acting because 

of its existing links to other entities. 

Burt, 1992 

TYPE: Node Level 

INPUT: N: square 

OUTPUT:  

This is the Constraint measure described by Equ. 2.4 on pg. 55 of Burt, 1992. Note that 

the matrix Z is the adjacency matrix representation of the network N. 
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198 Density 

The ratio of the number of edges versus the maximum possible edges for a network. 

Density compares existing links to all possible links in the employee communication 

network. It reflects the social level of organizational cohesion. This measure must be 

interpreted in relation to the size of the group and the type of work performed. 

Wasserman and Faust, 1994 (pg 101) 

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let M be the adjacency matrix for the network of dimension m x n. 

If the network is unimodal, then m=n and M has a zero diagonal, and therefore 

Density = sum(M)/(m*(m-1)). 

For rectangular networks, Density = sum(M)/(m*n). 

199 Diameter 

The maximum shortest path length between any two nodes in a unimodal network 

G=(V,E). If there exist i,j in V such that j is not reachable from i, then the diameter is 

returned as |V|. 

Wasserman and Faust, 1994 (pg 111) 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

The diameter of G=(V,E) is defined as: 

 

That is, the maximum shortest directed path between any two vertices in G. If there exists 

i and j such that j is not reachable from i, then |V| is returned. 
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200 Diversity, Knowledge/Resource 

The distribution of difference in idea sharing. This is the Herfindahl-Hirshman index 

applied to column sums of AK. 

Characterizes the network in terms of how the items in a knowledge or resource network 

(who knows what) are non-uniformly distributed across employees 

Borgatti, 2003 

TYPE: Graph Level 

INPUT:  

Knowledge: AK:binary 

Resource: AR:binary 

OUTPUT:  

This is the Herfindahl-Hirshman index (economics: sum of the squares of each firm's 

market share) applied to the normalized column sums of AK. This measures the degree to 

which knowledge is equally known. 

let 

 

let 

 

Then 

 

Resource Diversity is analogous, replacing AK with AR. 
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201 Edge Count, Lateral 

Fixing a root entity x, a lateral edge (i,j) is one in which the distance from x to i is the 

same as the distance from x to j. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) be the graph representation of a network. And fix an entity x {element of} 

V to be the root entity. 

Let 

 

Then Lateral Edge Count = |S| / |E| 

202 Edge Count, Pooled 

A pooled edge in a network N=(V,E) is an edge (i,j){element of} E such that there exists 

at least one other edge (i,k) {element of} E, and k ≠ j. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let M be the adjacency matrix representation of a unimodal network. 

Let S = { (i,j) | M(i,j)=1 ∧ sum(M(:,j))>1 } 

In other words: edge (i,j) is a pooled edge iff the in-degree of entity j > 1. 

Then Pooled Edge Count = |S| / |E| 
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203 Edge Count, Reciprocal 

The percentage of edges in a network that are reciprocated (also called Reciprocity). An 

edge (i,j) in the network is reciprocated if edge (j,i) is also in the network. Self-loops are 

ignored. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of a network. 

Let S=card{(i,j) {element of} E|i<,(j,i) {element of} E} 

Then Reciprocral Edge Count = |S| / |E| 

204 Edge Count, Sequential 

The percentage of edges in a network that are neither Reciprocal Edges nor Pooled 

Edges. Note that an edge can be both a Pooled and a Reciprocal edge. Self-loops are 

ignored. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of a network, and let X = set of Pooled edges of 

G, and let Y = set of Reciprocal edges of G. 

Then Sequential Edge Count = | E-X-Y| / |E| 
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205 Edge Count, Skip 

The fraction of edges in a unimodal network that skip levels. An edge (i,j) is a skip edge 

if there is a path from entity i to entity j even after the edge (i,j) is removed. 

Carley, 2002 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT:  

A skip edge in a network G=(V,E) is an edge (i,j)∈E such that j is reachable from i in the 

graph G'=(V,E\(i,j)), that is, the graph G with edge (i,j) removed. Skip Count is simply 

the number of such edges in G normalized to be in [0,1] by dividing by |E|.  

206 Effective Network Size 

The effective size of an entities's communication Network based on redundancy of ties. 

Burt, 1992 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT:  

This is the Effective Size of Network measure described by Equ. 2.2 on pg. 52 of Burt, 

1992. Note that the Communciation Network is used for the matrix Z.  
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207 Efficiency, Global 

Measures the closeness of the entities in the network. 

Latora and Marchiori, 2001 

TYPE: Graph Level 

INPUT: N:square, binary, symmetric 

OUTPUT:  

Global Efficiency is the normalized sum of the inverse geodesic distances between all 

entity pairs. Let G be a square network on n entities. 

Then, 
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208 Efficiency, Krackhardt 

The degree to which each component in a network contains the minimum edges possible 

to keep it connected. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Let G=(V,E) be the graph representation of a square, undirected network. 

let 

 

let 

 

let 

 

let 

 

Then Efficiency = 1 - penalty/maxPenalty 
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209 Efficiency, Local 

Measures the closeness of the entities in each ego network in the network. 

Latora and Marchiori, 2001 

TYPE: Graph Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Local Efficiency is the normalized sum of the inverse closeness of the ego networks 

(here, the ego network for entity i does not include entity i). 

Let G = (V,E) be any square, symmetric network with |V| = N entities. 

let 

 

let 

 

to 

 

define 

 

Then, 
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210 Entity Level 

The Entity Level for a entity v in a square network is the worst case shortest path from v 

to every entity v can reach. 

Carley, 2002 

TYPE: Entity Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) be the graph representation of a square network and fix an entity v. 

Entity Level if v 

cannot reach any entities, then its level is 0.  

211 Exclusivity Complete 

Detects entities that have unique connections to other entities. 

Ashworth, 2003 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT:  

This is a variation of the Exclusivity measure that weights the edges of an entity as 

follows: if no other entity has a connection to the entity, then its weight is one, otherwise 

it is zero. 

Thus, the Complete Exclusivity value for node i is: 

 

The value is then normalized by dividing by |K|. 
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212 Exclusivity — 

Knowledge, Resource, Task 

Resource Exclusivity measures the extent that a WHO has connections that are unique in 

a network especially to network resources. It can reveal to the network analyst critical 

vulnerabilities (or strengths) depending on what the analyst is looking for. An example of 

this measure would be if a key resource that supports an entire organization is only 

accessible through one person. That person would have a high resource exclusivity 

value./p>  

Ashworth, 2003 

TYPE: Entity Level 

INPUT:  

Knowledge: AK:binary 

Exclusivity run on the AK matrix 

Resource: AR:binary 

Exclusivity run on the AR matrix 

Task: AT:binary 

Exclusivity run on the AT matrix 

OUTPUT:  

The Knowledge Exclusivity Index (KEI) for agent i is defined as follows: 

Resource Exclusivity Index (REI) or Task Exclusivity Index (TEI) 

 

for Resource replace AK with AR 

for Tasks replace AK with AT 

The Resource Exclusivity Index (REI) for agent i is defined exactly as for Knowledge 

Based Exclusivity, but with the matrix AK replace by AR. 
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The Task Exclusivity Index (TEI) for agent i is defined exactly as for Knowledge Based 

Exclusivity, but with the matrix AK replaced by AT. 

213 Fragmentation 

The proportion of entities in a network that are disconnected. 

Borgatti, 2003 

TYPE: Graph Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Consider a square, symmetric network G=(V,E). 

let 

 

let 

 

Then, 

 

214 Hierarchy, Krackhardt 

The degree to which a square network N exhibits a pure hierarchical structure. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  
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Let N be a square network. The Hierarchy of N is the Reciprocity of the Reachability 

Network for N. 
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215 Interdependence and Radials 

The percentage of edges in a network N that are Pooled and Reciprocal. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) be the graph representation of a square network. 

Let a = Pooled Edge Count and b = Reciprocal Edge Count of the network. 

Then Interdependence = (a+b)/|E| 

Interlockers and Radials 

Interlockers and radial entities in a square network have a high and low Triad Count, 

respectively. 

Carley, 2002 

TYPE: Entity Level 

INPUT: N: square, binary 

OUTPUT: Binary 

Let N=(V,E) be a square network. 

Let 

= Triad Count for node i,  

Let 

= the mean of  

Let 
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= the variance of  

Then, 

if , then agent k is an interlocker. 

If , then agent k is a radial. 
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216 Load, Knowledge or Resource 

Average number of knowledge or resource per agent. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK:binary 

OUTPUT:  

Knowledge Load = sum(AK)/ (|A|) 

Resource Load is defined analogously, replacing AK with AR. 
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217 Negotiation, Knowledge or Resource 

The extent to which personnel need to negotiate with each other because they lack the 

knowledge to do the tasks to which they are assigned. 

Carley, 2002 

TYPE: Graph Level 

INPUT:  

Knowledge: AT:binary; AK:binary; KT:binary 

Resource: AT:binary; AR:binary; RT:binary 

OUTPUT:  

Compute the percentage of tasks that lack at least one knowledge (or Resource): 

let 

 

for Resource replace AK with AR and KT with RT 

let 

 

Then Knowledge (or Resource) Negotiation = |S| / |T| 
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218 Network Centralization, Betweenness 

Network centralization based on the betweenness score for each entity in a square 

network. This measure is defined for symmetric and non-symmetric networks. 

Freeman, 1979 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let G=(V,E) represent the square network, and let n = |V| 

let 

 

let 

 

Then 
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219 Network Centralization, Closeness 

Network centralization based on the closeness centrality of each entity in a square 

network. This is not defined only for unconnected or directed networks. 

Freeman, 1979 

TYPE: Graph Level 

INPUT: N:square, symmetric, connected 

OUTPUT: (if N connected) 

Let G=(V,E) represent the square network, and let n = |V| 

let 

 

let 

 

Then 
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220 Network Centralization, Column Degree 

A centralization based on the out degree of the column vertices in a network N.  

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let N be a network with n column entities. 

let 

 

let 

 

Then 
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221 Network Centralization, In Degree 

A centralization of a square network based on the In-Degree Centrality of each entity. 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 

 

where D = (n-2) if N is undirected, and (n-1) otherwise. 
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222 Network Centralization, In Degree 

A centralization of a square network based on the In-Degree Centrality of each entity. 

TYPE: Graph Level 

INPUT: N:square 

OUTPUT:  

Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 

 

where D = (n-2) if N is undirected, and (n-1) otherwise. 
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223 Network Centralization, Row Degree 

A centralization based on the out degree of the row vertices in a network N. 

TYPE: Graph Level 

INPUT: N 

OUTPUT:  

Let N be a network with n row nodes. 

let 

 

let 

 

Then 
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224 Network Centralization, Total Degree 

A centralization of a square network based on total degree centrality of each entity. 

Freeman, 1979 

TYPE: Graph Level 

INPUT: N: square, symmetric 

OUTPUT:  

Let N be a unimodal network with n entities. 

let 

 

let 

 

Then 
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225 Network Levels 

An entity level metric is one that is defined for, and gives a value for, each entity in a 

network. If there are x entities in a network, then the metric is calculated x times, once 

each for each entity. Examples are Degree Centrality, Betweeness, and Cognitive 

Demand. 

A network level metric is one that is defined for, and gives a value for, the network as a 

whole. The metric is calculated once for the network. Examples are Centralization, Graph 

Hierarchy, and the maximum or average Betweeness. 

Given an entity level metric, e.g., degree centrality, then the minimum, maximum, 

average, and standard deviation of that metric for that network level metrics. Examples 

are average degree centrality, maximum betweeness, and the standard deviation in 

cognitive demand. 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Let G=(V,E) be the graph representation of a square network and fix an entity v. 

Then 
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226 Omega, Knowledge or Resource 

The degree to which an organization reuses knowledge or resource. 

Carley, Dekker, and Krackhardt 2000 

TYPE: Graph Level 

INPUT:  

Knowledge: AT:binary; KT:binary; TT:binary 

Resource: AR:binary; RT:binary; TT:binary 

OUTPUT:  

Let TAT = TA*TA' 

Let N = ((T'@TAT)*KT')@KT' 

for resource replace KT with RT 

Then Knowledge Based Omega = sum(N)/sum(KT) 

for resource replace KT with RT 
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227 Performance as Accuracy 

Performance as Accuracy measures how accurately one can perform an assigned task 

based on one?s access to existing knowledge and resources in the network. Think of how 

this might be important to a person in a business organization? 

Given a complicated task, this measure reveals who is best equipped to perform such a 

task. Performance as Accuracy is yet another key measure in the arsenal of the dynamic 

network analyst. 

Carley, 2002 

TYPE: Graph Level 

INPUT:  

AT: binary; [AK/KT]: binary; [AR/RT]: binary 

OUTPUT:  

One of the following pairs of matrices must exist: AK/KT, AR/RT. If both exist, then the 

measure first concatenates them into [AK AR], [KT RT] and uses them. 

Accuracy is computed based on the binary classification problem. It is computed in one 

of two ways: 

(1) Knowledge based: Let b be a binary string of length |K|, let N=KT', and let S=AK. Fix 

a task t. 

let 

 

which is the correct classification of b with respect to task t. 

Now, let I={ i | AT(i,t)=1}. 

let 

 

This is agent i's classification of b with respect to t. 
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The group of agents classify b using majority voting. 

That is, 

 

Then, if group_answer = answer, then the group was accurate, otherwise not. 

This is repeated multiple times for each task, and across all tasks. The percentage correct 

is Performance as Accuracy. 

(2) Resource based: let N=RT' and S=AR in the analysis of case (1). 
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228 Personnel Cost 

Total number of people reporting to an agent, plus its total knowledge, resources, and 

tasks. 

Carley, 2003 

TYPE: Agent Level 

INPUT: AA:binary; AK:binary; AR:binary; AT:binary 

OUTPUT:  

Personnel Cost is the sum of the in-degree centrality of all AA matrices in the graph (this 

computes the number of agents reporting to each agent), plus the out-degree centrality of 

any AK, AR, and AT graphs. 

This sum is scaled so that each entity gets a score in [0,1]. 

229 Potential Workload — Knowledge or Resource 

Maximum knowledge or resource an agent could use to do tasks if it were assigned to all 

tasks. 

Carley, 2002 

TYPE: Entity Level 

INPUT:  

Knowledge: AK:binary; KT:binary 

Resource: AR:binary; RT:binary 

OUTPUT:  

Potential Knowledge Workload for agent i = sum((AK*KT)(i,:))/sum(KT) 

for Resource replace AK with AR and KT with RT  
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Redundancy, Access 

Average number of redundant agents per resource. An agent is redundant if there is 

already an agent that has access to the resource. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AR:binary  

OUTPUT:  

This is the Column Redundancy of matrix AR. 

230 Redundancy, Assignment 

Average number of redundant agents assigned to tasks. An agent is redundant if there is 

already an agent assigned to the task. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AT 

OUTPUT:  

This is the Column Redundancy of matrix AT. 
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231 Redundancy, Column 

The mean number of column node edges in excess of one. 

TYPE: Graph Level 

INPUT: N of dimension m x n 

OUTPUT:  

Let M be the matrix representation for a network N of dimension m x n. 

let 

 

for 

 

this is the number of column entries in excess of one for column j. 

Then 

 

232 Redundancy, Knowledge 

Average number of redundant agents per knowledge. An agent is redundant if there is 

already an agent that has the knowledge. 

The number of individual employees with the same knowledge. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK: Binary 

OUTPUT:  

This is the Column Redundancy of matrix AK. 
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233 Redundancy, Resource 

Average number of redundant resources assigned to tasks. A resource is redundant if 

there is already a resource assigned to the task. 

The number of individual employees with access to the same resource. 

Carley, 2002 

TYPE: Graph Level 

INPUT: RT:binary 

OUTPUT:  

This is the Column Redundancy of matrix RT. 

234 Redundancy, Row 

The mean number of row entity edges in excess of one. 

TYPE: Graph Level 

INPUT: N of dimension m x n 

OUTPUT:   for N dimension m x n 

Let M be the matrix representation for a network N of dimension m x n. 

let 

 

for 

 

this is the number of column entries in excess of one for row i. 

Then 

235 
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Shared Situation Awareness 

The similarity of actor pairs based on social interaction, physical distance, and socio-

demographic data. 

Graham, 2005 

TYPE: Agent Level | Dyad Level 

INPUT:  

 AA: interaction/communication 

 AA: physical proximity 

 AA: socio demographic similarity 

OUTPUT:  

 Agent Level:  

 Dyad Level:  

SSA consists of weighted terms of interaction between actions. 

Let 

 

Let A = Agent x Agent interaction/communication matrix 

Let P = Agent x Agent physical proximity matrix 

Let S = Agent x Agent social demographic similarity matrix 

Let e = eigenvector centrality measure computed on A 

Let G = dyadic geodesics computed on A 

Then the SSA measure between agents i and j is: 
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236 Simmelian Ties 

Computes the normalized number of entities to which each node has a Simmelian tie. 

Krackhardt, 1998 

TYPE: Entity Level 

INPUT: N: square, binary, symmetric 

OUTPUT:  

Let N be a square network with n entities. The Simmelian Tie value for entity i is 

computed as follows: 

let NS = network N symmetrized using the Intersect (Minimum) method. 

All cliques of size >= 3 are computed on NS and clique membership is recorded. Let 

be the number of entities that are in a clique with entity i. 

Then the Simmelian Ties value for emtity i is . 

237 Socio Economic Power 

A measure of actor power based on access to knowledge, resources, and tasks in the 

organization. 

TYPE: Agent Level 

INPUT: 

AK: binary 

AR: binary 

AT: binary 

OUTPUT:  

Let N = [AK AR AT], that is, the concatenation of the input matrices. 

Then, Agent Socio Economic Power is the row degree centrality of N. 
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238 Span of Control 

The average number of out edges per node with non-zero out degrees. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  

let S = set of entities in V that have positive out-degree 

let 

 

Then 

  

239 Speed, Average 

The average inverse geodesic distance between all entity pairs. The highest score is 

achieved for a clique, and the lowest for all isolates. 

Average shortest communication path length between pairs of individuals; gauges how 

quickly a message will move throughout the network. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Average Speed is the average of the Inverse Closeness Centrality for the network entities. 
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240 Speed, Minimum 

The maximum shortest path length between entity pairs (i,j) where there is a path in the 

network from i to j. If there are no such pairs, then Minimum Speed is zero. 

Carley, 2002 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Minimum Speed = 1 / (Levels for the Network) 

241 Task Completion — 

Knowledge / Resource / Overall 

The percentage of tasks that can be completed by the agents assigned to them, based 

solely on whether the agents have the requisite knowledge or resources to do the tasks. 

Task Completion Overall is a combination of the Task Completion Knowledge and the 

Task Completion Resource. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK:binary; AT:binary; KT:binary 

OUTPUT:  

Find the tasks that cannot be completed because the agents assigned to the tasks lack 

necessary knowledge. 

let 

 

let 
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Knowledge Based Task Completion is the percentage of tasks that could be completed = 

(|T|-|S|) / |T| 

Resource Based Task Completion is analogous, replacing AK with AR and KT with RT. 
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242 Transitivity 

The percentage of edge pairs {(i,j), (j,k)} in the network such that (i,k) is also an edge in 

the network. 

The percentage of pairs in the employee communication network where employee A is 

linked to B and B is linked to C and C is also linked to A 

TYPE: Graph Level 

INPUT: N:square, binary 

OUTPUT:  

Let G = (V,E) be the graph representation of the square network. 

let 

 

let 

 

let 

 

Then 
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243 Triad Count 

The number of triads centered at each entity in a square network. 

TYPE: Agent Level 

INPUT: N:square, binary 

OUTPUT:   for N dimension n. 

Let G=(V,E) represent a square network with n entities. 

And let Triad be a matrix of dimension n x n. 

 

Then 

 

244 Under Supply — 

Knowledge / Resource 

The extent to which the knowledge/Resource needed to do tasks are unavailable in the 

entire organization. 

Carley, 2002 

TYPE: Graph Level 

INPUT: AK:binary; AT:binary; KT:binary 

OUTPUT:  

This is the number of required knowledge not available to tasks based on the current 

agent task assignments normalized by the number of tasks. 

Knowledge Under Supply = sum(dich( KT - AK'*KT)) / |T| 

Under Resource Supply is analogous, replacing AK with AR, and KT with RT. 
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245 Upper Boundedness, Krackhardt 

The degree to which pairs of agents have a common ancestor. 

Krackhardt, 1994 

TYPE: Graph Level 

INPUT: N: square, binary 

OUTPUT:  
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246 Reports 

247 Belief Report 

Below are procedures to run a Belief Report in ORA.  

We set up an Excel spreadsheet with agents and the levels for each of the beliefs. Beliefs 

are strange as they can be either positive or negative. Two people share a belief only is 

both have a positive response or both have a negative response. 

From Excel, or other program you're using, save your data in the .csv format. 

 

From the main menu select File => Data Import Wizard. 

Click the [Select] button to call up the open dialog box. Navigate to the directory where 

you have saved your .csv file. 
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Make sure the Create a New Matrix radio button is selected. Leave Choose a source node 

set set to agent. In the Choose a target node set click the down arrow to bring up the drop 

down menu. Highlight the <new type> option. Then select the Next button at the bottom 

of the box. 

 

Type in belief into the textbox. 

 



 

403 

 

You can enter a new name in Enter a unique graph name or leave is as Agent x belief. 

When you're done, select the [Finish] button. 

 

A new Network appears in Panel 1 with two Entites and one graph. The values from the 

Editor reflect the original numbers from the Excel spreadsheet. 

 



 

404 

 

 

Now you're ready to create a beliefs report. 

From the main menu select Analysis => Generate Reports. 

1. In the Select Report textbox, select Beliefs. 

2. In the Select one or more meta matrices: place a checkmark in the Networks you 

want to run the report on. 

3. In the Select the report formats to create: place a checkmark in all the formats you 

want the final report to appear in. Here we are doing only Text (which will appear 

in panel 3 in the main interface) and HTML (which will create an HTML 

document that will open up in your browser. 

4. In the Enter a filename section you can either type in a filepath or use the 

[Browse] button to navigate to a directory to save your files. 

When you're finished select the [Next-->] button. 
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Select the Number of ranked nodes and critical attribute (if any). Then select the [Finish] 

button. 

 

The Belief Report now appears in panel 3. If you selected HTML you will also see the 

report appear in your browser. 
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247.1 BELIEFS REPORT 

Input data: Meta Matrix 

Start time: Wed Jul 25 21:24:34 2007  

Given one or more belief networks, this analyzes the most strongly held beliefs, the most 

opinionated individuals and other characteristics of the belief networks. 

The beliefs node set must have the id equal to 'belief'. There can be multiple graphs based 

on this belief node set, for example, Agent x Belief and Organization x Belief. 
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247.2 Analysis for the belief network: Agent x belief 

247.2.1 Most Common Beliefs 

Top 10 beliefs that are shared by the most people. 

Belief Value Number of believers 

Israel_is_a_state Negative 2 

There_exists_a_Palestine_two_state_solution Negative 2 

Hamas_should_PNA_elections Negative 2 

Hamas_is_a_terrorist_organization Negative 3 

Oslo_Accords_is_a_peace_solution Negative 3 

Hamas_should_disarm Negative 3 

Israel_should_Occupy_Palestine Negative 3 

AB Positive 4 

Hamas_is_a_terrorist_organization Positive 4 

Hamas_should_government Negative 4 

247.2.2 Most Contentious Beliefs 

Top 10 beliefs that are most disagreed upon across individuals. This is based on the GINI 

coefficient of the belief vector. 

  

Belief Gini coefficient 

AB 0.686667 

Hamas_should_government 0.622222 

Hamas_is_a_terrorist_organization 0.5625 

Israel_should_Occupy_Palestine 0.5625 

Oslo_Accords_is_a_peace_solution 0.456338 

There_exists_a_Palestine_two_state_solution 0.454795 

Hamas_should_PNA_elections 0.454795 

Israel_should_Destruction 0.430818 

Israel_is_a_state 0.37973 

Hamas_should_disarm 0.270992 

247.2.3  
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247.2.4 Most Strongly Held Beliefs 

Top 10 beliefs that are the most strongly held. This is the average absolute value of the 

belief vector. 

  

Belief Score 

Hamas_should_government 1.6 

AB 1.5 

Hamas_is_a_terrorist_organization 1.2 

Israel_should_Occupy_Palestine 1.2 

Israel_should_Destruction 0.97 

There_exists_a_Palestine_two_state_solution 0.86 

Hamas_should_PNA_elections 0.86 

Oslo_Accords_is_a_peace_solution 0.84 

Israel_is_a_state 0.78 

Hamas_should_disarm 0.47 

247.2.5 Most Likely to Change Beliefs 

Top 10 individuals most likely to change beliefs. This is based on the entropy of each 

individual's belief vector. 

  

Belief Entropy 

unknown-2 0 

President George Bush 1 

Condoleezza Rice 1.469 

Ismail Haniya 1.65992 

Bashar Al-Assad 2 

Ehud Olmert 2.16578 

Mahmud Abbas 2.19092 

Khalid Mish?a 2.87598 

Former President Carter 4.14443 

unknown-1 4.2961 
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247.2.6 Most Opinionated Individuals 

Top 10 individuals that have the highest absolute sum of beliefs. 

  

Agent Total beliefs 

unknown-2 49.8 

President George Bush 9.5 

Bashar Al-Assad 9 

Condoleezza Rice 8.6 

Mahmud Abbas 8.6 

Former President Carter 5.2 

Khalid Mish?a 4.9 

unknown-1 3.2 

Ismail Haniya 2.4 

Ehud Olmert 1.6 

247.2.7 Most Neutral Individuals 

Top 10 individuals that have the lowest absolute sum of beliefs. 

  

Agent Total beliefs 

Ehud Olmert 1.6 

Ismail Haniya 2.4 

unknown-1 3.2 

Khalid Mish?a 4.9 

Former President Carter 5.2 

Mahmud Abbas 8.6 

Condoleezza Rice 8.6 

Bashar Al-Assad 9 

President George Bush 9.5 

unknown-2 49.8 

Produced by ORA developed at CASOS - Carnegie Mellon University 
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248 Capacity Report 

The purpose of this report is to assess individuals' and organizations' capability to 

perform tasks. Below are procedures for running this report.  

248.1 Overall Capability and Needs 

List all congruence measures 

1. For agents – list min, max, avg and std dev in capability for each capability index. 

2. For organizations – list min, max, avg and std dev in capability for each capability 

index 

3. For tasks – list min, max, avg and std dec in requirements for each requirement 

index 

Most Capable 

List the top n most capable agents and next to their name list their capabilities 

(knowledge, resources, tasks). 

NOTE : list overall capability first (don't show capabilities for the overall). 

List the top n most capable organizations and next to their name list their 

capabilities (knowledge, resources, tasks). 

NOTE : List overall capability first, the overall explicit – then the three explicit. Then list 

the overall implicit and then the three implicit. 

NOTE : don't show capabilities for the overall measures. 

248.2 Highest Requirements 

List the top n tasks with the most requirements and next to each name list the 

requirements. 

NOTE: list the overall first (don't show requirements for the overall). 

Capability  

Capabilities are defined in terms of expertise (knowledge) and resources. 

NOTE : this formula discounts for the fact that most agents have some capabilities and 

assumes that there is a general discount to having large numbers of capabilities. 

An agent's general capability index in resources is: ACR =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of resources the agent has divided by the maximum number of 

resources any agent has (so for AR this is the row sum divided by the max row sum) 

An agent's general capability index in expertise is: ACK =1/(1+EXP(-((x-

0.5)*10))) 
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Where x = number of knowledge the agent has divided by the maximum number of 

knowledge any agent has (so for AK this is the row sum divided by the max row sum) 

An agent's capability can be inferred by the agent's experience. This is captured 

by the agent to task links. This is ACT=1/(1+EXP(-((x-0.5)*10))). 

Where x = number of tasks the agent has divided by the maximum number of tasks 

any agent has (so for AT this is the row sum divided by the max row sum) 

An agent's capability overall in both R, K and T is (ACR + ACK + ACT)/3 

An organization's explicit capability is: 

An organization's general capability index in resources is: OCR =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of resources the organization has divided by the maximum 

number of resources any organization has (so for OR this is the row sum divided by 

the max row sum) 

An organization's explicit capability index in expertise is: OCK =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of knowledge the organization has divided by the maximum 

number of knowledge any organization has (so for OK this is the row sum divided by 

the max row sum) 

An organization's explicit inferred capability index using tasks is: OCK 

=1/(1+EXP(-((x-0.5)*10))) 

Where x = number of tasks the organization has divided by the maximum number of 

tasks any organization has (so for OT this is the row sum divided by the max row 

sum) 

An organization's overall explicit capability is (OCR + OCK + OCT)/3 

An organization's implicit capability considers the expertise and resources of the 

agent's associated with the organization 

So this is for resources the average ACR across the agents associated with the 

organization. 

So this is for knowledge the average ACK across the agents associated with the 

organization. 

So this is for tasks (implicit inferred) the average ACT across the agents 

associated with the organization. 

From a network perspective, an agent is associated with an organization if AOij 

!= 0. 

An organization's overall implicit capability is the sum of the 3 divided by 3. 

An organization's overall capability is the average of the explicit and implicit. 
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248.3 Requirements 

Each task has requirements in terms of the knowledge and resources needed for 

that task. 

Note : in practice it may not be possible to measure the requirements for all tasks, 

particularly for covert operations, prior to the task being done. So, a subject matter 

expert's view of the "complexity" of the task might be substituted. Such complexity would 

play the same role, and have the same properties as the requirements index defined here. 

A task's general requirement index in resources is: RR =the number of resources 

needed for that task/maximum number of resources needed for any task (so for 

RT this is the col sum divided by the max col sum) 

A task's general requirement index in knowledge is: RK =the number of 

knowledge needed for that task / maximum number of knowledge needed for any 

task (so for KT this is the col sum divided by the max col sum) 

A task's overall requirement index is the average of RR and RK. 

Match 

In general agents with more capabilities when assigned to tasks with more 

requirements will better meet those needs. In general, agents with more 

capabilities will be able to perform more tasks. In general, tasks with higher 

requirements need either more agents or agents with more capabilities. 

When the exact requirements are done it is possible to do a match function. Here 

the idea is that the task is done best when the there is congruence between what 

resources/knowledge are needed for a task and what resources/knowledge those 

agents assigned to the task have. 

Several of the congruence measures in ORA apply here. For these definitions see 

the on-line ORA help. 

249  
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250 Capacity Report 

The purpose of this report is to assess individuals' and organizations' capability to 

perform tasks. Below are procedures to run a capacity report in ORA.  

250.1 Overall Capability and Needs 

List all congruence measures 

1. For agents – list min, max, avg and std dev in capability for each capability index. 

2. For organizations – list min, max, avg and std dev in capability for each capability 

index 

3. For tasks – list min, max, avg and std dec in requirements for each requirement 

index 

Most Capable 

List the top n most capable agents and next to name list their capabilities 

(knowledge, resources, tasks). Note; list overall capability first (don't show 

capabilities for the overall). 

List the top n most capable organizations and next to name list their capabilities 

(knowledge, resources, tasks). Note; list overall capability first, the overall 

explicit – then the 3 explicit, then the overall implicit and then the 3 implicit. 

Note, don't show capabilities for the overall measures. 

Highest Requirements 

List the top n tasks with the most requirements and next to each list the 

requirements. Note list the overall first (don't show requirements for the overall). 

Capability 

Capabilities are defined in terms of expertise (knowledge) and resources. 

Note this formula discounts for the fact that most agents have some capabilities and 

assumes that there is a general discount to having large numbers of capabilities. 

An agent's general capability index in resources is: ACR =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of resources the agent has divided by the maximum number of 

resources any agent has (so for AR this is the row sum divided by the max row sum) 

An agent's general capability index in expertise is: ACK =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of knowledge the agent has divided by the maximum number of 

knowledge any agent has (so for AK this is the row sum divided by the max row sum) 

An agent's capability can be inferred by the agent's experience. This is captured 

by the agent to task links. This is ACT=1/(1+EXP(-((x-0.5)*10))). 
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Where x = number of tasks the agent has divided by the maximum number of tasks 

any agent has (so for AT this is the row sum divided by the max row sum) 

An agent's capability overall in both R, K and T is (ACR + ACK + ACT)/3 

An organization's explicit capability is: 

An organization's general capability index in resources is: OCR =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of resources the organization has divided by the maximum 

number of resources any organization has (so for OR this is the row sum divided by 

the max row sum) 

An organization's explicit capability index in expertise is: OCK =1/(1+EXP(-((x-

0.5)*10))) 

Where x = number of knowledge the organization has divided by the maximum 

number of knowledge any organization has (so for OK this is the row sum divided by 

the max row sum) 

An organization's explicit inferred capability index using tasks is: OCK 

=1/(1+EXP(-((x-0.5)*10))) 

Where x = number of tasks the organization has divided by the maximum number of 

tasks any organization has (so for OT this is the row sum divided by the max row 

sum) 

An organization's overall explicit capability is (OCR + OCK + OCT)/3 

An organization's implicit capability considers the expertise and resources of the 

agent's associated with the organization 

So this is for resources the average ACR across the agents associated with the 

organization. 

So this is for knowledge the average ACK across the agents associated with the 

organization. 

So this is for tasks (implicit inferred) the average ACT across the agents 

associated with the organization. 

From a network perspective, an agent is associated with an organization if AOij 

!= 0. 

An organization's overall implicit capability is the sum of the 3 divided by 3. 

An organization's overall capability is the average of the explicit and implicit. 

250.2 Requirements 

Each task has requirements in terms of the knowledge and resources needed for 

that task. 
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Note, in practice it may not be possible to measure the requirements for all tasks, 

particularly for covert operations, prior to the task being done. So, a subject matter 

expert's view of the "complexity" of the task might be substituted. Such complexity would 

play the same role, and have the same properties as the requirements index defined here. 

A task's general requirement index in resources is: RR =the number of resources 

needed for that task/maximum number of resources needed for any task (so for 

RT this is the col sum divided by the max col sum) 

A task's general requirement index in knowledge is: RK =the number of 

knowledge needed for that task / maximum number of knowledge needed for any 

task (so for KT this is the col sum divided by the max col sum) 

A task's overall requirement index is the average of RR and RK. 

Match 

In general agents with more capabilities when assigned to tasks with more 

requirements will better meet those needs. In general, agents with more 

capabilities will be able to perform more tasks. In general, tasks with higher 

requirements need either more agents or agents with more capabilities. 

When the exact requirements are done it is possible to do a match function. Here 

the idea is that the task is done best when the there is congruence between what 

resources/knowledge are needed for a task and what resources/knowledge those 

agents assigned to the task have. 

Several of the congruence measures in ORA apply here. For these definitions see 

the on-line ORA help. 
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251 Key Entity Report — Basic 

Below is an image of main dialog window used to run a Key Entity Report. Further 

below are procedures for doing so.  

251.1 Main Dialog Box 

 

This is the main interface for this report where you select the Network and the types of 

transformations to perform for the report. 

1. Select a Report contains all the reports available 

2. MetaNetworks to Analyze Place a checkmark in the matrices you want to analyze. 

3. Show/Hide transform options shows the options for transforming a Network. 

4. Transform contains three options 

o General mathematical transformations contains the basic types of 

transformations available. It uses a checkbox which can be either turned 

on or off. 

o Remove entities allows you to remove entities from the report. It is a radio 

button used in conjunction with partition entities. 

o Partition entities allows you to create a division to separate the report. 
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251.2 The Reports 

 

The Entity Report creates up to six separate reports. 

1. KEY-ENTITY REPORT shows general information about the report 

2. Who shows information about agents, such as Emmergent Leader, In the Know, 

and Potential Influential. Gives information about knowledge that agents know, 

the resources they have access to, and what events the agents were at. 

3. What shows information for tasks and the tasks related to agents, knowledge, etc. 

such as High Concentration of Actors, Knowledge, and Resources. 

4. Where shows information about locations related to agents, resources, and tasks 

such as Central Locations, Most Active Locations, and Highest Concentration of 

Actors. 

5. How shows information about the knowledge related to agents, knowledge, and 

loactions such as Dominant Knowledge, Most Available, Dominant Resources. 

6. Performance Indicators shows information about Social Density, Communication, 

and Performance. 

251.3 Output Options 

 

You have a choice of four formats of report. Text places the reports in individual tabs in 

Panel 3 of the main interface. HTML creates reports that are opened up in a browser 

window. CSV are files that can be opened in Excel. And DyNetML creates .xml files, the 

default for ORA. 
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When you are finished, select [Finish].  
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252 Key Entity Report — Other Options 

The Key Entities Report allows you to further tweak your report by defining parameters 

such as isolates, pendants, and binarizing your data. Following are three dialog boxes 

explaing those further refinements. 

252.1 General Transformation 

Occasionally your data needs work before creating the report. The General 

Transformation allows for refining it. See the dialog box below 

 

 Remove Isolates: Remove any isolates* before running the report. 

 Remove Pendants: Remove any pendants* before running the report. 

 Symmetrize by method: Even out the matrix by using one of the methods i nthe 

dropdown menu. 

 

o Maximum : Acts like the binary OR function. If either one of a pair of 

nodes has a link then this function creates an equal link in the opposite 

direction. 

o Minimum : Acts like the binary AND function. Both nodes need to have a 

link one another in order for a link to be valid. Else there is no link 

between the two nodes. 

o Average :  

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23i
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23p
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 Remove links: Allows you to remove links from the report based on one of the 

options in the dropdown menu. 

 

 Binarize: Binarizing* your numeric data will change all link weights to a value of 

either [1] or [0]. 

 Conform meta-matrice by method:  

 Create union matrices:  

When you are finished, select [Next >]. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23b
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252.2 Remove Entities Options 

 

You can remove any of the nodes and stop them from affecting a report. By either using 

the tabs to find the entity in it's set or using the search box to single it out. Then place a 

checkmark in the box to remove it from view. The options are fairly self explanatory. 

You can create multiple filters with this method. 

The Filter Commands give you the choice of matching all or some of the filters you've 

created. And the [Reset Filters] button clears all the filters you've made. The filters can be 

refined by using the Search box to cal up particular nodes and marking them with a 

checkmark to remove them from the use. This can be done as many times as necessary 

before proceeding. You can also go through the tabs individually and choose to 

Select/Deselect whichever nodes you want. 

The [Select All] and [Clear All] buttons work on only the currently visible items. 

Any node that you place a checkmark in will be excluded from the filter. 

When you are finished, select [Next >]. 
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252.3 Partition Options 

 

From this screen choose an Entity from the top box. Place a checkmark in the appropriate 

checkbox. Next in the Select an attribute dropdown menu chose the attribute to base the 

report on. Finally chose and attribute value to use for the partition. 

If you want to create a new MetaMatrix place a checkmark in the bottom box add created 

partition meta matrices to the main interface.  

When you are finished, select [Next >]. 

252.4 Summary 

With the Key Entities Report you can refine your report to focus on only the segment 

of your Network you prefer. 
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253 Mental Model Reports 

What follows are descriptions of the various mental model reports in ORA.  

Single condensed files - per chunk, where a chunk is N days prior to or posterior to an 

event, excluding the day of the event 

Number of concepts - Number of words (frequency count per email) Carley and Kaufer, 

1993 

Number of isolated concepts - Number of words that were coded as knowledge items, but 

did not get linked into statements Carley and Kaufer, 1993 

Number of statements - Number of links (frequency count per email) Carley and Kaufer, 

1993 

Density - Density of semantic network Carley and Kaufer, 1993 

Set-Theoretic and qualitative (word-level) comparison of maps from before and after 

event  

Concept Analysis - Concepts are classified according to whether they have high and low 

values for the measures: total degree centrality, betweenness centrality, and consensus. 

  

 
Allusions - high degree, low betweenness, low consensus Carley and Kaufer, 1993 

Buzzwords - low degree, high betweenness, low consesus Carley and Kaufer, 1993 

Emblems - low degree, high betweenness, high consensus Carley and Kaufer, 1993 

Factoids - low degree, low betweenness, high consensus Carley and Kaufer, 1993 

Ordinary Words - low degree, low betweenness, low consensus Carley and Kaufer, 1993 

Placeholders - high degree, high betweenness, low consensus Carley and Kaufer, 1993 

Stereotypes - high degree, low betweenness, high consensus Carley and Kaufer, 1993 

Symbols - high degree, high betweenness, high consensus Carley and Kaufer, 1993 

253.1 Mental Model Reports Bibliography 

 Carley, Kathleen & Kaufer, David. (1993). Semantic Connectivity: An Approach 

for Analyzing Symbols in Semantic Networks. Communication Theory, 3, 183-

213. 

 Wasserman, S., & Faust, K.. Social Network Analysis: Methods and Applications. 

New York and Cambridge, ENG: Cambridge University Press. 

 Watts, D.J., Strogatz, S.H.(1998) Collective dynamics of 'small-world' networks. 

Nature 393:440-442. 
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255 Tasks 

256 Contextual Menus 

What follows are procedures for using ORA's contextual menus.  

Right-clicking on any Meta-Network, NodeSet, or Network brings up a contextual menu 

with the functions available with each. 

 

The first four are self-explanatory. Transform… opens up the Meta-Network 

Transform… dialog box. 

 

The first three are self-explanatory. Add Attribute … opens up the attribute function in 

order to add attributes to a nodeset. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\tasks\mt\matrixTransform.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\tasks\mt\matrixTransform.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\tasks\attribute\attribute.html
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The first two are self-explanatory. 

 Set Diagonal… : Used on a square network to set cells 1,1 through x,x to the same 

value. In binary view the choise are 1: True (+1) 2: True (-1) 3: False (0). In 

Numeric view you can put any value into the diagonal. 

 Fold Network… : This function creates a new network using matrix algebra. 

Below are four variations of a four x four network and the results when each is 

folded. 

 

 Save Network… : Any Network can be saved individually to a file in one of the 

following formats: CSV*, DL, DyNetML*, or UNCINET (.##h). Also check File 

Formats for more information 

 Binarize Network : Turns all non-zero numbers to [1] and leaving all [0] 

untouched. 

 Remove Links… : Removes links in accordance to the selection in the dropdown 

menu (as seen in the images below). 

 

 Symmetrize… :  

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\BasicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\BasicTerms\basicTerms.html%23d
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
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257 Contextual Menus - Multi Files 

There's also a separate contextual menu when you've got two or more Meta-Networks 

selected.  

Open up multiple Meta-Networks in the Main Interface. Load two or more files into 

Panel 1. We'll demonstrate this on two Meta-Networks containing Bob, Carol Ted, & 

Alice. 

The agents are identical but the tasks in each are different, except for driving which 

appears in both and has slightly different values. Inbetween the time of cookingIn and 

eatingOut Alice's feelings for Ted have grown. 

cookingIn and 

 

eatingOut 
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Highlight both of them by holding down the [Control] while clicking on each file. Then 

Right-click on one of the files. This brings up the contextual menu. 

 

The Add New MetaNetwork & Remove Selected Meta-Network are self-explanatory. 

The Union Meta-Network will create a new Meta-Network using one of five actions: 

sum, binary, average, minimum, or maximum. 

 

 sum : In any identical network all values from all networks are added together. 

(i.e. bob's score of 4.0 in both meta-networks are added together for a total of 

8.0). 

 

 binary : Then in the binary option it doesn't matter what numbers appeared in 

either meta-network as it uses only 1 or 0 as a result. If any cell has a non-zero it 

will contain a 1 as a result. 
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 average : This option takes the sum of all identical cell values and divides them 

by the number of cells used. In cookingInted x alice contained a 2 while in 

eatingOut the value for tes x alice was a 1. This was averaged out to 1.5. 

 

 minimum : This function finds the smallest value in any identical cells and uses 

that in the final result. (i.e. for ted x carol and ted x alice both cells use the smaller 

value of "1" even though they are from different meta-networks. 

 

 maximum : This function finds the largest value in any identical cells and uses 

that in the final result. (i.e. for ted x carol and ted x alice both cells use the larger 

value of "2" and "3" respectively, each taken from a different meta-network. 

 

Intersect Meta-Network works similar to the Union function and has the same five 

options. But in creating the new Meta-Network only nodes that appear in all Meta-

Networks are carried over to the new Meta-Network. 

For example: All four agents appear in both Meta-Networks and are brought over into the 

new Meta-Network. But though there were six tasks in the cookingIn and three tasks in 

eatingOut there is only one task (driver) in the new Meta-Network created from the 

intersect function. Only nodes found in all Meta-Networks are brought over. 
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And even though bob has a value for driver in cookingIn only carol has a value for driver 

in both Meta-Networks. 

 

Conform Meta-Network alters the selected Meta-Networks and makes them equal. union 

adds nodes that are found in one Meta-Network but not the other. inersect removes nodes 

that are not common to both. 
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258 Creating a Network from an Excel Spreadsheet 

If you don't have a Network, you can create one from scratch. Below is step-by-step 

instruction on how to do this. 

We will create an square, agent-by-agent Network. We say it is square because all row 

headings correspond directly to column headings. This is important as it relates to 

specific measures ORA can run on a graph. If the graph is not square, some measures will 

not work. 

Open a blank Microsoft Excel work book. In column A we will enter the name of all the 

nodes that make up our social network or organization. 

258.1.1 NOTE : When creating your spreadsheet, do not add any 

additional titles, notes, or other headings, which will interfere with 

the "square" properties of the Network. 

 

Next, create column headings using the correlating names as they appear in row 

headings. Again, this will ensure that our Network will be square. 

 

Next we will create links between each agent. We do this by entering a 1 if a direct 

connection or relationship exists and a 0 if it does not. Please note that headings that 

cross-reference themselves are considered redundant and thus are left blank or 0. 

In the example below, Redundant cells are filled in with red strips to illustrate the self-

loops. This redundancy should continue as a smooth diagonal line from the top left corner 

of your Network to the bottom right. 
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258.1.2 NOTE : If you don't end up with a diagonal line then your 

graph is not square. 

Using 1s and 0s to establish link, complete your spreadsheet. 

In the Network example, we have assigned links randomly. Within your organization or 

network, however, you can describe any direct connections or relationships you are 

interested in analyzing. For instance, you may determine that a direct connection exists if 

agents within your network consult with each other at least once a month; literally, it can 

be anything you decide. 

Below is our completed Network (The red fill illustrates cells that do not require input 

due to their redundancy*). 

 

Now that we have essentially built a Network from scratch using Excel, the next step is to 

save it in a compatible file format ORA can interpret. For Excel spreadsheets this will be 

the CSV* file format. 

258.1.3 From the drop down menu: File => Save As 

Make sure you save this file as a CSV (comma delimited) 

You have now created a Network from scratch which can be loaded into ORA. 

Now return to ORA and load up your new Network. Below is a our new Network 

rendered in the ORA Visualizer. Notice the arrows only point from one node to another if 

there is a 1 in the column for a particular node. i.e. There is a "1" in the bob column for 

ted but a "0" in the ted column for bob. So an arrow points from ted to bob but NOT from 

bob to ted. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23r
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
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259 Hovering 

Hovering the pointer over various parts of the panels will reveal information about the 

Meta-Network.  

Hovering over the parts in Panel 1 will reveal different information about the Meta-

Networks, Meta-Nodes, and Networks. 
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260 Info Tab - Network 

When a Network is selected there are also two tabs, Info and Editor. 

The Info tab contains a textbox, Network ID in which you can change the name of any 

metwork, The Source and Target Nodesets, and whether this network is directed or not, 

the Link Count, and the Density. 

The two buttons underneath allow the choice of Visualize this Network which will send 

the entire Meta-Network to the visualizer or Visualize Only this Network which display 

only the currently selected Network. 

 

The Editor tab has two views: Binary and Numeric.  

Binary view is used when you only need to extablish a connection between two nodes 

with no weights. It's a simple Yes or No arrangement. 
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The Numeric view allows you to treat links between various nodes with more or less 

importance. Notice that all the row nodes have a checkmarked connection to the column 

containing [yu] in the binary mode. This denotes they know one another. But in the 

numeric mode this value is a 0.5 which is used to denote previous acknowledgement but 

is an advesary. 
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261 Info Tab - NodeSet 

Panel 2 contains two tabs, Info and Editor. The Info tab is mainly designed to display 

information regarding the Meta-Networks, NodeSets, and Networks. But this is the area 

where you can rename the Node Class ID and the Node Class Type. Place the cursor in 

the box, make sure the entire name is highlighted, and type in your new name. 

This area also gives you the Node Count of the selected Node Set as well as the Attribute 

Names contained within the NodeSet. 

 

The Editor tab contains most of the editing functions. 

 

1. The Search box for finding particular node(s) in a set. 

2. The <set filter> for displaying only a particular sub-set of node(s). 

3. The Checkboxes to designate which nodes to Delete or Merge. 

4. The Nodes buttons: Create, Delete, Merge. 

5. The Attributes buttons: Create and Delete. 
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262 Running an Intelligence Report 
262.1 Who are the critical actors? 

 

An Intelligence Report identifies key actors (individuals and groups) who are positioned 

in the network in ways that make them critical to its operation. 

To run an Intelligence Report: 

 Return to the ORA interface. 

 Go to Analysis in the menu bar and click Generate Reports which brings up the 

Generate Reports dialog box.  

 At the top of the window is a pull-down menu titled Select Report. Pull down the 

menu by clicking the small inverted arrow icon to its right, and select Intelligence.  

 In the box titled Select one or more meta matrices: select the box for the Tanzania 

Embassy bombing meta matrix.  

 At the bottom of the popup window is a file chooser titled Enter a file name (any 

extension will be ignored) for the results file: Select the [Browse] button to the 

right and navigate to the location you want. Type in a filename (for example, 

IntelOutput) and select Open.  

Below is a screen capture showing the popup windows with the correct options chosen: 

 

 Select the [Next] button at the bottom of the dialog box. Select the [Finish] 

button. 
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An HTML file will pop up in your browser displaying the Intelligence Report. The same 

text is also displayed in Panel 3 in ORA. 

Below is a screen capture of the ORA interface with the Intelligence Report displayed in 

Panel 3: 
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Below is the HTML file for the Intelligence Report on the Tanzania Embassy bombing 

data: 

262.2 INTELLIGENCE REPORT 

Input data: TanzaniaEmbassyEnhance_2-07 

Start time: Fri Feb 23 10:30:55 2007 

262.3 KEY ACTORS 

262.4 Emergent Leader (cognitive demand) 

Measures the total amount of cognitive effort expended by each agent to do its tasks. 

   

Rank Value Nodes 

1 0.378917 fazul_mohammed 

2 0.341104 khalfan_mohamed 

3 0.299063 mohamed_owhali 

4 0.280313 a13 

5 0.269833 mohammed_odeh 

6 0.243792 abdullah_ahmed_abdullah 

7 0.192542 a10 

8 0.183771 a4 

9 0.180042 wadih_el-hage 

10 0.176083 a16 

262.5 In-the-Know (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 

degrees. 

Input graph(s): Agent x Agent 

   

Rank Value Nodes 

1 0.4 wadih_el-hage 

2 0.266667 mohamed_owhali 

3 0.266667 bin_laden 

4 0.2 abdullah_ahmed_abdullah 
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5 0.133333 ali_mohamed 

6 0.133333 khalid_al-fawwaz 

7 0.133333 a16 

8 0.1 mohammed_odeh 

9 0.0666667 fazul_mohammed 

10 0.0666667 a13 

262.6 Number of Cliques (clique count) 

The number of distinct cliques to which each node belongs. 

Input graph(s): Agent x Agent 

   

Rank Value Nodes 

1 2 wadih_el-hage 

2 2 bin_laden 

3 1 mohamed_owhali 

4 1 ali_mohamed 

5 1 khalid_al-fawwaz 

6 1 abdullah_ahmed_abdullah 

7 1 a16 

8 0 khalfan_mohamed 

9 0 mohammed_odeh 

10 0 a4 

262.7 Most Knowledge (row degree centrality) 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): Agent x Knowledge 

   

Rank Value Nodes 

1 0.75 mohamed_owhali 

2 0.75 mohammed_odeh 

3 0.75 fazul_mohammed 
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4 0.5 khalfan_mohamed 

5 0.5 wadih_el-hage 

6 0.5 ali_mohamed 

7 0.5 a10 

8 0.5 jamal_al-fadl 

9 0.5 a13 

10 0.25 bin_laden 

262.8 Most Resources (row degree centrality) 

The Row Degree Centrality of a node is its normalized out-degree. 

Input graph(s): Agent x Resource 

   

Rank Value Nodes 

1 0.75 abdullah_ahmed_abdullah 

2 0.5 fazul_mohammed 

3 0.5 ahmed_ghailani 

4 0.25 khalfan_mohamed 

5 0.25 mohammed_odeh 

6 0.25 wadih_el-hage 

7 0.25 bin_laden 

8 0.25 a10 

9 0.25 a16 

10 0 mohamed_owhali 

262.9 Leader of Strong Clique (eigenvector centrality) 

Calculates the principal eigenvector of the network. A node is central to the extent that its 

neighbors are central. 

Input graph(s): Agent x Agent 

   

Rank Value Nodes 

1 0.167408 wadih_el-hage 

2 0.147407 bin_laden 
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3 0.101381 mohamed_owhali 

4 0.0992916 ali_mohamed 

5 0.0992915 khalid_al-fawwaz 

6 0.0836873 abdullah_ahmed_abdullah 

7 0.0791944 mohammed_odeh 

8 0.0583699 a16 

9 0.0527998 mahmud_abouhalima 

10 0.0527997 fazul_mohammed 

262.10 Potentially Influential (betweenness centrality) 

The Betweenness Centrality of node v in a network is defined as: across all node pairs 

that have a shortest path containing v, the percentage that pass through v. 

Input graph(s): Agent x Agent 

   

Rank Value Nodes 

1 0.233333 wadih_el-hage 

2 0.197619 mohamed_owhali 

3 0.192857 bin_laden 

4 0.0690476 abdullah_ahmed_abdullah 

5 0.0452381 mohammed_odeh 

6 0 khalfan_mohamed 

7 0 a4 

8 0 fazul_mohammed 

9 0 ali_mohamed 

10 0 ahmed_ghailani 

262.11 Connects Groups (high betweenness and low degree) 

The ratio of betweenness to degree centrality; higher scores mean that a node is a 

potential boundary spanner. 

Input graph(s): Agent x Agent 

   

Rank Value Nodes 
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1 0.26046 mohamed_owhali 

2 0.254184 bin_laden 

3 0.205021 wadih_el-hage 

4 0.158996 mohammed_odeh 

5 0.121339 abdullah_ahmed_abdullah 

6 0 khalfan_mohamed 

7 0 a4 

8 0 fazul_mohammed 

9 0 ali_mohamed 

10 0 ahmed_ghailani 

262.12 Unique Task Assignment (task exclusivity) 

Detects agents who exclusively perform tasks. 

    

Rank Value Nodes Speciality 

1 0.205078 fazul_mohammed t3 

2 0.0136876 mohamed_owhali t1 

3 0.0136876 a13 t1 

4 0.011305 abdullah_ahmed_abdullah t1 

5 0.00995741 ali_mohamed t1 

6 0.00507781 khalfan_mohamed t5 

7 0.00366313 a4 t5 

8 0.00141468 mohammed_odeh t4 

9 0.00141468 a16 t4 

10 0.00134759 ahmed_ghailani t4 

262.13 Special Expertise (knowledge exclusivity) 

Detects agents who have singular knowledge. 

    

Rank Value Nodes Speciality 

1 0.0919699 bin_laden k4 
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2 0.0919699 khalid_al-fawwaz k4 

3 0.00214043 mohamed_owhali k3 

4 0.00214043 mohammed_odeh k3 

5 0.00214043 fazul_mohammed k3 

6 0.00191246 khalfan_mohamed k3 

7 0.00191246 ali_mohamed k3 

8 0.00168449 abdullah_ahmed_abdullah k3 

9 0.000455941 wadih_el-hage k1, k2 

10 0.000455941 a10 k1, k2 

262.14 Special Capability (resource exclusivity) 

Detects row nodes who have singular ties to column nodes. 

Input graph(s): Agent x Resource 

    

Rank Value Nodes Speciality 

1 0.108996 abdullah_ahmed_abdullah r4 

2 0.0965488 ahmed_ghailani r4 

3 0.0919699 bin_laden r2 

4 0.0919699 a10 r2 

5 0.0170257 fazul_mohammed r3 

6 0.0124468 wadih_el-hage r3 

7 0.0124468 a16 r3 

8 0.00457891 khalfan_mohamed r1 

9 0.00457891 mohammed_odeh r1 

10 0 mohamed_owhali  

262.15 Workload (actual based on knowledge and resource) 

The knowledge and resources an agent uses to perform the tasks to which it is assigned. 

   

Rank Value Nodes 

1 0.692308 fazul_mohammed 
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2 0.307692 mohamed_owhali 

3 0.307692 khalfan_mohamed 

4 0.230769 mohammed_odeh 

5 0.230769 a13 

6 0.230769 abdullah_ahmed_abdullah 

7 0.153846 wadih_el-hage 

8 0.153846 a16 

9 0.0769231 ali_mohamed 

10 0.0769231 ahmed_ghailani 

262.16 KEY KNOWLEDGE 

Dominant Knowledge (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 

degrees. 

   

Rank Value Nodes 

1 0.571429 k2 

2 0.428571 k1 

3 0.333333 k3 

4 0.0952381 k4 

262.17 KEY RESOURCES 

Dominant Resource (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 

degrees. 

   

Rank Value Nodes 

1 0.333333 r3 

2 0.285714 r1 

3 0.190476 r4 

4 0.142857 r2 

262.18 KEY LOCATIONS 
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Dominant Location (total degree centrality) 

The Total Degree Centrality of a node is the normalized sum of its row and column 

degrees. 

   

Rank Value Nodes 

1 1.125 u_s 

2 0.847222 afghanistan 

3 0.833333 pakistan 

4 0.722222 washington 

5 0.708333 indonesia 

6 0.701389 europe 

7 0.673611 airport 

8 0.604167 america 

9 0.527778 turkey 

10 0.506944 somalia 
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PERFORMANCE INDICATORS 

  

Entity class Size 

agent 16 

event 3 

knowledge 4 

location 54 

resource 4 

task 5 

Overall Complexity = 0.22707503 

Density of the Meta-Matrix: Social Density = 0.11666667 

Density of the Agent x Agent network: Social Fragmentation = 0.45 

Fragmentation of the Agent x Agent network: Communication Congruence = 0.416667 

Measures to what extent the agents communicate when and only when it is needful to 

complete tasks. Perfect congruence requires a symmetric Agent x Agent network: 

Knowledge Congruence = 0.55 

Measures the similarity between what knowledge are assigned to tasks via agents, and 

what knowledge are required to do tasks. Perfect congruence occurs when agents have 

access to knowledge when and only when it is needful to complete tasks: Performance 

As Accuracy = 0.36 

Measures how accurately agents can perform their assigned tasks based on their access to 

knowledge and resources: Avg Communication Speed = 0.438406 

The average speed with which any two nodes can interact. This is based on the inverse of 

the shortest path lengths between node pairs. 

Produced by ORA developed at CASOS - Carnegie Mellon University 

 
From this Intelligence Report, it appears that Fazul Mohammed, Khalfan Mohamed, 

Mohamed Owhali, Mohammed Odeh, Abdullah Ahmed Abdullah, and Wadih El-Hage 

are among the most important people in the terrorist network. This means they may have 

a great deal of knowledge, influence over many other agents in the network, special 

expertise or capability, or access to important resources and locations. 

For example, Wadih El-Hage is important because he is the most in-the-know, commands 

important cliques within the network, and has the most potential influence in the network.  
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262.19 III. What do we know about an actor of interest? 

There are three ways to get additional information about an actor of interest: 

262.20 1. Visualize information about a selected actor 

For example, we can view information about Wadih El-Hage. 

 Return to the meta matrix visualization pop-up window. 

 Single-click on the red circle for the actor of interest. A window will pop up 

displaying information on the actor. 

Below is a screen capture of the information resulting from clicking on the red circle for 

Wadih El-Hage: 
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262.21 2. Visualize an actor's sphere of influence 

A sphere of influence is the set of actors, groups, knowledge, resources, events, and 

locations that influence and are influenced by a particular actor of interest. 

For example, we can examine the sphere of influence of Ahmed Ghailani. 

To visualize an actor's sphere of influence: 

 Return to the meta matrix visualization pop-up window. 

 Make sure the whole meta matrix is visualized. If it isn't, go to Actions in the 

menu bar and select Show All Entities. 

 Go to Tools in the menu bar and select Sphere of Influence. A window titled 

Sphere of Influence (Ego Network) will pop up. 

 In the Search field halfway down the popup window, type the beginning of the 

actor's name. From the options that appear in the chart below, click the box next 

to the name of your actor of interest. That actor's sphere of influence will be 

displayed in the visualization window. 

Below is a visualization of the sphere of influence of Ahmed Ghailani: 

 

To return to the original full meta matrix visualization, go to Actions in the menu bar and 

select Show All Entities. 



 

449 

 

262.22 3. Run a Sphere of Influence Report 

A Sphere of Influence Report for an individual identifies the set of actors, groups, 

knowledge, resources, events, and locations that influence and are influenced by that 

actor. 

For example, we can examine the sphere of influence of Ahmed Ghailani. 

To run a Sphere of Influence Report: 

 Return to the ORA interface. 

 Go to Analysis in the menu bar and click Generate Reports. A window titled 

Generate Reports pops up.  

 At the top of the window is a pull-down menu titled Select Report. Pull down the 

menu by clicking the small inverted arrow icon to its right, and select Sphere of 

Influence.  

 In the box titled Select one or more meta matrices: click the box for the Tanzania 

Embassy bombing meta matrix.  

 At the bottom of the popup window is a file chooser titled Enter a file name (any 

extension will be ignored) for the results file: Click the Browse button to the right 

and navigate to the location you want. Type in a filename (for example, 

SOIOutput) and click Open.  

 Click the Next button at the very bottom of the popup window.  

 From the pull-down menu titled Select an Entity: choose Ahmed Ghailani.  

 Click the Finish button. 

It may take a few minutes for ORA to run the Sphere of Influence Report. When ORA is 

finished, a small window will pop up tell you the analysis was successfully completed. 

Click OK. 

An HTML file displaying the Sphere of Influence Report will pop up in your browser 

window. 

Below is the HTML file for Ahmed Ghailani's sphere of influence: 
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262.23 SPHERE-OF-INFLUENCE REPORT 

Input data: TanzaniaEmbassyEnhance_2-07 

Start time: Fri Feb 23 11:10:54 2007 

262.24 Sphere of Influence Analysis for agent ahmed_ghailani 

The radius of the network is 1 

 

262.25 Size Statistics 

Contains the size of each node type within the ego network, expressed as an absolute 

value and as a percentage of the nodes in the original input network. 

   

Node Type Size Percent 

agent 1 +6% 

manual_location 6 +11% 
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resource 2 +50% 

task 1 +20% 

262.26 Attributes 

These are the attributes of the ego node. 

  

Name Value 

first_name ahmed 

hostility_level 2 

kinship mother 

last_name ghailani 

nationality tanzanian 

nationality_relation hostile 

nyi president 

source_date 2006-05-10 

source_name xmldata/pacrim_ilchul.xml 

title ahmed_khalfan_ghailani 

262.27 Exclusive Connections 

Find nodes that have connections exclusively to the ego node. These are also called 

pendant nodes of the ego. 

There are no pendants attached to this node. 

262.28 Most Similar Node 

Computes the node that is most similar to the ego node with respect to Cognitive 

Similarity. This is computed two ways: first, using just the ego network, and second, 

using the original input network. 

   

Network Node Type Node Name 

Original Network agent abdullah_ahmed_abdullah 

Ego Network agent ahmed_ghailani 

262.29 Top Measures 
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Computes a collection of standard network analysis measures and reports those for which 

the ego node is among the top 10 nodes. 

    

Measure Name Measure Input Rank Value 

Centrality, Row Degree Agent x Resource 3 0.5 

Centrality, Betweenness Agent x Agent 10 0 

Boundary Spanner, Potential Agent x Agent 10 0 

Exclusivity, Task Agent x Task 10 0.00134759 

Exclusivity Agent x Resource 2 0.0965488 

Actual Workload Agent x Knowledge 10 0.0769231 

262.30 Measure Value Range 

Computes a collection of network analysis routines for all the nodes in the network and 

reports whether the ego node has a Low, Medium, or High value with respect to the other 

nodes. Low means less than one standard deviation from the mean; high means more than 

one standard deviation from the mean; Medium is neither low nor high. 

   

Measure Name Measure Input Range 

Cognitive Demand Agent x Agent Medium 

Centrality, Total Degree  Medium 

Clique Count Agent x Agent Medium 

Centrality, Eigenvector Agent x Agent Low 

Centrality, Betweenness Agent x Agent Medium 

Boundary Spanner, Potential Agent x Agent Medium 

Exclusivity, Task Agent x Task Medium 

Exclusivity, Knowledge Agent x Knowledge Medium 

Exclusivity Agent x Resource High 

Actual Workload Agent x Knowledge Medium 

262.31  
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262.32 Resource Analysis Section 

Computes the resources that ahmed_ghailani can directly leverage and that can be 

mobilized. Direct resource are those directly connected to it, and indirect resources are 

those directly connected to a neighbor. 

Resources that can be leveraged 

 
Resources that can be mobilized 

ahmed_ghailani does not have any resources to mobilize. 

   

Measure Value Percent of total 

Direct resources 2 +50% 

Indirect resources 0 0% 

Possibly constrained resources 0 0% 

Possibly constrained resources are both directly and indirectly linked to the ego entity. 

Contacts with the most resources (directly linked entities with the most resources): 

  

Name Number of resources 

Contacts with the unique resources (directly linked entities with exclusive resources): 

  

Name Unique resources 

Produced by ORA developed at CASOS - Carnegie Mellon University 

________________________________________  
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262.33 IV. What are the connections between two actors of interest? 

Sometimes, rather than influencing an actor directly, you may want to examine whether 

that actor has a connection with someone who is more interesting to you. For this, the 

Path Finder feature is most useful. 

For example, we can look at how Ahmed Ghailani and Wadih El-Hage are connected. 

To use the Path Finder feature: 

 Return to the meta matrix visualization pop-up window. 

 Make sure the whole meta matrix is visualized. If it is not, go to Actions in the 

menu bar and select Show All Entities. 

 Go to Tools in the menu bar and select Path Finder. A window titled Path Finder 

will pop up. 

 In the bottom half of this pop-up window, there are two tabs titled Entity 1 and 

Entity 2. Entity 1 is the from entity, and Entity 2 is the to entity. In other words, 

Path Finder searches for communication and information that is passed from 

Entity 1 to Entity 2. 

 In the Entity 1 tab, type the name of your first actor of interest into the Search 

field. From the chart of agents below the Search field, check the box for the name 

of that agent. (For example, Ahmed Ghailani). 

 Click on the Entity 2 tab and type in the name of your second actor of interest into 

the Search field. From the chart of agents below the Search field, check the box 

for the name of that agent. (For example, Wadih El-Hage). 

 The visualization of the connections between Entity 1 and Entity 2 will appear in 

the visualization window. 
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Below is a screen capture showing the connection between Ahmed Ghailani and Wadih 

El-Hage: 

 

262.34 V. What is the immediate impact of a particular agent on the network? 
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262.35 VI. What happens to the network when certain entities are removed? 

We can examine the impact of removing a particular entity from the network by using 

Near Term Analysis (NTA). NTA removes a given entity and estimates the changes in 

the remaining network. 

This provides a what if?... analysis of the network. We can simulate strategic 

interventions or eliminations of certain agents, and examine how the network should 

react and change. For example, we can look at how the Tanzania Embassy bombing 

network changes if Ahmed Ghailani and/or Wadih El-Hage are eliminated. 

To run a Near Term Analysis: 

1. Start the Near Term Analysis window 

 Return to the ORA interface. 

 Make sure the meta matrix is highlighted in Panel 1. If it is not highlighted, 

single-click on it. 

 Go to Analysis in the menu bar and select Near-Term Analysis. A window titled 

Near Term Analysis will pop up. 

NTA has two modes, Novice and Advanced, displayed as tabs in the Near Term Analysis 

pop-up window. Novice mode provides an automatic analysis set-up, but does not allow 

users to set up their own hypotheses. 

 Click on the Advanced mode tab to switch to Advanced mode. 

Below is a screen capture showing the Advanced mode tab in the Near Term Analysis 

pop-up window: 
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 In the field titled Settings, find the number boxes on the far right. Change the 

number of replications (the top number box) to 2, and the number of simulated 

time-points (the bottom number box) to 52. The timeline in the Simulated time 

line field will expand to include 52 time-steps. 

2. Open the simulation scenario wizard 

 In the middle of the pop-up window, find and click the Add new simulation 

instances button. A small window titled Near Term Analysis - Simulation 

scenario create wizard will pop up. 

Below is a screen capture showing this wizard window: 

 

 In this wizard window, make sure the first option in the Options field is selected. 

Click the Next button. The wizard window will display options for creating a 

custom scenario. 
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Below is a screen capture showing this custom scenario field in the wizard window: 

 

3. Remove Wadih El-Hage 

 Click the box for Wadih El-Hage in the table of agents in the wizard window. 

Change the Timing box to 10 in the same row. 

 To add this event set-up to the Near Term Analysis, click the Add events button 

located next to the Search field (above the list of agents). 

The timeline at the top of the wizard window will mark the isolation of Wadih El-Hage at 

time 10. 
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Below is a screen capture of this timeline: 

 

 Click the Add a simulation button at the bottom of the wizard window. The 

wizard window will close automatically. In the NTA window, the new simulation 

case will appear in the Cases to simulate field. 

4. Remove Ahmed Ghailani 

 Follow Step 3, but replace Wadih El-Hage with Ahmed Ghailani. 

Your two simulation cases appear in the Near Term Analysis window in the Cases to 

simulate field, along with the Baseline case. The Baseline case is simply the network with 

no entities removed. 

You can view your different simulation cases by clicking on them in the Cases to 

simulate field, and the simulation time-line will change accordingly. 

5. Run the Near Term Analysis 

 Click the Execution button at the bottom of the Near Term Analysis window. 

 A small window will pop up to warn you that the execution may take a long time. 

Click OK. Another small window will pop up to show you how the simulations 

are progressing in the Near Term Analysis. 

6. View the results of the Near Term Analysis 

 When the analysis is complete, a new window titled Near Term Analysis Results 

will pop up. 
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Below is a screen capture of the results pop-up window: 

 

These two performance lines correspond to deviations from the baseline of knowledge 

diffusion over time. Examining this performance change over time reveals how much an 

agent's elimination impacts the performance of the organization. 

 To draw a bar chart, click the Draw bar chart button in the results window. The 

resulting bar chart displays a performance comparison for each time-point. 
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Below is a screen capture of the bar chart: 

 

The results of the Near Term Analysis are also available in HTML format. 

7. Save the results of the Near Term Analysis in HTML format 

 Go to File in the menu bar and select Save the html report. A file chooser window 

will pop up. Navigate to the location you want and type a filename for your 

HTML report. 

 A window titled Image Size Input will pop up. Type in the width of the image and 

click OK. 

 Another window titled Project Saved will pop up displaying the location of your 

saved analysis results. Click OK. 

8. Save the organizational structures resulting from your simulations in ORA 

 Return to the ORA interface. 

 To save the Agent-to-Agent communication network at time-step 40 in the 

simulation, go to File and select Save the Agent-to-Agent communication 

matrices during evolution. 

 A small window titled Save the probability of interaction matrix will pop up. 

Click the Yes button. 

 Another small window titled Save timing will pop up. Enter 40 and click OK. 

 A final window titled Saved will pop up. Click OK. 
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You can view saved simulations in Panel 1 of the ORA interface. 
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Below is a screen capture of Panel 1 after simulations have been saved: 
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263 Create a New Meta-Network 

There are times you need to run measures on or visualize only part of an existing Meta-

Network.  

This section will show you the easy way to create sub-sets of an existing Meta-Network. 

First duplicate the Meta-Network. Highlight the Meta-Network then from the main menu 

select Edit => Copy Meta-Network. Then form the main menu select Edit => Paste Meta-

Networks. It would be a good idea to rename this new Meta-Network immediately so as 

to not get it comfused with the original. 

Next, expand the Meta-Network you want by clicking the [+] if it isn't expanded already. 

Highlight the nodeset with the nodes you want to remove. 

 

In panel 2 select the Editor tab which brings up the matrix with nodes on the vertical and 

attributes on the horizontal. Below each attribute is a <set filter>. Below left is the 

stargate_summit meta-network along with the ally attribute. I wish to make a new meta-

network of the good guys only. In the dropdown menu under ally I select no. These are 

the nodes I want to remove. 

 

Place a checkmark in the box of each node. Below the matrix under Nodes are three 

buttons. Click the [Delete] button. The new nodeset now contains only the nodes that had 

yes in the attribute ally. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\cpMatrix\cpMatrix.html
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With this same procedure I created a Meta-Network of only the bag guys. 

Creating or Deleting Nodes 
Creating a new Node 
What follows are procedures for creating a new node in your dataset.  

Highlight a NodeSet where the node is to be added. Click [Create]. 

 

You will be prompted to input the number of new nodes you want to create in the 

NodeSet. Input the number of nodes to add and select [OK] and the new node(s) will 

appear at the bottom of the nodeset. 

 

The new node can then be renamed by clicking inside the cell. 

263.1 Delete an existing node 

To delete a node from a NodeSet place a checkmark in the box(es) to the left of the 

node(s) and select [Delete].  

 

Select [OK] and all nodes with checkmarks will be deleted from the NodeSet. 
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263.2 Merge two nodes 

The Merge button combines the links and attributes of the selected nodes and creates a 

merged or combined node. The nodes that were merged are removed, and replaced with 

the combined node. Used primarily when data needs to be consolidated. 

Example: You have two nodes, Bob and Robert. They are actually the same node and 

you want to combine their information into one node. 

264 Performing a View Network Over-Time Analysis 

The purpose of this lesson is to perform both a View Network Over Time and View 

Measures Over Time Analysis.  

To do so requires multiple network datasets representative of your network over different 

times.  

The goal is to analyze how a network changes across multiple times. The period is 

determined by the intervals of collected network data and presented as multiple Meta-

Matrices, which are loaded into ORA in sequential order. The steps below provide 

detailed instruction on how type of analysis. 

To perform a View Network Over-Time Analysis, you must load Meta-Matrices that 

relate to different time captures of your network data, which need to be in the form of 

multiple Meta-Matrices. 

In the following example, we will use network time captures of the 1998 Embassy 

Bombing in Tanzania Meta-Matrix data set and compare the same data set as we knew it 

in 1997 and 1996 and 1998. We will then compare all the Meta-Matrices in the Network 

Over-Time Viewer to gain a visual representation of how this network changed between 

1996 and 1998. 

 

NOTE : For our purposes, we have changed data in this example and have renamed the 

Meta-matrix for three different years. This will denote different network variables that 

have changed over time. 

 

You will see in the left windowpane under input dataset three Meta-Matrices, 1998, 1997, 

and 1996, have been loaded. 
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From the main menu, select File => Open Meta Matrix 

 

Choose [Select Files] 
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You will see all of our example data sets, which will load simultaneously into ORA, buy 

highlighting and selected all the files. 

Highlight all files you analyze in Over-Time Viewer. Press [Enter]. 

 

The import data window will appear (below). This will confirm the files you wish to 

analyze. 

 

Select [Finish]. 



 

469 

 

All three Meta-Matrices should display in Panel 1. 

 

264.1 Performing the Over-Time Analysis 

Now that we have time captures of our network data represented and loaded into ORA in 

the form of three Meta-Matrices relating to 1996, 1997 and 1998, we can perform the 

Over-Time Analysis. 

264.1.1.1 From the Menu Bar => Data Visualization => View 

Network Over-Time 

 

The ORA Visualizer will render all of the loaded Meta-Matrices. 

Please take special note of the Time Viewer pop-up Window. This window displays a 

slider, which will allow you to quickly change from the first Meta-Matrix time capture of 

1996, to 1997 and 1998 respectively. 
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By moving the slider from one Meta-Matrix to the next, you will gain a visual 

perspective on how the network has changed over Time. 

The series of screen shots below display how the visualized data changes from one slider 

to position to the next. These renders then allow you a picture of how the network 

changes Over-Time. 

NOTE : Depending on the complexity of the network and the extent to which 

relationships (ties) have changed, the visualization of those changes may be subtle. 

The screen shots below, however, will emphasize the extent to which the role of the 

WTC Event node has changed from 1996 to 1998 in relation to the network of which it is 

part of namely the Tanzania data set. Below these screen captures, are a series of detail 

screen captures focusing on the WTC Event node. 

264.2 Example Slider Position 1 
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264.3 Example Slider Position 2 

 

264.4 Example Slider Position 3 
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Detail of WTC Event Node when visualized in the Over-Time Viewer as part of the 

1996, 1997 and 1998 Tanzania Data Sets. 

264.5 WTC Event Node: Detail 1 - 1996 
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264.6 WTC Event Node: Detail 2 - 1997 

264.6.1.1 Notice who how the relationships of this node to the rest 

of the network has changed from 1996 to 1997. 

 

264.6.1.2 Notice that the connections (links) have changed from 

1996 to 1997. 
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As you can see, as we progress through the data sets pertaining to 1996, 1997 and 1998, 

the event node WTC lost direct ties to other parts of the network. In the 1996 data set, 

WTC had 3 ties to other nodes in the Tanzania Embassy network; In 1997, only 2; 

Finally, in 1998, the WTC event node had only 1 link to Tanzania Network. This may 

indicate that the WTC node may have lost importance from one year to the next. 

264.7 Summary of Lesson 

At this point, you should be able to complete the following tasks to perform an Over-

Time Network Analysis. 

 Load multiple Time Data Captures in the form of Meta-Matrices, which are 

representative of your network (Meta-Matrix) over time. 

 Use the Over-Time slider window tool to move from one time capture to the next. 

 Gain a visual perspective of how your overall network has changed from one time 

capture to the next. 
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265 Performing the View Measures Over-Time Analysis 

ORA provides an alternative method to analyzing your network data (in the form of 

MetaNetworks captured over time) than the only in the Visualizer. By running a View 

Measures Over Time analysis you can visualize how your network changes in relation to 

any given measure in the form of charts, which take you from one time point to the next. 

Below is a series of screen captures and instruction on how to access the View Measures 

Over Time feature: 

From the main menu bar select Data Visualization => View Measures Over Time 

265.1 Performing the View Measures Over-Time Analysis 

ORA provides an alternative method to analyzing your network data (in the form of 

MetaNetworks captured over time) than the only in the Visualizer. By running a View 

Measures Over Time analysis you can visualize how your network changes in relation to 

any given measure in the form of charts, which take you from one time point to the next. 

Below is a series of screen captures and instruction on how to access the View Measures 

Over Time feature: 

265.1.1.1 From the main menu bar: Data Visualization => View 

Measures Over Time 

 

Select View Measures Over Time. 

 

Select [OK] 
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The View Measure Over Time Window will appear. You will see that this window is 

primarily organized into three sections. 

Area 1: is a slider where you can control various inputs that affect the aggregation level 

of your Meta Matrices. 

Area 2: is a tabbed index allowing you to select the graph level you desire and the 

individual node sets you are interested in analyzing.  

Area 3: displays the actual chart based on the measures you selected in the tabbed index 

and the position of the aggregation slider. 

 

265.2 Interpreting The Results After Performing View Measures Over-Time 

Analysis 

In the example above, we have loaded all three of our network time captures into the 

View Measures Over Time Analysis tool. The result of our analysis, as we have indicated 

before, will be displayed as a chart in the bottom section of the ORA interface in Panel 3. 

But, what does this tell us? To find out, we will examine the Graph Level measure 

Knowledge Waste. From the tabbed measures window: 

265.2.1.1 Graph tab > Congruence, Organization Measure, 

Knowledge Waste. 
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The result is displayed below. 

 

We can see the chart displays an axis scale correlating to our networks over time. The 

graph level measure of Knowledge Waste was selected using the View Measures Over 

Time tool and the result is displayed in the chart area of the window. 

We can see that the graph level measure of Knowledge Waste held a value slightly above 

40 in the first Meta Matrix, 1996, displayed with 1 on the Time axis. We can deduce from 

the chart that in 1997 something affected our measure of Knowledge Waste to increase 

the value to nearly 60. This corresponds to the time scale axis of 2, which represents 

1997, our second year of network data. In the final year, 1998, our measure of 

Knowledge Waste declined to the value in 1996. This should be visually evident with its 

relative line graph position. 

It is clear that the value for the Knowledge Waste Measure increased from the first Meta 

Matrix (1996) to the second (1997) and then retreated back to its original (1996) level. It 

would be up to you to determine what may have affected that measure for it to undergo 

this progression and regression. 

Summary of Lesson 
At this point, you should be able to complete the following tasks to perform a View 

Measures Over-Time Analysis: 

 Load multiple data files into ORA (in the form of Meta-Matrices) representative 

of your network across certain periods. 

 Select an aggregation level and choose a graph level or node level set to analyze. 

 Analyze the data output in the charting tool located in the bottom section of the 

View Measures Over Time window. 
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 See how your network may have changed from one time capture to the next for 

any given graph level or entity node measure. 

 Use this visual comprehension to draw conclusions about how your network 

changed across multiple times. 

266 Renaming 
266.1 Renaming Meta-Networks, Meta-Nodes, and Networks 

ORA allows you to rename the Meta-Network, Meta-Node, and Networks. This helps 

makes the information clearer for you. Below I renamed one of the Meta-Nodes to those 

guys and also renamed the type to who?. You can see how it's reflected throughout the 

entirely of panel 1. So you can rename any Meta-Node in a Meta-Network for better 

readability. 

 

267 Running An Over-Time Analysis 
267.1 Overview: Over-Time Viewer 

To run the Over-Time Viewer, you must first load MetaNetworks that relate to different 

time captures of network data. In the example below, you will see in the left window 

pane under input dataset three MetaNetworks, 2000, 2001, and 2002, have been loaded. 

Once you have loaded your MetaNetworks, select the Over-Time Viewer from the main 

interface tool bar under Data Visualization. 

The black ellipse in the screen shot below illustrates how to access the Over-Time 

Viewer from ORA's main interface. 
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From the drop-down menu: Data Visualization => Over Time Viewer 

 

After you select Over-Time Viewer from the drop-down menu, the following information 

pop-up window will appear: 

 

Click [OK] 
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The Over-Time Viewer will merge your loaded MetaNetworks. In this case 2000, 20001, 

and 2002 will merge. The Progress... pop-up window (below) details the status as ORA 

runs measures on the merged MetaNetworks: 

 

When it is finished running, the View Measures Over Time window appears next (screen 

shot below). 

Here you can run specific measures against the nodesets within your merged 

MetaNetworks. In the example below, we see that we have opted to run the measure 

Chart_Measures against the node set Centrality-Total Degree. Multiple sets of nodes can 

be selected against a measure by using "ctrl-click." 
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The results are displayed in the chart at the bottom of the View Measures Over Time 

window (shown above). 

Based on this analysis, we can conclude the overall Centrality-Total Degree measure of 

our network sample had increased slightly from 2000 to 2001, then decreased noticeably 

in 2002. 
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268 Lessons 

269 Lesson 1: ORA Overview 
269.1 Overview of ORA Interface 

An overview of the ORA interface 

Below is an image of the ORA interface: 

 

The menu bar runs across the top of the window, and the rest of the screen is divided into 

three panels. 

Panel 1 displays a list of the Meta-Networks that has been loaded into ORA, its 

components and sub-networks. To view information about a particular meta-network or 

sub-network, single-click on it. 

Panel 2 displays information about the meta-network or sub-network highlighted in Panel 

1. 

Panel 3 displays information about the results of analyses run on your meta-network. 

269.2 Loading a meta-network into ORA 

You have three options for opening your meta-network in ORA: 

 From the main menu select File => Open Meta-Network. A small window titled 

Help: Opening meta-network pops up. Your data should already be in the correct 

format, so click [OK]. 

 Next, a file chooser titled Open pops up. Browse to the location of your dataset, 

single-click on it, and click the Open button in the bottom right corner. 
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 Click the first icon in the row directly below the menu bar. It looks like a half-

open file folder. A window titled Import Data into ORA will pop up. Click the 

Select Files button. A file chooser titled Open pops up. Browse to the location of 

your dataset, single-click on it, and click the Open button in the bottom right 

corner. You will be returned to the Import Data into ORA window. Click the 

Finish button in the bottom right corner.  

 In panel 2, click the Load button on the far right. A window titled Import Data 

into ORA pops up. Click the Select Files button. A file chooser titled Open pops 

up. Browse to the location of your dataset, single-click on it, and click the Open 

button in the bottom right corner. You will be returned to the Import Data into 

ORA window. Click the Finish button in the bottom right corner. 

A list of your meta-network and sub-categories in Panel 1, as well as the location and 

basic statistics of your meta-network in Panel 2 will appear. ORA is ready to begin 

analyzing the meta-network. 

269.3 The Visualizer  

To visualize a meta-network, first make sure the meta-network you wish to visualize is 

highlighted in Panel 1. If it is not highlighted, single-click on it. 

In Panel 2, click the Visualize this Meta-Network button. A new window will pop up 

displaying your meta-network graphically. A small legend also appears. 
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Below is a screen capture showing the visualization of the agent x event graph from the 

Stargate Summit Meta-Network. 

 

The visualization displays the connections between all items in the Sargate Summit Meta-

Network. The red circles represent the agents, the green circles represent individual 

events in the scenario, and the lines represent the connections between the agents and the 

events. 

You'll notice there are agents with no connections to any events. They represent nodes 

that were connected to the scenario but not to the particular events of the Summit 

timeline. 
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270 Lesson 2: Creating A New Meta-Network 

These lessons will give you the information in order to create a Meta-Network from data 

you have on-hand. 

270.1 Lesson - 101 

This section describes the process of looking over your data and deciding what is relavent 

for inclusion into a Meta-Network. It takes the examples I used for the Stargate dataset. 

270.2 lessons - 201-207 

A step by step run through of creating the Meta-Network from working with Excel, 

exporting data to csv files and finally building a complete Meta-Network. 

270.3 lessons - 301+ 

Lessons dealing with importing data from other programs. 
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271 101 - Examine Your Data 
271.1 General Thoughts 

When you first open up ORA you need to construct a MetaNetwork. But the question is, 

how do you go about this task?  

First, you need to understand what constitutes a MetaNetwork. The basic building blocks 

of all MetaNetworks is a Node*. Similar nodes are combined to build NodeSets*. 

NodeSets are combined to make Networks*. Multiple networks are combined to create a 

MetaNetwork*.  

It is up to you on HOW to construct the individual NodeSets and Networks and how to 

combine the Networks into a MetaNetwork. This means you need to gather as much 

information regarding the scenario as possible (who, what, when, where, and how) 

Knowing as much about the scenario as possible is important. Information about the 

people involved, where these people were seen, what items they had available and used, 

what they knew, what tasks they performed, what resources are needed to perform those 

tasks, etc. The more relevant information you collect the better your final MetaNetwork 

will be. 

271.1.1.1 For the purpose of creating the Stargate MetaNetwork 

the two-episode story arc (Summit / Last Stand) was choosen 

as the basis for all the nodes, nodesets, and networks. But even 

though the information was clearly on the tv screen, many 

intuitive decisions had to be made. 

271.1.1.2 For the Julius Caesar MetaNetwork both the play and 

spark notes were used as reference. As with the Stargate 

MetaNetwork many decisions were made about how to create 

datasets and what connexions would be required. 

I found that for the help file using a set of data where you know all the answers helps. But 

that won't always be the case. If you already know what the results are supposed to be 

then it's easy to build a correct Meta-Network.  

But the most important part of this is it helps you to learn what to look for. You'll initially 

make mistakes but if you instantly jump into creation mode then, well, since you're not 

sure how to build this in the first place then how can you be sure your Meta-Networks are 

built correctly in the first place? 

271.1.1.3 Initially the Stargate MetaNetwork was built with both 

the allies and the badGuys. This appeared to be the best way 

and it looked good displayed in the visualizer. But it was 

discovered that having the badGuys interfered with getting 

proper information from the reports. It wasn't until after the 

badGuys were removed that reports began to make more 

sense. What looks good in the beginning ISN'T necessarily 

your best option. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23n
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file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23n
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23m


 

487 

 

271.2 What's in a Node Class 

There are six major classes: Agents, Location, Events, Tasks, Knowledge, and 

Resources.. Nearly everything will fall into one of these six class. ORA contains the 

ability to create new Node Classes but in most cases that's entirely unnecessary because 

most of ORA measures are designed to work with most common six classes metioned 

above. 

271.2.1.1 With Stargate the agents were easy. The Stargate 

personnel, the Tok'ra, and some assorted others. The locations 

also were easy using scenes form the show. It was the events, 

knowledge, resources, and tasks which became slightly more 

difficult to discern. There were multiple false starts (missing 

some events, unnecessary locations, misplaced 

knowledge/resources) before I came to a proper conclusion. 

Initially I created extra Nodesets (like faction & groups). This 

did nothing but clutter up the MetaNetwork and make finding 

information much harder. 

271.2.1.1.1 The Julius Caesar Agent NodeSet was also easy using the cast 

of characters but it too had it's construction problems. Julius 

Caesar had limited resources so knowledge and resources were 

essentially combined into one NodeSet called knowledge. 

NodeSets can be either binary (0 or 1) or numbered (negative #, 0 or positive #). A 

MetaNetwork can contain a combination of the two. 

When building Node Classes and Networks (and then onward to MetaNetworks) you'll 

discover that many networks are are very apparent while others were almost invisible. 

You'll have some large networks while others may be extremely small. But all networks 

are necessary to produce the complete MetaNetwork. 

And the depth of the Node Classes can be extended by affixing attributes* to them. 

271.2.1.2 Stargate uses attributes to give extra information such as 

an agent's gender or time of death or the order in which 

events happened. 

271.2.1.2.1 Use the Julius Caesar attributes alligence and persuasion as a 

control mechanism to show the strength which various agents use 

these attributes. 

271.3 Agents (Who) 

It's usually best to start out by constructing the Agent NodeSet. This helps reveal many 

facets of the rest of the MetaNetwork. Gather all possible information about the Whos 

involved. Agents are the persons involved Stargates' daniel_jackson & 

jacob_carter_selmac and over at Julius Caesar Brutus and 1st Commoner. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23a
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271.3.1.1 The Stargate NodeSet contains a mere 16 agents. 

Originally I plotted both the allies and badGuys but found 

there was too much clutter and unnecessary nodes. Removing 

the badGuys helped streamline the NodeSet. 

271.3.1.1.1 The Julius Caesar NodeSet came in with more than twice as 

many. Unlike the Stargate NodeSet all of the characters were 

necessary. Everybody was plotting against everybody else. 

After you've collected all the agents involved you can proceed to creating your first 

network. Figure out which agents had any contact the situation and place a "1" in the 

corresponding cell. Depending on the particular circumstances you will have to establish 

criteria for an association. An Agent x Agent network creates a Square Network meaning 

the names in the rows are identical to the columns. 

271.3.1.2 The Stargate (and Julius Caesar) MetaNetworks were 

fairly easy to construct agent NodeSets and agent by agent 

Networks. Real life data doesn't always come with such an 

easy to see diagram. After a MetaNetwork is constructed it 

very likely that new information will surface which will 

change the face of the current MetaNetwork and, thusly, the 

results of any reports. 

There are three modes of thought in creating connections. 1) The most common would be 

to say if one agent knows another agent then place a 1 in the cell. 2) Next would be to use 

the preceding criteria but to weight the ties where one person could have a higher regard 

for a person more than there are reciprocal feelings. 3) The third would be to use a 

hierarchical style showing who reports to who in a organizational tree situation. It's 

important that the person creating the MetaNetwork makes a call whether there is and and 

how strong a tie will be. 

271.3.1.3 All three of these steps (unfortunately) were gone through 

in the creation of the Stargate MetaNetwork. Initially, using 

only binary data, the logic of the dataset was very fuzzy as to 

the exact nature of many of the connexions. Many of the allies 

knew many of the badGuys on a first name basis. Next 

weighted ties were tried with higher numbers for stronger 

connexions but the results that should have been - just 

weren't. It wasn't until a hierarchical style showing who 

reported to who was used did the results begin to ring true. 

271.3.1.3.1 The Julius Caesar MetaNetwork didn't have the same problems. 

It was apparent from the start that a weighted person-by-person 

network was the key. 

As you learn more about MetaNetworks it becomes easier to see which mode you need to 

use. 
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You might not create a MetaNetwork correctly the first time (or the second or the third 

time) if you rush into it. Best to take a little time and review the information before 

heading straight into the creation process. Sometimes too much information will find it's 

way into your MetaNetwork. 

271.3.1.4 On the first run for the Stargate MetaNetwork both the 

allies and the badGuys were placed in the network figuring 

both were needed for proper interaction. And it worked find 

until the reports had some badGuys popping up where they 

actually interfered with the results. So those nodes were 

removed and run the reports a second (or third time). This 

become a waste of time and effort. This solution was to create 

the dataset with only the allies. This then gave more reliable 

information in the reports. 

A little time spent on reviewing the data and any reports will great improve you chances 

of getting it somewhat right in the first place. It will also help in your deciding the best 

way to build your Networks. 

271.3.1.5 Originally, when both allies and badGuys were used, 

weighted ties were used to describe the connexions between 

various nodes. Each connexion between the nodes on the same 

side were individually weighted depending on how they felt 

toward that other node and weights between opposing sides 

were always less than "1". 

271.3.1.5.1 Originally the Network was done with binary ties but was 

changed to weighted ties. 

Remember, you'll always find something that you think needs tweaked as more and more 

information is uncovered. 

271.4 Locations (Where) 

Next create a NodeSet of all the locations involved in the scenario. Locations are places 

like Stargate's earth or revenna or Julius Caesar's battlefield or senate. 

271.4.1.1 For the Stargate MetaNetwork it was a simple matter of 

following the episode and marking down who was in what 

scene. Not quite a simple when you've got less than perfect 

data. 

271.4.1.1.1 Ditto for Julius Caesar If a character was in a scene location 

then a "1" was placed in that character's matrix cell showing he 

was there. 

Create a list of all possible locations and use your best guess as to whether that location is 

important. Remember, just because people are seen in a location doesn't mean it's 

important to the MetaNetwork. You may have a location you think is important initially 

but come to find that nothing happened of interest there (or visa versa). 
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271.4.1.2 For the Stargate MetaNetwork it was difficult to focus in 

on the exact locations necessary. The first time only the major 

locations were used, but it was difficult defining specific tasks. 

Then all locations were added but it ended up have many 

isolates and pendants that became unnecessary. 

271.4.1.2.1 For the Julius Caesar MetaNetwork there was the scene on the 

battlefield and various sub-scenes in individual battle-tents. It was 

decided to combine all the battle-tent scenes together. Individual 

tasks would be used to sort out the MetaNetwork. 

271.5 Events (When) 

Creating an Events NodeSets is a little more difficult than for either agents or locations. 

Agents and locations are tangible items whereas events are intangible. They also depend 

on the interpretation of the individual creating the NodeSet. Events can include items like 

Stargate's summit_meeting and gate_attack or Julius Caesar's Brutus speaks to citizens 

and Funeral of Julius Caesar. 

271.5.1.1 Many of the events in Summit scenario were easy (the 

meetings, the summit, the attack). But others were a little 

harder to discern. Initially there were a mere eight events. But 

shortly after it was found to be inadequate. After a quick re-

adjustment he number of events doubled. 

When plotting events it is sometimes necessary to show what order they occurred. What 

happened first, second, third, and so on. This helps discern which agents are needed in 

which parts of the scenario. 

271.5.1.2 In the Stargate MetaNetwork the event sequence shows 

the beginning event was the tollana_attack. This led to the 

sgc_meeting and onto the revenna_meeting. There the 

sequence split into two branches eventually both converging in 

on gate_attack. 

To create an ordered event x event network start with the row of earliest event. Place a 

checkmark in the column for the next event. Find the row for the column you just 

checkmarked. Follow that to the column with the next event. Proceed in this manner till 

you have all your events. You may, as happened in the Stargate Network, that two events 

sprout from a single event. They may, or may not. converge back to an ending. 

271.6 Tasks (How) 

Tasks are things that are done by the agents such as Stargate's replace_jarren and 

poison_summit and Julius Caesar's Kill Caesar and Attend Senate. 
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A task network can be set up to show the order that tasks need to be done in order for the 

scenario to be played out. For example, procuring materials to build something is always 

necessary before building something but not necessarily before planning. This is usually 

done with a directed graph (i.e. a link from procuring to building but not the other way 

around). 

271.6.1.1 As in the example of Events above certain tasks need to 

be completed before others can be started. Stargate uses a 

binary, directed network showing a pathway of which tasks 

are required to be completed before the next task can be 

started. create_poison, inflitrate_yuWorld, and 

create_memory_drug all needed done before 

present_plan_to_sgc. But none of this could have taken place 

without get_reole_chemical leading to the 

create_memory_drug. 

Tasks are exclusively attached to agents. You can't have a location, event, etc. performing 

a task. But this is not to say that you can't have a task attahced to a location as it might 

necessarily need to be done at a certain location. 

271.6.1.2 daniel_jackson could only perform the task 

poison_summit at the location hasaraSystem_spaceStation as 

that's where the event summit_meeting took place. He could 

not have done poison_summit on revenna or yu_homeworld. 

271.7 Knowledge (What) 

Many times more than one person knows the same thing. And other times there is a 

single person who has some vital knowledge. This is a way to help find out if one person 

is completely indispensable or whether there are other pathways to accomplishing the 

goal. 

271.7.1.1 In the Stargate MetaNetwork there are some knowledge 

which many agents have. But there are also some knowledge 

that only one person has. And if that person is taken out of the 

picture then the plan fails to materialize. 

271.7.1.2 Another situation is two people both having knowledge 

but it's much more important to one than the other. Both 

daniel_jackson and jacob_carter_selmak use spying but it's 

clear that jacob_carter_selmak is better at it than 

daniel_jackson. 

271.8 Resources (What) 

Resources can be very similar to knowledge and many times these two overlap. It's not 

necessary to always have both. 



 

492 

 

271.8.1.1 The Stargate MetaNetwork is was very necessary to 

separate the two as sometimes it was necessary to have 

knowledge regarding a resource before you could actually use 

that resource. Before Daniel could use the symbiote poison or 

the memory-altering drug he was required to have the 

knowledge of how the devices operated. 

271.8.1.1.1 In the Julius Caesar MetaNetwork there was no real reason to 

separate knowledge and resources. The resource NodeSet was 

simply not used for this dataset as it would have been redundant. 

There is no such constraint on learning how a dagger worked in 

Julius Caesar. 

Most of the Measures that can be run on knowledge have a corresponding measure that 

runs on resources. So some Meta-Network can eliminate one or the other. 

271.9 Networks 

After creating all your NodeSets you then move on to creating Networks. Every 

MetaNetwork will require a slightly different set of NodeSets and Networks. Below are 

the Stargate and the Julius Caesar NodeSets. The NodeSets in bold/italic are not 

contained in the other MetaNetwork. 

271.9.1.1 The Stargate NodeSet consisted of: agent x agent, agent x 

event, agent x knowledge, agent x location, agent x resource, 

agent, x tasks, event x event, event x resource, knowledge x 

tasks, tasks x event, tasks x tasks 

271.9.1.1.1 The Julius Caesar NodeSet consisted of: agent x agent, agent x 

event, agent x knowledge, agent x location, agent x tasks, event x 

event, knowledge x tasks, location x location, task x event, task x 

task. 

Notice that the two are almost identical but Stargate contains Networks for the Resource 

NodeSets. The Julius Caeasar used a location x location network. 

271.10 Difference between the two MetaNetworks 

The big difference was the construction of the agent x agent network. Julius Caesar was a 

weighted matrix with connexions to everyone an agent knew. The Stargate agent x agent 

network used a hierarchical method showing who reported to who. 

Another difference was the lack of a resource nodeset in Julius Caesar. There was no 

need as all that was placed under knowledge. Stargate, on the other-hand required 

separate knowledge and resources as it was sometimes necessary to have a certain 

knowledge before using a certain resource. 

The two datasets are very similar, most of the major NodeSets are contained in both. But 

the circumstances for each are unique which requires a slightly different set of NodeSets. 
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272 201 - Excel and CSV 

You learned from Meta-Network 101 about how to survey your data, the different forms 

it can take, and how to make it a fit for ORA. In this lesson we'll go through the 

procedure of creating a Meta-Network using the Stargate dataset in some practical 

examples. 

272.1 Your first NodeSet 

Your first NodeSet will more than likely be an Agent NodeSet since all other nodesets 

are either referred to/or by the agent nodeset. Review you data and make a list of the 

people involved. 

272.1.1.1 After watching the Summit/Last Stand episodes (a couple 

times) and reading various reviews on the storyline I came up 

with 16 agent nodes. My first thought was to only use the 

people involved in the assassination plot (The SGC and the 

Tok'ra) but found that two of the Gou'ald had vital 

interactions with the the team members. 

What program should be used to create the information?  

You need a program that can create .csv files that your system can read. Microsoft Excel 

is an excellent choice as it has good copy/paste features, multiple spreadsheets in one 

files, and known compatibility with ORA.  

The examples in the rest of this lesson will be using Excel in OSX. 

272.1.1.1.1 NOTE to MAC users: If you use Excel for OSX beware that 

there are two options for saving as a .csv. The first one you see on 

the list is the Mac-compatible version. You need to go lower on the 

list to find CSV (WINDOWS) option to save in a format compatible 

with ORA on Windows. 

The agent NodeSet was created with IDs A01, A02, A03,... A16 and the names of the 

agents were put in a column called agent. The order of the agents does not matter as long 

as you keep the relationship between IDs and agents consistent throughout your work. 

The IDs are what allows ORA to match various files. 

272.1.1.2 Column A contains my IDs A01, A02,... A16 and column 

B contains the names of all the agents in my Agent NodeSet. 

272.1.1.2.1 NOTE: I use A01 instead of A1 preferring to prefix the zero to 

the numbers less than ten. This assists when doing a sort within the 

editor. If you think that you will have a NodeSet with more than 100 

nodes then use A001, A002, ... 
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272.2 Your first Network 

Now that the agent NodeSet is done the next item is to create an agent x agent Network. 

As described in Meta-Network 101 just how your agents interact with one another is 

subjective to the type of Network you have. 

Insert a new spreadsheet in Excel and place the agent IDs running down in column A 

starting with row 2 and the same set of agent IDS in row 1 starting with column B. Then 

place your link values for the agent by agent connexions in this matrix. 

272.2.1.1 The Stargate example was done with a hierarchical 

method showing the chain of command. Nodes A02, A03, & 

A04 represent maj_samantha_carter, daniel_jackson, & teal'c 

who all report to col_jack_o'neill (node A01), leader of SG-1. 

jack_o'neill reports directly to gen_hammond (node A11). 

daniel_jackson, & teal'c, both being civilians, also report to 

gen_hammond and thusly have two links in the chain of 

command. maj_samantha_carter, being military, directly 

reports to her team leader, col_jack_o'neill. 
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272.3 The rest of the NodeSets and Networks 

Next you have to decide what other NodeSets you need... 

272.3.1.1 I created Stargate NodeSets for events: important events 

during the course of the scenario, knowledge: important 

information necessary for the completion of the mission, 

resource: material objects important to the mission, location: 

where particular events took place, and tasks: specific jobs for 

the completion of the mission. 

...and how these NodeSets need to interact with each other. 

272.3.1.2 For Stargate_summit I decided I needed: agent x agent, 

agent x event, agent x knowledge, agent x resource, agent x 

task, event x event, event x resource, knowledge x task, 

resource x taks, task x event, and task x task. 

Each Meta-Network will require different handling and may require more or less 

networks. 

Then, as done in the agent x agent network, decide how the various nodes interact 

with each other for each Network. When finished you will have one spreadsheet 

from which you can create all your .csv files. 

272.3.1.2.1 NOTE: I keep all my spreadsheets in one file for easy access. 

One set for the NodeSets and the other set for the Networks. 
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272.4 Saving as .CSV files 

The next step is to convert these Excel file to a format that ORA can import, namely the 

.csv format. This is easily done with Excel's Save As… function. Select the Excel 

spreadsheet you want to convert to CSV. From the Excel main menu select File => Save 

As…. Navigate to the directory to save your file, from the drop down menu select the csv 

format, and hit OK. Opening up this file in a text editor will reveal it's new format. 

272.4.1.1.1 NOTE to OSX Users: Remember to use the CSV (WINDOWS) 

option or else ORA will not properly recognize these csv files. 

 

You can now convert all your Excel spreadsheets to CSV files in preparation for 

importing into ORA. 
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273 202 - Import into ORA 

NOTE: If you are visiting this page from the help section on the Data Import Wizard, 

what follows is a series of lessons using the Data Import tool with the Stargate sample 

data set. You can start from the very beginning of this lesson by going to the preceding 

Meta-Networks 101 lesson)  

 

Now that we've got the Excel spreadsheets created and converted to .csv 

files it's time to learn abougt importing a CSV file into ORA. 

273.1 Starting a new Meta-Network 

From the main menu of ORA, select File => Data Import Wizard or hit Ctrl-O. For thse 

lessons we will be using only the first three options in this dialog box. With these you can 

open up both the table data and network data you created in Excel and work with 

attributes. 

 

We'll start with Create a meta-network from separate network files:. This will import a 

.csv file in the form of a matrix with labels on the X and Y axis (i.e. an agent by agent 

graph or resource by event and link data in the body). 

273.1.1.1 Below are the first four nodes of the 

stargate_agent_x_agent.csv file. 

 A01 A02 A03 A04 

A01 0 0 0 0 

A02 1 0 0 0 

A03 1 0 0 0 

A04 1 0 0 0 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\fileMenu\diw\diw.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn101.html
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The second option, Create a neta-network from table data: is used to import a .csv file in 

the form of a table (i.e. attribute data into a NodeSet). 

273.1.1.2 Below are the first four nodes of the 

stargate_agentNodeSet.csv file. 

id title gender 

A01 col_jack_o'neill male 

A02 maj_samantha_carter female 

A03 daniel_jackson male 

A04 teal'c male 

Select the Create a meta-network from separate network files radio button to create a 

Network and NodeSet. Then select the [Next] button. On the next screen select Create a 

new meta-network with ID: radio button (see below) and tab over to the textbox. Type in 

the name for the new Meta-Network then select the [Next] button at the bottom of the 

box. 

 

Select the [Browse] button and navigate to the directory with the saved .csv files. Select 

the agent x agent .csv file created earlier. In the two drop down menus select the types of 

nodes you are using. In this case both the Source type: and Target type: will be agent. In 

the Network ID: field, name the network (typically for this it would be agent x agent). 

The [ + ] button is used for adding more than one network (which will be explained in the 

next section). When all parts are completed, select the [Finish] button. 

 

Highlighting either the Agent: size 16 or the agent x agent line in Panel 1 and selecting 

the Editor tab will reveal the imported data. 
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273.2 Adding to the new Meta-Network 

You could, if you wanted, do each Network one at a time. But to save time you can 

import all your .csv files simultanously with the Data Import Wizard. For each new 

Network file to import, browse for the .csv file, define the Source Type: and the Target 

type:, and use the [ + ] button to add another row as needed. This can continue until you 

have listed all the Networks you want to import. 

NOTE: If at any time you want to remove a Network from the list select the [ - ] 

underneath its Network ID:. 



 

500 

 

 

When you have selected all your .csv node x node files select the [Finish] button. The 

result in Panel 1 is shown when I imported the 11 remaining Networks which in turn 

created six new NodeSets. 
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You could import all of your CSV Network files at one time and ORA will create all your 

NodeSets and Networks. Currently these NodeSets have no titles or attribute names. 

That's the next step in the process. 
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274 203 - Attributes 

NOTE : If you are visiting this page from the Data Import Wizard, what follows is a 

lesson on adding attributes to the Stargate sample data set provided with ORA. To begin 

the lesson from the very beginning go to Meta-Networks 101. 

 

All the NodeSets have been created when the Networks were imported. But without 

naming the individual nodes and without any attributes for those nodes it's very limited in 

it's information. Attributes help define nodes as individuals by designating what is special 

about each node. 

274.1 The Special Attribute, "Title" 

All attributes give information about the node they're attached to. But the title attribute is 

special. After importing the title attribute to a NodeSet it will lend this title to all 

Networks that use this NodeSet. 

NOTE: In the Stargate Nodeset the title attribute consists of the character's names. This 

is the standard operating procedure but exactly what you use as the title is entirely up to 

you. 

 

Currently the NodeSet and Networks created only contain IDs which are not very easy 

for discerning who is who.  

Below is an example using the first four nodes from the Stargate agent NodeSet (left) and 

the agent x agent Network (right). Truly this needs more definition 

 

Once again data needs to be imported to give it some meaning. But in this example the 

second option, Create a meta-network from table data will be used as we want to import 

attribute data for the NodeSet, not Network linking data. 

 

First let's add one attribute, the special title attribute. From the main menu select, File ⇒ 

Import Data Wizard. From the dialog box select the radio button labeled Create a meta-

network from table data. In the previous section the option to import a Network was used 

to import network data but here we only want to import specific columnar data. Select the 

[Next] button. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\fileMenu\diw\diw.html
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\lessons\L2-newMetaNetwork\mn101.html
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Since the Stargate Meta-Network is already created we want to use Add to the existing 

meta-network:. Actitivate the corresponding radio button and from the drop down menu 

select the correct Meta-Network to add the new attributes to. When done, select the 

[Next] button. 

 

Below is the main dialog box to inform ORA what and how to import the new attributes. 

After the image is a description of each of the numbered steps. 
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1. The [Browse] button allows you to navigate to the directory where the table data 

is held. Once a file is selected, hit the [OK] button and the file will be displayed in 

the textbox to the left. 

2. This sections gives the options for how ORA will search the new dataset. Placing 

a checkmark in the box alerts ORA to use this column to match up the data in a 

NodeSet. The Type: drop down menu selects the type of NodeSet it is. The Make 

unique checkbox will sequentially number any duplicate names in the column 

checked. (i.e. three nodes named tom become tom-1, tom-2, & tom-3) 

3. There are four ways to define and import attribute data. In this example select the 

Attribute tab. 

4. There are three dropdowns (for selecting Node IDs, Attribute Values, amd 

Attribute Type) and a textbox (for specifiying the Atribute name). 

o The Node IDs reflects the choices made in step 2 and its dropdown will 

contain all the checkmarks you placed in the boxes. With only one 

checkbox marked in Step 1 there is only one choice in this drop down. If 

more Node IDs were choosen in Step 2, then this drop down would 

contain them all. 

o Attribute Values contains all the names in the header row of the selected 

open file. 
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o Value Type gives you two choices: Categorical: which uses a finite set of 

values (i.e. gender: male/female) - and Continuous: which can contain an 

infinite number of choices (continuous implies numerical). The most 

common selection with Categorical. 

5. The [New] button creates a new row to import another atribute. The [Clear] clears 

the data... ALL THE DATA! 

6. The checkbox Create new nodes for unrecognized IDs allow for creating new 

nodes that aren't currently in the NodeSet. If a node appears in the data being 

imported that does not appear in the NodeSet choosen then ORA will only insert a 

new node if this checkbox is marked. For now we'll make sure it's unchecked. 

NOTE: The [Clear] button clears ALL data in that particular tab. 
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When finished entering information on this screen, select [Finish]. The NodeSet now 

contains names that match up to the IDs from the imported file. 
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274.2 Adding other Attributes and Values 

Now that the title attribute is in place the rest of the attributes can now be imported. This 

will be done in the same manner but all the attributes from a table file can be imported 

simultanously. 

 

In this case all the available attributes were imported by first selecting the [New] button 

then selecting from the drop down menus the Node IDs, Attribute Values and the Value 

Type. The entry was finished off by giving it a name in the Attribute Name column. 

When all the entries were finished the [Finish] button was pressed. 
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And the NodeSet is complete with Entity IDs, Entity Names, and the Attributes imorted 

from the dataset. 

 

This procedure can be followed for each NodeSet in the Meta-Network in order to Name 

the nodes and attach any attributes. 
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275 204 - Modifying a Meta-Network 

At this point the Meta-Network has been created and it contains the NodeSets and 

Networks. And each of the NodeSets contains titles and attributes in which to better 

define the NodeSets and Networks. But as with any dataset there will always be changes. 

Most certainly, as time goes on, NodeSets will require extra attributes or even new nodes. 

Possibly even new NodeSets will need to be created and worked into the Meta-Network. 

Or maybe a current set of attributes needs to be changed. What follows are the procedures 

to accomplish those tasks.  

275.1 Step 1: Adding a New Node 

In this section we'll add a new node to the agent NodeSet using the Create new nodes 

from unrecognized IDs checkbox. It's for the situation that the data being imported 

contains nodes that are not in the current NodeSet. 

The new .csv file we're using contains one new set of information, the 17th agent to add 

to the agent NodeSet. Upon importing the new node we will have a 17th node with the 

title attribute. 

id,title,position,symbiote,host,dies_when,dies,ally,group,servitude,gender,race,race-2 

A17,zipacna,,zipacna,unknown,,,no,anubis,anubis,male,gou'ald,human 

It was created in Excel file (the same way the other NodeSets and Networks were) and 

exported out to a new .csv file called stargate_zipacna.csv. 
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Call up the Data Import Wizard. Again, use the Create meta-network from table data 

option, then Add to the existing meta-network:. Chose your network from the drop down 

menu. The Import Data into ORA box will appear. 

 

1. Navigate to the directory where you placed the new .csv file. It will show up in 

the textbox to the left. 

2. Check the proper column to use for the node ID and from the drop down menu 

select the type of node. 

3. Select the Attribute tab. Then select the Node ID to use as reference, the Attribute 

Value to import, the Value Type (Categorical or Continuous). Finally, give it a 

name in Attribute Name. (For this example we'll be bringing in the "title" 

attribute). 

4. And most importantly, make sure the box Create new nodes for unrecognized IDs 

contains a checkmark in order to allow ORA to create new nodes. Without this 

checkmark ORA will ignore any nodeIDs that aren't already in the NodeSet. 
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When you review your agent NodeSet in the editor you will see a new entry at the 

bottom, the 17th node with zipacna in the Entity Title attribute. 

 

Now we move on to importing the other attributes for this new nodes. 
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275.2 Step 2: Importing the Attributes 

The new .csv file created previously to create the new node will now be used to import 

the rest of the attributes. 

Call up File => Data Import Wizard. This time we need to use the function Import node 

attributes from table data. This allows ORA to fill in the attribute values for the selected 

node(s) in the file. Then select the [Next] button. 

 

Next, make sure there is a checkmark only next to the Meta-Network you want to import 

into. When done, select the [Next] button. 
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1. Using the [Browse] button navigate to the directory with the csv file containing 

the information for the new node. 

2. In Step 1: choose how ORA will detect the new information. Use this column for 

node IDs: allows the user to pick which column to use and The rows are in the 

same order as the node class assumes that your data is in the same order as it is in 

ORA. For importing a single new node, or Nodesets that aren't in the same order, 

leave it on the first choice. 

3. In Step 2: you choose which attributes to import and denote its value type. For 

any attributes not to be imported, remove the checkmark next to it's name. 

4. Below this are buttons for [Select All>] and [Clear All] which do exactly as they 

say, select or remove all checkmarks. 

5. The checkbox, Create new nodes for unrecognized IDs:, which allows ORA to 

create new nodes for IDs not present in the selected NodeSet. 

6. Finally in Step 3: select the NodeSet to import the new nodes into. 

Below shows the before and after for the new node for Zipacna. All the data from the .csv 

file has been imported into the ORA NodeSet. 

 



 

514 

 

276 205 - Working with SubSets 

There will be times when you have a SubSet of a larger Meta-Network and you'll want to 

import data from a larger, main dataset. And you want to do this without creating new 

nodes. What follows are the procedures for accomplishing those goals.  

276.1.1.1 We start off with the SubSet of SG-1 team and the SGC 

commanding officer, a Meta-Network of five agents. 

 

The dataset to use has 17 agents with all their attributes. 
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Now, as before, navigate to the directory with your dataset, select the column with your 

node ID, select the Attribute tab and create new Attributes using the [New] button, and 

finally, the most important part, remove the checkmark from the box next to Create new 

nodes for unrecognized IDs. Its the removing of this checkmark that will prevent ORA 

from creating extra nodes and only import data for the nodes in the selected NodeSet. 

 

The result is maintaining a NodeSet with five nodes but attribute data imported only for 

the five nodes in the NodeSet. No new nodes will be created in this process. 
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277 206 - Attribute Columns 

There are three functions that can done with Attributes: 1) Edit and Attribute name; 2) 

edit Attribute type, and; 3) Delete an Attribute. 

All three are accomplished by Right-clicking on the Attribute Name to bring up the 

contextual menu. 

 

Edit Attribute Name 

Used for renaming an existing Attribute column. 

Edit Attribute Type 

Attributes can be tagged with two types: Categorical or Continuous. 

Delete Attribute 

Removes an Attribute column from a NodeSet. 

277.1 Replacing an Attribute Column 

NOTE: This method is suggested as ORA has the capability of retaining multiple values. 

If you want to completely replace the values then deletion and replacement of the column 

is suggested. 

 

For most small changes you can type in a new attribute value or two directly into the 

Editor. But say your NodeSet contained quite a few nodes, and the majority of the values 

needed changed. If might be easier to create a new .csv file and import the values in just 

as in the previous lesson. In the example below it was decided to completely replace all 

the skill_needed with a new set of values. 
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Go to the ORA main interface and select the NodeSet. Then select with the attribute 

column you want to change. Right-click on the attribute name which brings up the 

contextual menu. Select Delete Attribute to remove it from the NodeSet. 

 

After deleting a column then use the procedure for importing Attributes from Lesson-203 

to import a new attribute information. Remember, you'll want to import into an Existing 

Meta-Network as in the example above. 

 

The skill_needed attribute has been imported into the NodeSet with the revised values. 
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278 207 - Updating Your Data Files 

After importing data from the .csv files into ORA and then altering the data in ORA this 

somewhat makes your original data files out-of-date.  

What follows are the procedures to update your original .csv and Excel files with any 

changes that have been made recently. 

278.1 Saving Your Network Data 

From the main interface highlight the Network you want to save and Right-Click. This 

will bring up a contextual menu. Select Save Network. 

 

This will bring up a Save dialog box. First, navigate to the directory you want to save 

your new Network file. Next, select the format (DyNetML, UCINET, DL, or CSV) to 

save the file. Give it a filename and select [Save]. 
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Saving to each of the four formats creates five files. 

278.1.1 REMEMBER: The UCINET uses both .##d and .##h 

extensions and both are needed to build a Meta-Network. 

 

NOTE: Since this Save box does not display the files present in the directory it is Highly 

Suggested that you save to a new directory and verify which previous file you want to 

replace. More information on these file formats can be found HERE 

278.2 Saving Your Attribute Data 

The above mentioned procedure works well for saving Networks but there are also the 

attributes in the NodeSets to think about. All the data is can be saved from File ⇒ Save 

Meta-Network and the File => Save Meta-Network…. But this saves the data into one 

xml file. What if you what to save the data into individual files, the same as when you 

imported it. 

The quickest way is using the Copy / Paste method. Values copied directly from the Main 

Interface Editor can be pasted into a Excel spreadsheet. 

In the ORA editor, highlight the cells you need to copy. Use either Ctrl-C or Edit => 

Copy Editor Values. 

 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\fileFormats\fileFormat.htm
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\mi\editMenu\cpValues\cpValues.html
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Then switch to your Excel spreadsheet. Highlight the cell that corresponds to the top/left 

cell you started with in ORA and use either Ctrl-V or Edit => Paste. Entire NodeSets can 

be done in this fashion. 

 

IMPORTANT NOTE: Before you Copy/Paste in this manner make sure your columns are 

in the same order. This operation will NOT match up data as it's a blind copy/paste 

operation. 

 

You can then backup all of your NodeSets in the procedure and then re-

save it to your .cvs files. 
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279 301 - Import Analyst Notebook 

What follows are procedures to import data from I2 (Analyst Notebook): 

The data needs to be exported from I2 into comma-separated or tab-separated files. There 

is one file for nodes and another for links. 

Both of these files need to be custom imported because I2 allows the user to have custom 

fields - they are not fixed, and so the importer needs to provide ORA with information in 

order to import. 
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280 Lesson 3: Key Entity Report  
280.1 The Reports 

A Key Entity Report creates the following reports: central actors, organizations, central 

knowledge, resources, central events, tasks, central locations, and performance indicators.  

The Key Entity Report can either run its measures over the entire network or be refined 

or filtered to run them over only a select portion of the network. 

More detailed information regarding the basic workings of the Key Entity Report screens 

can be found Reports Section.  

280.2 Running a Key Entity Report: 

We'll be using the network Stargate: Summit contains all the agents involved in the 

scenario, friend and foe. The first report run will contain all the agents, friend and foe. 

 From the main mennu select Analysis => Generate Reports which brings up the 

Generate Reports dialog box.  

 At the top of the window is a dropdown menu titled Select a Report. Pull down 

the menu by clicking the small inverted arrow icon to its right, and select Key 

Entity.  

 In the box titled Select one or more meta matrices: select the network to run the 

report on.  

 At the bottom of the box is the Transform options. 

o General Mathematical Transformation : Contains various formulas for 

manipulating a network. 

o Remove Entities : Remove node(s) from a network before running the 

measures. 

o Partition entities into separate meta matrices by attribute value : Create 

new networks based on your choice of nodes and attributes. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\reports\keyEntity\keyEntity.html
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Select the [Next >] button at the bottom of the dialog box. 

 

The next dialog box is for selecting the number of ranked nodes, critical attribute and 

values and also for selecting which reports you want to view. I am only interested in the 

top five nodes in the network and place a 5 in the top box. I don't want to point out any 

particular nodes, only the friends, so I'll leave the textbox blank. I want all the reports run 

so I place a checkmark in all four boxes. 

Click the [Next >] button. 
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The last dialog box is for selecting what type of format for the final reports and the 

directory to place them. Text will create reports that will appear in Panel 3 of the 

interface, HTML* creates reports that will open up your browser, and CSV* creates files 

that are usable in ORA. The bottom section allows you to navigate to a directory where 

you want to save your files. 

280.3 Remove Nodes from a Key Entity Report: 

Next we'll look at removing nodes from the report. The network Stargate: Summit 

contains both the friends and foes in the scenario. But say you only want to see only how 

the friendly agents interacted. Being that there's an ally attribute this will make it simple 

to eliminate the foe agents. 

Follow the same procedure as above except click in the Remove entities radio button. 

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
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In this example we're going to eliminate a portion of the network before we run the 

measures. Select the Remove entities button. Then select the [Next >] button at the 

bottom of the dialog box. 
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In this dialog box you can select exactly which nodes to remove. 

 

The top section, Filter Commands, allows you to create a single filter or compound them 

and force it to Match all filters. 

The bottom sections contains tabs which further allow you to refine your filter. There is a 

tab for each nodeset in your network. 

I only want to run the measures on the Allies so I select the agent tab, scroll over to the 

ally tab, and in the dropdown menu I select no. This will call up all the non-ally agents. I 

then click the [Select All] button which places a checkmark in each box effectively 

removing them from the network. 

Click the [Next >] button. 
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The next dialog box is for selecting the number of ranked nodes, critical attribute and 

values and also for selecting which reports you want to view. I am only interested in the 

top five nodes in the network and place a 5 in the top box. I don't want to point out any 

particular attributes so I'll leave the textbox blank. 

Click the [Next >] button. 
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The last dialog box is for selecting what type of format for the final reports and the 

directory to place them. Text will create reports that will appear in Panel 3 of the 

interface, HTML* creates reports that will open up your browser, and CSV* creates files 

that are usable in ORA. The bottom section allows you to navigate to a directory where 

you want to save all your files. 

280.4 Comparison of the two reports 

As the reports are rather large, let's compare a small portion of cognitive effort from the 

reports. 

      

All agents Allies-only 

Rank Value Agent Rank Value Agent 

1 0.340911 jacob_carter_selmak 1 0.354626 jacob_carter_selmak 

2 0.257479 ren'al 2 0.284762 daniel_jackson 

3 0.248333 daniel_jackson 3 0.284218 ren'al 

4 0.205698 olokun 4 0.166667 maj_samantha_carter 

5 0.205698 morrigan 5 0.164218 teal'c 

The left-hand column shows all nodes, including the non-allies olokun and morrigan. But 

after eliminating the non-allies two friendly agents take their place. You'll also notice that 

daniel_jackson and ren'al swapped places. With various links removed, after eliminating 

the non-allies, the order of the remaining nodes can shift. It should also be noticed that 

the rating for jacob_carter_selmak has increased elevating his position as Emergent 

Leader. 

280.5   

file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
file:///C:\Documents%20and%20Settings\default\My%20Documents\SVN\ora_java\include\OraFiles\help\Topics\start\basicTerms\basicTerms.html%23c
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281 Lesson 5: Over-Time Analysis 
281.1 Performing a View Network Over-Time Analysis 

What follows are procedures to perform a View Network Over Time and View Measures 

Over Time Analysis.  

To either requires multiple network datasets representative of your network over different 

time periods. The goal is to analyze how a network changes across multiple time periods. 

The time period is determined by the intervals of collected network data and presented as 

multiple Meta-Networks, which are loaded into ORA in sequential order. The steps 

below provide detailed instruction on how type of analysis. 

To perform a View Network Over-Time Analysis, you must load Meta-Networks that 

relate to different time captures of your network data, which need to be in the form of 

multiple Meta-Networks. 

In the following example, we will use network time captures of the 1998 Embassy 

Bombing in Tanzania Meta-Network data set and compare the same data set as we knew 

it in 1997 and 1996 and 1998. We will then compare all the Meta-Networks in the 

Network Over-Time Viewer to gain a visual representation of how this network changed 

between 1996 and 1998. 

 

Note: For our purposes, we have changed data in this example and have renamed the 

Meta-Network for three different years. This will denote different network variables that 

have changed over time. 

 

You will see in the left window pane under input dataset three Meta-Networks, 1998, 

1997, and 1996, have been loaded. 
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From the menu bar: File => Open Meta Network 

 

281.1.1.1 Choose [Select Files] 
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You will see all of our example data sets, which will load simultaneously into ORA, buy 

highlighting and selected all the files. 

281.1.1.2 Highlight all files you analyze in Over-Time Viewer. 

Press [Enter]. 

 

The import data window will appear (below). This will confirm the files you wish to 

analyze. 

 

281.1.1.3 Select [Finish]. 
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All three Meta-Networks should display in Panel 1. 

 

281.2 Performing the Over-Time Analysis 

Now that we have time captures of our network data represented and loaded into ORA in 

the form of three Meta-Networks relating to 1996, 1997 and 1998, we can perform the 

Over-Time Analysis. 

281.2.1.1 From the Menu Bar => Data Visualization => View 

Network Over-Time 

 

The ORA Visualizer will render all of the loaded Meta-Networks. 

Please take special note of the Time Viewer pop-up Window. This window displays a 

slider, which will allow you to quickly change from the first Meta-Network time capture 

of 1996, to 1997 and 1998 respectively. 
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By moving the slider from one Meta-Network to the next, you will gain a visual 

perspective on how the network has changed over Time. 

The series of screen shots below display how the visualized data changes from one slider 

to position to the next. This allows you a picture of how the network changes Over-Time. 

 

Please note: Depending on the complexity of the network and the extent to which 

relationships (ties) have changed, the visualization of those changes may be subtle. 

 

The screen shots below, however, will emphasize the extent to which the role of the 

WTC Event entity has changed from 1996 to 1998 in relation to the network of which it 

is part of namely the Tanzania data set. Below these screen captures, are a series of detail 

screen captures focusing on the WTC Event node. 

281.3 Example Slider Position 1 
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281.4 Example Slider Position 2 

 

281.5 Example Slider Position 3 
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Detail of WTC Event Node when visualized in the Over-Time Viewer as part of the 

1996, 1997 and 1998 Tanzania Data Sets. 

281.6 WTC Event Node: Detail 1 - 1996 

 

281.7 WTC Event Node: Detail 2 - 1997 

281.7.1 Notice who how the relationships of this node to the rest of 

the network has changed from 1996 to 1997. 
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281.7.2 Notice that the connections (links) have changed from 1996 to 

1997. 

 

As you can see, as we progress through the data sets pertaining to 1996, 1997 and 1998, 

the event node WTC lost direct ties to other parts of the network. In the 1996 data set, 

WTC had 3 ties to other entities in the Tanzania Embassy network; In 1997, only 2; 

Finally, in 1998, the WTC event node had only 1 link to Tanzania Network. This may 

indicate that the WTC node may have lost importance from one year to the next. 

281.8 Summary of Lesson 

At this point, you should be able to complete the following tasks to perform an Over-

Time Network Analysis. 

 Load multiple Time Data Captures in the form of Meta-Networks, which are 

representative of your network (Meta-Network) over time. 

 Use the Over-Time slider window tool to move from one time capture to the next. 

 Gain a visual perspective of how your overall network has changed from one time 

capture to the next. 

281.9 Performing the View Measures Over-Time Analysis 

ORA provides an alternative method to analyzing your network data (in the form of 

Meta-Networks captured over time) than the only in the Visualizer.  

By running a View Measures Over Time analysis you can visualize how your network 

changes in relation to any given measure in the form of charts, which take you from one 

time point to the next.  
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Below is a series of screen captures and instruction on how to access the View Measures 

Over Time feature: 

281.9.1.1 From the main menu bar: Data Visualization => View 

Measures Over Time 

 

281.9.1.2 Select View Measures Over Time. 

 

281.9.1.3 Select [OK] 

The View Measure Over Time Window will appear. You will see that this window is 

primarily organized into three sections. 

Area 1: is a slider where you can control various inputs that affect the aggregation level 

of your Meta-Networks. 

Area 2: is a tabbed index allowing you to select the graph level you desire and the 

individual entity sets you are interested in analyzing.  

Area 3: displays the actual chart based on the measures you selected in the tabbed index 

and the position of the aggregation slider. 
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281.10 Interpreting The Results After Performing View Measures Over-Time 

Analysis 

In the example above, we have loaded all three of our network time captures into the 

View Measures Over Time Analysis tool. The result of our analysis, as we have indicated 

before, will be displayed as a chart in the bottom section of the ORA interface in Panel 3. 

But, what does this tell us? To find out, we will examine the Graph Level measure 

Knowledge Waste. From the tabbed measures window: 
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281.10.1.1 Graph tab > Congruence, Organization Measure, 

Knowledge Waste. 

The result is displayed below. 

 

We can see the chart displays an axis scale correlating to our networks over time. The 

graph level measure of Knowledge Waste was selected using the View Measures Over 

Time tool and the result is displayed in the chart area of the window. 

 

We can see that the graph level measure of Knowledge Waste held a value slightly above 

40 in the first Meta-Network, 1996, displayed with 1 on the Time axis. We can deduce 

from the chart that in 1997 something affected our measure of Knowledge Waste to 

increase the value to nearly 60. This corresponds to the time scale axis of 2, which 

represents 1997, our second year of network data. In the final year, 1998, our measure of 

Knowledge Waste declined to the value in 1996. This should be visually evident with its 

relative line graph position. 

 

It is clear that the value for the Knowledge Waste Measure increased from the first Meta-

Network (1996) to the second (1997) and then retreated back to its original (1996) level. 

It would be up to you to determine what may have affected that measure for it to undergo 

this progression and regression. 

281.11 Summary of Lesson 

At this point, you should be able to complete the following tasks to perform a View 

Measures Over-Time Analysis: 
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 Load multiple data files into ORA (in the form of Meta-Networks) representative 

of your network across certain periods of time. 

 Select an aggregation level and choose a graph level or entity set to analyze. 

 Analyze the data output in the charting tool located in the bottom section of the 

View Measures Over Time window. 

 See how your network may have changed from one time capture to the next for 

any given graph level or entity node measure. 

 Use this visual comprehension to draw conclusions about how your network 

changed across multiple time period. 
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282 Lesson 8: Network Converter 
282.1 Load Network 

The Network Converter is used for changing dataset file formats. 

 

If you have Analyst Notebook data then select the [Analyst Notebook >>>] button to 

reveal the section. Select the [<<< Analyst Notebook] button to hide it. 

 

282.2 Transform Network 



 

542 

 

 

Create bipartite: Creates a set of nodes decomposed into two disjoint sets such that no 

two nodes within the same set are adjacent. 

Remove isolate nodes: If the Meta-Network you are transforming contains any Isolate 

nodes they will be removed in the transformed Meta-Network. 

Remove pendant nodes: If the Meta-Network you are transforming contains any 

Pendants nodes they will be removed in the transformed Meta-Network. 

Symmetrize by method: The two options are Minimum or Maximum. Symmetrizing 

turns a directed or asymmetric network data into un-directed or symmetric data. Both 

methods use a pair of values from the upper and lower portions of the table 

[Transform] button: Performs any of the checkmarked functions above. 
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[Make IDs Canonical] button: Removes leading and trailing spaces, replaces internal 

spaces with underscores, replaces apostrophes with dashes, and converts everything 

to lowercase. (NOTE: works on IDs only, does not touch the Title Attribute) 

[Load and Apply Thesaurus] button:  

Make thesaurus canonical:  

[Move Node IDs to Node Titles] button: Moves the values in the Entity ID column 

into the Entity Title Column and renumbers the Entity ID. 

[Move Titles IDs to Node IDs] button: Moves the values in the Entity Title column 

into the Entity ID column and deletes the Entity Title column. 
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282.3 Node Sets 

The Node Sets tab allows you to alter what, and how, a Meta-Network will be converted. 

It starts with a list of the NodeSets and empty checkboxes 

 

282.4 Nodes Add 

You can add a node to any set by placing a checkmark in the NodeSets' box and selecting 

the [Add] button. For this example a checkmark was placed in the Agent box and the 

[Add] button is selected. The dialog box will ask how many nodes you want to add. 

 

Type in the number of nodes to add, in this case we'll only add 1, and select [OK]. The 

AGENT section accordians to show a new agent node, 17. 
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282.5 Nodes Delete 

Now say you want to delete an agent, say 17. Place a checkmark in the checkbox and 

select the [Delete] button and it will be removed. 

 



 

546 

 

282.6 Nodes Merge 

The third button in the Nodes section is [Merge]. With this function you can combine two 

or more nodes into a single node. Here I place checkmarks next to the members of SG-1 

to combine them into a single node. 
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After selected the [Merge] button the Merge AGENT Nodes dialog asks me to give it 

both an ID and Title. I give it an ID unique from the original dataset, A17, and an unique 

Title, sg-1. 

 

col_jack_o'neill, daniel_jackson, maj-samantha_carter, & teal'c have been removed and 

the new node, sg-1 has been added. 
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282.7 Node Properties 

This section allows you to Add/Edit/Delete attributes to individual Nodes in a NodeSet. 

One important plot point was finding a human who spoke Gou'ald, and that was 

daniel_jackson. Place a checkmark in his box. 
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550 

 

Select the [Add] button to bring up the Add AGENT Attribute window. in ID: type in the 

name of the new attribute. In Title: type in the value. Then select [OK]. 

 

daniel_jackson now has the attribute speak-gou'ald=yes. 
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But other agents also spoke the language. But instead of adding them one at time place a 

checkmark in the box next to each agent that will receive that attribute. Then select [Add] 

and specify the attribute and value as done previously. 

 

NOTE: Be sure to spell the attribute the same or ORA will add it as a different attribute. 

 

Save this new MetaNetwork under a new name. Select the Save Network tab, select the 

[Save…] button, and save it under a new name in the directory of your choice. Close the 

Network Converter window. 
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Open up the new MetaNetwork form the main menu, File ⇒ Open Meta-Network…. 

Viewing the agent NodeSet, select the Editor tab. A new attribute column, speak_gou'ald, 

shows the values inserted by the Network Converter. 
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282.8 Graphs 

 

282.9 Save Networks 
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286 Glossary 

A 

Adjacency Matrix – A Matrix that is a square actor-by-actor (i=j) matrix where the 

presence of pair wise edges are recorded as elements. The main diagonal, or self-tie of an 

adjacency matrix is often ignored in network analysis. 

Aggregation – Combining statistics from different entities to higher entities. 

Algorithm – A finite list of well-defined instructions for accomplishing some task that, 

given an initial state, will terminate in a defined end-state. 

Attribute – Indicates the presence, absence, or strength of a particular connection 

between entities in a Matrix. 

B  

Betweenness – Degree an individual lies between other individuals in the network; the 

extent to which an entity is directly connected only to those other entities that are not 

directly connected to each other; an intermediary; liaisons; bridges. Therefore, it's the 

number of entities who an entity is connected to indirectly through their direct links. 

Betweenness Centrality – High in betweenness but not degree centrality. This entity 

connects disconnected groups, like a Go-between. 

Bimodal Network – A network most commonly arising as a mixture of two different 

unimodal networks*. 

Binarize – Divides your data into two sets; zero or one. 

Bipartite Graph – Also called a bigraph. It's a set of entities decomposed into two 

disjoint sets such that no two entities within the same set are adjacent. 

C 

Caesar III – An application for the design of information processing and decision 

making organizations. An application for the design of decision making organizations at 

the operational and tactical levels; it takes into consideration cultural differences in 

coalitions and of adversaries. This tool is under development by George Mason 

Univeristy.  

Categorical – An Attribute Type used primarily used for grouping nodes. 

Centrality – The nearness of an entity to all other entities in a network. It displays the 

ability to access information through edges connecting other entities. The closeness is the 

inverse of the sum of the shortest distances between each entity and every other entity in 

the network. 

Centralization – Indicates the distribution of connections in the employee 

communication network as the degree to which communication and/or information flow 

is centralized around a single agent or small group. 

Characteristic Path Length – The median of the average shortest distances (number of 

links) connecting each employee to all other employees.  

Interpretation  
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Characteristic path length gives a insight into how information spreads. It reflects the 

communication performance of the entire network and is important for diffusing 

information and routing information to the right people. A small average path length 

results in fewer "hops" where individuals or groups don't get information. 

Classic SNA density – The number of edges divided by the number of possible edges not 

including self-reference. For a square matrix, this algorithm* first converts the diagonal 

to 0, thereby ignoring self-reference (an entity connecting to itself) and then calculates 

the density. When there are N entities, the denominator is (N*(N-1)). To consider the 

self-referential information use general density. 

Clique – A sub-structure that is defined as a set of entities where every entity is 

connected to every other entity. 

Clique Count – The number of distinct cliques to which each entity belongs. 

Closeness – Entity that is closest to all other Entities and has rapid access to all 

information. 

Clustering coefficient – Used to determine whether or not a graph is a small-world 

network. 

Cognitive Demand – Measures the total amount of effort expended by each agent to do 

its tasks. 

Column Degree – see Out Degree*. 

Complexity – Complexity reflects cohesiveness in the organization by comparing 

existing links to all possible links in all four networks (employee, task, knowledge and 

resource).  

Complementarity – The idea that people seek others with characteristics that are 

different from and complement their own, aka the idea that opposites attract. 

Concor Grouping – Concor recursively splits partitions and the user selects n splits. (n 

splits -> 2
n
 groups). At each split it divides the entities based on maximum correlation in 

outgoing connections. Helps find groups with similar roles in networks, even if dispersed. 

Congruence – The match between a particular organizational design and the 

organization's ability to carry out a task. 

Construct – A reduced form of Construct is found in ORA in the Near Term Impact 

Report. 

Continuous – A Attribute Type primarily used for values that are numerical so that 

statistical analysis can be be performed (Average, Minimum, Maximum, and Standard 

Deviation). 

Count – The total of any part of a MetaNetwork row, column, entity, edge, isolate, etc. 

CSV – File structure meaning Comma Separated Value. Common output structure used 

in database programs for formatting data. 

D  

Degree – The total number of edges to other entities in the network. 

Degree Centrality – Entity with the most connections. (i.e. In the know). Identifying the 

sources for intel helps in reducing information flow. 

Density –  
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 Binary Network: The proportion of all possible edges actually present in the 

Matrix. 

 Value Network: The sum of the edges divided by the number of possible edges. 

(i.e. the ratio of the total edge strength that is actually present to the total number 

of possible edges). 

Dyad – Two entities and the connection between them. 

Dyadic Analysis – Statistical analysis where the data is in the form of ordered pairs or 

dyads. The dyads in such an analysis may or may not be for a network. 

Dynamic Network Analysis – Dynamic Network Analysis (DNA) is an emergent 

scientific field that brings together traditional Social Network Analysis* (SNA), Link 

Analysis* (LA) and multi-agent systems (MAS). 

DyNetML – DynetML is an xml based interchange language for relational data including 

nodes, ties, and the attributes of nodes and ties. DyNetML is a universal data interchange 

format to enable exchange of rich social network data and improve compatibility of 

analysis and visualization tools. 

E 

Edge – See Link. 

Entity – A who, what, where, how, why, or thing that is being studied such as people, 

agents, organizations, beliefs, expertise, resourse, tasks, events, or locations. Node the 

representation of a single entity (a who, what, where, how why item). 

Entity Class – A set of entities of one type. 

Entity Level Metric – is one that is defined for, and gives a value for, each entity in a 

network. If there are x entities in a network, then the metric is calculated x times, once 

each for each entity. Examples are Degree Centrality*, Betweenness*, and Cognitive 

Demand*. 

Entity Set – See Meta-Node. 

Eigenvector Centrality – Entity most connected to other highly connected entities. 

Assists in identifying those who can mobilize others 

F  

FOG – (F)uzzy (O)verlapping (G)roups. Gives a better understanding of individuals 

spanning groups. Fuzzy groups are a more natural and compelling way of thinking of 

human social groups. 

G  

General density – The number of edges divided by the number of possible edges 

including self-reference. For a square matrix, this algorithm* includes self-reference (an 

entity connecting to itself) when it calculates the density. When there are N entities, the 

denominator is (N*N). To ignore self-referential information use classic SNA* density. 

Geodesic Distance – A generalization of the notion of a straight line to curved spaces. In 

presence of a metric, geodesics are defined to be (locally) the shortest path between 

points on the space. 
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Gini coefficient – The measure of inequality of a distribution of income. Uses a ratio 

with values between 0 and 1: the numerator is the area between the Lorenz curve of the 

distribution and the uniform (perfect) distribution line; the denominator is the area under 

the uniform distribution line. 

Graph Level Metric – A metric defined for, and gives a value for, the network as a 

whole. The metric is calculated once for the network. Examples are Centralization, Graph 

Hierarchy, and the maximum or average Betweenness. 

GraphML – GraphML is a comprehensive and easy-to-use file format for graphs. It 

consists of a language core to describe the structural properties of a graph and a flexible 

extension mechanism to add application-specific data. 

Group – a collection of things (entities, nodes, ties, networks).   A group might at times 

be represented as a meta-node.   Nodes may be classified in to groups on the basis of a 

shared attribute, type, id-range, label, user selection, etc.   For example, if you have a set 

of people and know their gender, then their might be two groups - men and women.   In 

addition the nodes representing those people could be displayed as a meta-node for men 

and a meta-node for women.   Nodes may be classified in to groups on the basis of a 

grouping algorithm.   For example, if you have a network showing connections among 

members of an organization and you run a grouping algorithm it will return clusters of 

nodes that fit together on some mathematical criteria.   This cluster is a group and can be 

represented as a meta-node. 

H  

Hamming Distance – Number minimum number of substitutions required to change one 

string into another string of equal length. (i.e. "toned" and "roses" is 3.) 

Heuristics – Problem-solving by trial and error: a method of solving a problem for which 

no formula exists, based on informal methods or experience, and employing a form of 

trial and error iteration. 

Homophily – (i.e., love of the same) is the tendency of individuals to associate and bond 

with similar others. 

 Status homophily means that individuals with similar social status characteristics 

are more likely to associate with each other than by chance. 

 Value homophily refers to a tendency to associate with others who think in 

similar ways, regardless of differences in status. 

HTML – HyperText Makup Language. 

I  

In-Degree – The sum of the connections leading to an entity from other entities. 

Sometimes refered to row degree. 

Influence network – A network of hypotheses regarding task performance, event 

happening and related efforts. 

Isolate – any entity which has no connections to any other entity 

L  
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Latent Semantic Analysis – Latent semantic analysis (LSA) is a technique in natural 

language processing, in particular in vectorial semantics, of analyzing relationships 

between a set of documents and the terms they contain by producing a set of concepts 

related to the documents and terms. 

Lattice Network – A graph in which the edges are placed at the integer coordinate points 

of the n-dimensional Euclidean space and each entity connects to entities which are 

exactly one unit away from it. 

Link – The representation of the tie, connection, relation, edge between two nodes. 

Link Analysis – A scientific area focused on the study of patterns emerging from dyadic 

observations. The relationships are typically a form of co-presence between two entities. 

Also multiple dyads that may or may not form a network. 

Link Class – A set of Links of one type. A set of links of one type can be represented as 

a meta-link. 

M  

Main Diagonal – in a sqaure matrix this is the conjunction of the rows and cells for the 

same entity. 

Math Terms 

These mathematical terms and symbols are used: Let S be any set: 

 card(S) = |S| = the cardinality of S (the cardinality of the entity-sets is represented 

as |A|, |K|, |R|, |T|) 

 ℜ denotes a real number 

 Z denotes an integer 

Matrix Algebra – The part of algebra that deals with the theory of matrices. 

Measure – A measure is a function that maps one or more networks to R
n
. Measures are 

often scalar (n=1) or vector valued with n=|V| or n=|U|. 

Meta-Link – The representation of a Group of Links. 

MetaNetwork – See Meta-Network 

Meta-Network – The representation of a Group of Networks. 

Meta-Node – A representation of a Group of nodes. 

Monte Carlo – A random optimization of your organization 

MRQAP - This describes a report in ORA. See Reports for more information. For 

multivariate cases, if your dependent variable is continous or count data (like in a 

negative binomial case), you should use MRQAP. If your dependent variable is binary, 

you should use ERGM (P*) which is forthcoming in ORA. One can perform MRQAP on 

data that have a dichotomous dependent variable (basically, this is equivalent to using a 

linear probability model). You do need to interpret your results accordingly. 

Multi-Agent System – A loosely coupled network of problem-solver entities that work 

together to find answers to problems that are beyond the individual capabilities or 

knowledge of each entity 

Multi-entity – More than one type of entity (people, events, locations, etc.). 

Multi-plex – Network where the links are from two or more relation classes. 

Multimode Network – Where the entities are in two or more entity classes. 
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N 

Neighbors – Entities that share an immediate edge to the entity selected. 

Network – The representation of a set of nodes (including meta-nodes) of one type and 

the links (including meta-links) of one type between them. 

A network N is a triple consisting of two sets of entities, called U and V, and a set of 

edges E⊂UxV. Thus, we write N=(U,V,E). An element e = (i,j) in E indicates a 

relationship or tie between entities i∈U and j∈V. A network where U=V and therefore 

E⊂VxV is called unimodal*; otherwise the network is bimodal*. We write G=(V,E) 

for unimodal* networks. For our purposes, unimodal networks will not contain self 

loops, which means that (i,i)∉E for i∈V. 

Network Class – A set of Networks on one type. This can also be represented as a Meta-

Network. 

Network data format – usually comes in the form of NodeSet 1 listed vertically in 

column A starting in row 2 and NodeSet 2 listed horizontally in row 1 starting with 

column B. All the intersecting cells are the links between each of the nodes. 

Newman Grouping – Finds unusually dense clusters, even in large networks. 

Node – A representation of a real-world entity (a who, what, where, how, why item. 

Node Class – A set of nodes of one type. Note a set of nodes of one type can be 

represented as a meta-node. 

Normalized Sum – Otherwise known as the Average. 

Notation: 

The following matrix notation is used throughout the document for an arbitrary matrix X: 

 X(i,j) = the entry in the i
th

 row and j
th

 column of X 

 X(i,:) = i
th

 row vector of X 

 X(:,j) = j
th

 column vector of X 

 sum(X) = sum of the elements in X (also, X can be a row or column vector of a 

matrix) 

 dich(X) = dichotomize (make binary) X, so that dich(X)(i,j) = 1 iff X(i,j) > 0 

 X' = the transpose of X 

 ~X = for binary X, ~X(i,j) = 1 iff X(i,j) = 0 

 X@X = element-wise multiplication of two matrices (e.g. Z=X@Y => Z(i,j) = 

X(i,j)*Y(i,j)) 

O  

ODBC – (O)pen (D)ata (B)ase (C)onnectivity is an access method developed by the SQL 

Access group in 1992 whose goal was to make it possible to access any data from any 

application, regardless of which database management system (DBMS) is handling the 

data. 

Ontology – "The Specifics of a Concept". The group of entities, resources, knowledge, 

and tasks that exist in the same domain and are connected to one another. It's a simplified 

way of viewing the information. 

Organization – A collection of networks. 
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Out-Degree – The sum of the connections leading out from an entity to other entities. 

This is a measure of how influential the entity may be. Sometimes refered to as column 

degree. 

P  

Pajek – A visual tool for analyzing large networks (networks having thousands of 

vertices). 

Path – A set of nodes and links that form a single unbroken chain, such that no node or 

link is repeated. i.e. A > B > C > D > E 

Pendant – Any entity which is only connected by one edge. They appear to dangle off 

the main group. 

Percolation Theory – The behavior of connected clusters in a random network. 

Pythia – Program used to create Influence Nets. Pythia is a timed influence net 

application. This tool can downloaded at the following URL: 

http://sysarch.gmu.edu/main/software/. 

Q  

QAP Correlation – Calculates measures of nominal, ordinal, and interval association 

between the relations in two matrices, and uses quadratic assignment procedures to 

develop standard errors to test for the significance of association. 

QAP is designed as a bivariate test (only two variables). Generally, QAP is perfectly fine 

for almost any bivariate network problem. 

R  

Random Graph – One tries to prove the existence of graphs with certain properties by 

assigning random edges to various entities. The existence of a property on a random 

graph can be translated to the existence of the property on almost all graphs using the 

famous Szemerédi regularity lemma*. 

Reciprocity – The percentage of entities in a graph that arebi-directional. 

Redundancy – Number of entities that access to the same resources, are assigned the 

same task, or know the same knowledge. Redundancy occurs only when more than one 

agent fits the condition. 

Relation – The way in which entities in one class relate to entities in another class. 

Robustness – Two different definitions:  

 Networks – Concerned with the reliability (Kim & MÃ©dard, 2004) and 

continued functioning of a network following an intervention. The robustness of a 

network is particularly relevant in communication-type and flow-oriented 

networks. The purpose for understanding robustness of a network has more of a 

management of the network connotation. 

 Measures – This meaning has more of a statistical connotation. Studying the 

robustness of a measure of a network can also be referred to as conducting a 

sensitivity analysis on the measure. In keeping with the terminology of the most-

recently published research in this area, in lieu of using the term sensitivity, we 

too will use the robustness term, although the terms can be used interchangeably. 

A measure is robust if a slight perturbation in its input produces a slight change in 

its output. 
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Row Degree – see In Degree*. 

S 

Scale-Free Network – Some entities act as highly connected hubs (high degree), 

although most entities are of low degree. Scale-free networks' structure and dynamics are 

independent of the system's size N, the number of entities the system has. A network that 

is scale-free will have the same properties no matter what the number of its entities is. 

Self-Loop – An entity with a connection to itself. 

Simmelian Ties – Two entities are Simmelian Tied to one another if they are reciprocally 

and strongly tied to each other and strongly tied to at least one third party in common. 

Simulated Annealing – A method of finding optimal values numerically. It's a search 

method as opposed to a gradient based algorithm. It chooses a new point, and (for 

optimization) all uphill points are accepted while some downhill points are accepted 

depending on a probabilistic criteria. 

The term Simulated Annealing draws its inspiration from metallurgy, where atoms 

within a metal are heated thereby dislodging them from a metal's internal structure 

transforming the metal into another atomic state. In this way, your organization is 

heated changing its components in the attempt to arrive at an optimized state. 

Slow Measures – As the name implies these measures generally take longer to run. 

Small-World Network – Small-World Networks will have sub-networks that are 

characterized by the presence of connections between almost any two entities within 

them. 

Social Network Analysis – The term Social Network Analysis (or SNA) is used to refer 

to the analysis of any network such that all the entities are of one type (e.g., all people, or 

all roles, or all organizations), or at most two types (e.g., people and the groups they 

belong to). 

Sphere of Influence – One entity's direct relationship with one of it's neighbors as a 

function of specified path length. 

Standard Deviation – The square root of the variance where variance is the average of 

the squared differences between data points. 

.stl file format – This file format is native to the stereolithography CAD software created 

by 3D Systems. STL files describe only the surface geometry of a three dimensional 

object without any representation of color, texture or other common CAD model 

attributes and can us both ASCII and binary representations 

Szemerédi's Regularity Lemma – A fundamental structural result in extremal graph 

theory due to Szemerédi (1978). The regularity lemma essentially says that every graph 

can be well-approximated by the union of a constant number of random-like bipartite 

graphs, called regular pairs. 

T  

Table data format – Table data usually contains a column with referencing IDs and 

headers denoting column names. 

Tie – see Link 

Topology – The study of the arrangement or mapping of the elements (links, nodes, etc.) 

of a network, especially the physical (real) and logical (virtual) interconnections between 

nodes. 
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Total Degree Centrality – The normalized sum of an entity's row and column degrees. 

Trail – A set of nodes and links that form a single unbroken chain that can revisit nodes 

but not links. i.e. A > B > C > A > D 

Transpose – In linear algebra, the transpose of a matrix A is another matrix A
T
 (also 

written A
tr
, 

t
A, or A') created by any one of the following equivalent actions: 

 write the rows of A as the columns of A
T
 

 write the columns of A as the rows of A
T
 

 reflect A by its main diagonal (which starts from the top left) to obtain AT 

See The Transpose Wikipedia Entry for forumlas, examples and more information. 

U  

Unimodal networks – These are also called square networks because their adjacency 

matrix* is square; the diagonal is zero diagonal because there are no self-loops*.  

W  

Walk – A set of nodes and links that form a single unbroken chain that can revisit both 

nodes and links. i.e. A > B > C > B > D.  

 

http://en.wikipedia.org/wiki/Transpose
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